
 

 

 

 

 

 

 

 

 

 

  

 
 
 
 
 
 
 
 
 

User Manual 
SX20 Stopped Flow Spectrometer 
 

SX20 Stopped Flow Spectrometer 

March 2012 

 

Document 4140Q001C02.02 

 

 



 

 

Document 4140Q001C02.01  Page 2 of 175  

SX20 User Manual 

This page is intentionally left blank 

  



 

 

Document 4140Q001C02.01  Page 3 of 175  

SX20 User Manual 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This document contains important safety information. Read this document before 
attempting to install or use the SX20. Failure to do so could result in death or 
serious injury. 
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USE OF THIS DOCUMENT 

This document is intended to inform the operator of Applied Photophysics‟ SX20 stopped-flow spectrometer on 

its design, installation and operation. The information in this document is subject to change without notice and 

should not be construed as a commitment by Applied Photophysics, who accept no responsibility for errors that 

may appear herein. This document is believed to be complete and accurate at the time of publication, and in no 

event shall Applied Photophysics be held responsible for incidental or consequential damages with or arising 

from the use of this document. 

 

Some of the items that may be supplied with the SX20, for example the Workstation (PC) and temperature 

control circulator are manufactured by external companies, and are supplied with separate User Manuals 

provided by those companies. The operator should be familiar with the contents of those manuals, and in 

particular with the safety and other hazard information contained therein. 

 

COPYRIGHT  2012 APPLIED PHOTOPHYSICS LTD. ALL RIGHTS RESERVED. THIS DOCUMENT OR 

PARTS THEREOF SHALL NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION 

OF THE PUBLISHER.  

 

THE SOFTWARE PROVIDED WITH THE SX20 (PRO-DATA SX, PRO-DATA VIEWER, ETC.) IS THE 

PROPERTY OF APPLIED PHOTOPHYSICS LTD. (“APL”) AND IS SUPPLIED UNDER LICENCE. APL IS 

WILLING TO LICENSE THE SOFTWARE ONLY UPON THE CONDITION THAT THE LICENSEE ACCEPTS 

ALL THE TERMS CONTAINED IN THE LICENCE AGREEMENT. THESE INCLUDE THAT THE  LICENSEE 

MAY NOT SELL, RENT, LOAN OR OTHERWISE ENCUMBER OR TRANSFER LICENSED SOFTWARE IN 

WHOLE OR IN PART TO ANY THIRD PARTY. FOR A FULL COPY OF THE LICENCE PLEASE CONTACT 

APL OR SEE THE SOFTWARE INSTALLATION DISC. 

 

Figure 3.22 and Figure 3.24 are reproduced courtesy of Hamamatsu Photonics K.K.  

Figure 3.48 and Figure 3.49 are reproduced courtesy of Schott AG.  

 

SX20™ is a trademark of Applied Photophysics Ltd.  

Kloehn® is a registered trademark of Kloehn Inc. 

Salt Line® and Hamilton® are registered trademarks of Hamilton Company, Nevada, United States. 

Norton™ is a trademark of Symantec Corporation or its affiliates in the United States and other countries. 

McAfee® is a registered trademark of McAfee, Inc. in the United States and other countries. 

Sophos® is a registered trademark of Sophos Plc and Sophos Group. 

Hamamatsu® is a registered trademark of Hamamatsu Photonics K.K. 

Osram® is registered trademark of Osram Gesellschaft 

Schott® is a registered trademark of Schott AG 

Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the United States and other 

countries. 

All other trademarks or registered trademarks are the sole property of their respective owners. 
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HAZARD AND OTHER INDICATORS  

HAZARD INDICATORS USED IN THIS DOCUMENT 

 

The sign to the left is used to indicate a hazardous situation, which, if not avoided, could result in 

death or serious injury. 

 

The sign to the left is used to indicate a hazardous situation, which, if not avoided, could result in 

minor or moderate injury. 

 

 

OTHER INFORMATORY INDICATORS USED IN THIS DOCUMENT 

 

The sign to the left is used to indicate a situation which, if not avoided, could result in damage to 

the instrument. 

 

 

HAZARD INDICATORS USED ON THE SX20 OR ACCESSORIES 

 

Note that these hazard indicators may be either coloured as below or as black and white. 

 

The sign to the left is a general hazard indicator, indicating the presence of a hazard that is either 

described by text accompanying the sign or in this User Manual. 

 

 

The sign to the left is a High Voltage hazard indicator.  
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ESSENTIAL SAFETY INFORMATION 

MAKE SURE THAT YOU HAVE READ AND UNDERSTAND ALL THE SAFETY INFORMATION CONTAINED 

IN THIS DOCUMENT BEFORE ATTEMPTING TO OPERATE THE SX20 SPECTROMETER. IF YOU HAVE 

ANY QUESTIONS REGARDING THE OPERATION OF YOUR SPECTROMETER, PLEASE CONTACT APL 

TECHNICAL SUPPORT SECTION AT THE ADDRESS SHOWN ON THE FIRST PAGE OF THIS DOCUMENT. 

 

OBSERVE ALL SAFETY LABELS AND NEVER ERASE OR REMOVE SAFETY LABELS. 

 

PERFORMANCE OF INSTALLATION, OPERATION OR MAINTENANCE PROCEDURES OTHER THAN 

THOSE DESCRIBED IN THIS USER MANUAL MAY RESULT IN A HAZARDOUS SITUATION AND WILL VOID 

THE MANUFACTURERS WARRANTY.  

 

FOR CLARITY, MANY OF THE IMAGES IN THIS USER MANUAL SHOW THE SX20 WITHOUT THE SAFETY 

COVER IN PLACE. A DRIVE SHOULD NEVER BE PERFORMED UNLESS THIS COVER IS IN PLACE. 

 

The SX20 spectrometer is powered by  the mains electricity supply which can produce an 

electric shock leading to serious injury or death. Do not connect or disconnect the instrument 

from the mains supply unless the supply is powered off at source. Ensure all communications 

and electrical connections are made before powering on the spectrometer. Exercise care during 

operation and do not operate units with their covers removed. Operate the spectrometer using 

only the cables provided. Never operate a spectrometer with damaged cables.  

 

The metal components of the spectrometer can produce an electric shock leading to serious 

injury or death if they are not earthed (grounded). The design of the spectrometer provides 

protection against electric shock by earthing appropriate metal components. This protection will 

be lost unless the power cable is connected to a properly earthed outlet. It is the user‟s 

responsibility to ensure that a proper earth connection can be made.   

 

The photomultiplier tube (PMT) detector used with the SX20 operates at high voltages and can 

produce an electric shock leading to serious injury or death. Do not connect or disconnect the 

detector from the spectrometer unless the spectrometer is powered off.  

 

The SX20 spectrometer may be equipped with a light source (150 watt xenon or mercury-xenon 

arc lamp) that produces intense ultraviolet radiation that can irritate the eyes and may impair 

eyesight. Never look directly at the light source. Do not open the lamp housing while the lamp is 

operating or immediately after it is powered off. Do not allow the skin to be exposed to UV 

radiation. 

 

The SX20 drive rams are pneumatically driven and could trap hands or clothing, causing injury to 

the user. Keep hands and clothing and other items clear when performing a drive, and never 

perform a drive without the safety cover in place. 

 

The interaction between ultraviolet light and oxygen leads to the formation of ozone, a very 

reactive gas that is damaging to health and may cause deterioration of the optical components of 

the instrument. If an ozone producing lamp is used, it essential that the SX20 is thoroughly 

purged with clean, oxygen-free nitrogen before the lamp is powered on. 
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The electronic circuitry used in the SX20 is very sensitive and must be correctly grounded to 

avoid electrical interference. The lamp power supply unit, the lamp housing and the mains 

distribution board all have earth posts that must be connected to the earth post on the optical rail 

via the braided earth straps provided with the system. It is the user‟s responsibility to ensure that 

a proper earth connection can be made.   

 

The cables running between the power supply and the lamp housing carry high voltages during 

lamp ignition that could cause interference with other electronic devices and cables: keep other 

devices and cables at least 30 cm away.  

 

The lamps used in the SX20 operate at high pressure and can explode or break without warning, 

causing damage to the interior of the lap housing. This is more likely to happen with lamps with 

longer usage, and lamps with more than 1000 hours usage should be replaced.  

 

Corrosive chemical and organic solvents can cause damage to the spectrometer. Do not allow 

corrosive fluids to come into contact with any part of the spectrometer except within the flow 

system. Do not clean the spectrometer with organic solvents. Use only a soft cloth and water or a 

mild detergent solution. 
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SX20 INSTALLATION AND OPERATIONAL REQUIREMENTS 

Environmental requirements 

The SX20 is best installed in a safe position, in a clean, air-conditioned laboratory environment.  

 

Operating conditions 

Temperature:   ±2
o
C of a fixed temperature in the range 18

o
C to 26

o
C. 

Humidity  20% to 80% non-condensing 

 

Storage conditions 

Temperature  -20°C to +50°C: 

Humidity:   5% to 80% non-condensing 

 

Bench space 

The minimum bench space for the SX20 is (length x depth x height): 

 

Standard system:  1.5 x 0.8 x 0.6 metres 

With AM.1 accessory: 1.8 x 0.8 x 0.6 metres 

 

A sturdy, stable, vibration-free work surface is recommended. 

 

Pneumatic requirements 

The sample handling unit is pneumatically driven and requires a compressed gas supply (preferably nitrogen) 

capable of operating at 8 bar (120 psi). The supply should be fitted with a push-on tube adaptor to accept the 

flexible hose (6 mm internal diameter) that connects to the SHU inlets. 

 

Electrical requirements 

The SX20 spectrometer is supplied with a filtered mains distribution board which requires an earthed (grounded) 

mains electricity supply of between 85 and 264 volts. The minimum value of the uninterruptible power supply is 1 

kVA. 

 

Computer requirements 

The SX20 is normally supplied with a computer. However, some users may wish to use run the instrument from 

their own PC. This should be a Windows 7 Pro ready PC,  2.4 GHz, 2 GB RAM,  2 GB hard drive, 1 free PCIe 

slot. 

 

When used with an ozone producing lamp, the spectrometer requires constant purging with oxygen free nitrogen 

at a pressure of 4 to 6 bar (60 to 90 psi) and flow rate of at least 5 litres per minute 

  

Fluid circulator unit 

The SX20 can be used with or without temperature control. For connection to a water circulator unit, the SHU is 

provided with an inlet and outlet fitting compatible with a flexible hose of 8 mm internal diameter. Some 

circulators can be controlled via the SX20 software: the Thermo Fisher Scientific A25/SC150, available from 

Applied Photophysics, is recommended.  
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GENERAL INFORMATION 

Computer Configuration 

Your SX20 is normally supplied with an HP Compaq PC, pre-configured for use with the instrument. However, 

there are some issues that you need to be aware of, described below. 

 

Administrator Login 

No password is set by APL for the Administrator account.  Customers are advised to set the Administrator 

password of the Sx20 PC themselves. 

 

APL Service Account 

The user account “APLService” has been created and given Administrative privileges by APL.  This account will 

be used by APL engineers during servicing of your SX20 instrument.  Do not remove this user, or change the 

password. 

 

SX20 User Login and the SX20 Users Group 

The user account “SX User” has also been created by APL. SX20 users may login as “SX User”, or the system 

administrator may create individual user accounts.  An “SX Users” group has also been created, and users 

should be made members of this group.  If the SX PC is connected to a network then this may affect the way in 

which users logon to the SX20 PC. The system administrator should ensure that “network” or “domain” users 

who want to use the SX20 software are members of the “SX Users” group. 

 

Virus Protection 

The HP Compaq PC may be supplied with a trial version of a 3rd party anti-virus package.  APL recommends 

that the SX20 PC has up-to-date anti-virus software installed at all times.  Most customers will have a preferred 

anti-virus software package, and APL generally recommends that the anti-virus software which is supported by 

the customers' ICT department be installed on the SX20 PC.  However, please see the section on installing 3rd 

Party software below. 

 

Networking 

The SX20 PC is supplied with networking capabilities.  However, before the SX20 PC is connected to a network, 

the System Administrator should ensure that appropriate anti-virus (and optionally anti-spyware) software is 

installed and maintained.  APL cannot be held responsible for failure of the SX20 PC due to viruses or other 

malware. 

 

Installation of 3rd Party Software 

The SX20 Pro-Data suite is not compatible with most 3
rd

 party firewall programs, including Norton, McAfee and  

Sophos firewall programs. The Pro-Data suite is compatible with Windows built-in firewall, provided that SX20 

Pro-Data software is listed as an exception. APL is not aware of any other conflicts with 3rd Party Software., and 

will not be held responsible for failure of the SX20 software because of any such conflict.  

 

Upgrading Software and/or Hardware 

The SX20 software has been developed for use with Microsoft Windows software and has been extensively 

tested on the PC's supplied by APL.  APL cannot be held responsible for failure of the SX20 software if the SX20 

user or system administrator upgrades the PC, or the PC's Operating System. 
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Technical Support and Licensing 

APL will provide technical support, under the terms of the Service Level Agreement, for the SX20 software, 

subject to the SX20 Software Licence, and for the supplied PC.  However, APL cannot be held responsible for 

failure of the software or hardware through of misuse or neglect by the customer. 

 

If you have any queries relating to the SX20 software or the HP Compaq PC, please contact APL Technical 

Support Department at the address given on the front of this User Manual. 

 

Servicing 

Servicing of the SX20 and its accessories should only be undertaken by qualified personnel. If you are in any 

doubt at all please contact the Applied Photophysics Technical Support Department at the address given on the 

front of this User Manual.  
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GLOSSARY 

The following abbreviations are used in the descriptive text in this User Manual: 

 

AC   Alternating current 

APL   Applied Photophysics Ltd. 

AU   Absorbance units 

DC   Direct current 

FWHH   Full width at half height 

HT   High tension – the same as high voltage 

HV   High voltage 

L/min   Litres per minute
 

 

M   Molar (i.e. mol dm
-3

) 

SBW   Spectral bandwidth 

SF   Stopped flow 

SS   Step size 

UV   Ultraviolet 

 

The following abbreviations relate to components of the SX20 spectrometer: 

 

ESHU   Equilibrium sample handling unit 

KSHU   Kinetic sample handling unit 

LED   Light-emitting diode 

PDA   Photodiode array 

PEEK   Polyetherether ketone 

PMT   Photomultiplier tube 

PTFE   Polytetrafluoroethylene 

PSU   Power supply unit 

SCP   Spectrometer control panel 

SHU   Sample handling unit 

 

 

 

HYPERLINKS 

This document contains hyperlinks between references (for example the Contents tables, or references to 

Sections or Figures in the text) and sources. To follow a link, place the cursor over the reference and use 

CTRL+click. Hyperlinks in the text are indicated by underlined blue font. 
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1 INTRODUCTION 

 

 
      

Figure 1.1: The SX20 Stopped-Flow Spectrometer 

 

 

Stopped-flow is one of a number of methods of studying the kinetics of reactions in solution. In the simplest form 

of the technique, the solutions of two reactants are rapidly mixed by being forced through a mixing chamber, on 

emerging from which the mixed fluid passes through an optical observation cell. At some point in time, the flow is 

suddenly stopped, and the reaction is monitored using a suitable spectroscopic probe, such as absorbance, 

fluorescence or fluorescence polarization. The change in spectroscopic signal as a function of time is recorded, 

and the rate constants that define the reaction kinetics can then be obtained by fitting the data using a suitable 

model. 

 

The performance of a stopped-flow instrument is determined to a large extent by its dead time. This is defined as 

the time between the reactants mixing and the observation beginning, and is essentially the age of the reaction 

as the reaction mixture enters the observation cell. The limiting factors in the dead time of a particular stopped-

flow apparatus are the efficiency of the mixer, the distance between the mixer and the cell, and the flow rate of 

the reaction mixture at the instant at which flow is stopped. When its standard observation cell is used, the SX20 

is typically capable of achieving dead times of about a millisecond; when an ultra-small observation cell is used, 

dead times can be reduced to about half that.  

 

The standard operating mode of the SX20 is single-mixing. Two reactants are used; these are loaded into 

syringes, and are forced through the mixer and optical cell by the action of a pneumatically controlled ram which 

drives the syringe plungers. The reaction mixture emerging from the optical cell enters a third (stop) syringe, and 

flow ceases when the stop syringe plunger contacts a trigger switch. This simultaneously stops the flow and 

starts data acquisition.  

 

Normally, the two drive syringes are the same size, to achieve a mixing ratio of 1:1, but syringes of different sizes 

can be combined to obtain other mixing ratios. This so called asymmetric or ratio mixing is a common 

requirement in stopped-flow work.  

 

Sequential-, or double-, mixing is a variation of stopped-flow in which two reactants are forced through a pre-

mixer into an ageing loop. After a specified delay period, the mixed fluid is forced through a separate mixer with a 

third reactant, and the subsequent reaction is studied as in single-mixing. Sequential-mixing is used to 

investigate the behavior of reaction intermediates or short-lived transients. 
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It is usual to acquire data from a stopped-flow experiment at a single observation wavelength. A xenon-mercury 

(Xe-Hg) arc lamp is often used; these lamps provide high outputs at the mercury fluorescence emission lines, 

and one of these is selected as the observation wavelength. Alternatively the wavelength can be scanned, for 

example to assess the change in structure of a protein over time, in which case a xenon (Xe) arc lamp is 

preferred. 
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2 QUICK START 

2.1 Introduction 

This Chapter is intended to provide a series of step by step guides to performing basic experiments on the SX20. 

Each section consists of a brief description of the procedure followed by a thorough explanation.  Please refer to 

Chapters 3  and 4 respectively of this User Manual for detailed descriptions of instrument hardware configuration 

and a more extended explanation of the software functionality. 

 

Whichever acquisition mode is of interest, it is recommended that the inexperienced user first read through 

Section 2.2.  Please refer to Figure 2.1 for the terms used to describe the main components of the instrument. 

 

 
 

 

 

 
 
 

Figure 2.1: the main components of the SX 20 
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2.2 SX20 Start-up and Preparation 

The sequence for starting up and preparing the SX20 is as follows: 

 

1. Turn on the nitrogen supply and ensure that the pressure is set to 8 bar (120 psi) 

2. Power on the electronics unit 

3. Power on the lamp power supply unit; after 10 seconds ignite the lamp 

4. Power on the computer and load the Pro-Data SX20 software 

5. Load the Pro-Data Viewer software and set the file save location and seed names. 

 

These operations are described in more detail below. 

 

The SX20 spectrometer is powered by the mains electricity supply which can produce a shock 

leading to serious injury or death. Do not connect or disconnect the instrument from the mains 

supply unless the supply is powered off at source. Ensure all communications and electrical 

connections are made before powering on the spectrometer. Exercise care during operation and 

do not operate units with their covers removed. Operate the spectrometer using only the cables 

provided. Never operate a spectrometer with damaged cables.  

 

The design of the spectrometer provides protection against electrical shock by earthing 

(grounding) appropriate metal components. This protection will be lost unless the power cable is 

connected to a properly earthed outlet. It is the user‟s responsibility to ensure that a proper earth 

connection can be made.   

 

The photomultiplier tube (PMT) detector used with the SX20 operates at high voltages and can 

produce a shock leading to serious injury or death. Do not connect or disconnect the detector 

from the spectrometer unless the spectrometer is powered off.  

 

The SX20 spectrometer may be equipped with a light source (150 watt xenon or mercury-xenon 

arc lamp) that produces intense ultraviolet radiation that can irritate the eyes and may impair 

eyesight. Never look directly at the light source. Do not open the lamp housing while the lamp is 

operating or immediately after it is powered off. Do not allow the skin to be exposed to UV 

radiation. 

 

The SX20 drive rams are pneumatically driven and could trap hands or clothing, causing injury to 

the user. Keep hands and clothing clear when performing a drive, and never perform a drive 

without the safety cover in place. 

 

The interaction between ultraviolet light and oxygen leads to the formation of ozone, a very 

reactive gas that is damaging to health and may cause deterioration of the optical components of 

the instrument. If an ozone producing lamp is used, it essential that the SX20 is thoroughly 

purged with nitrogen before the lamp is powered on. 

 

The cables running between the power supply and the lamp housing carry high voltages during 

lamp ignition that could cause interference with other electronic devices and cables: keep other 

devices and cables at least 30 cm away.  

 

1) An 8 bar (120 psi) gas supply must be used to power the operation of the pneumatic rams and stop valve of 

the SX20 sample handling unit.  A nitrogen cylinder is the usual gas supply, but air supplied via a cylinder or 

compressor may also be used.  If an ozone producing lamp is fitted then the lamp housing must be continuously 
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purged via the black elbow connector in the right hand face of the housing.  Nitrogen must be used as the purge 

gas, but only a slow flow is needed in order to maintain a positive pressure in the lamp housing. 

 

2) Power on the electronics unit via the black rocker switch on the front panel. There are three light emitting 

diodes, one green and two red.  The green diode will flash for a short time after the unit is powered on, but 

should then remain on constantly.  Whenever the software is running the red diodes will flash continuously. It is 

recommended that if the instrument is to be used daily the electronics unit is left powered on. 

 

3) Power on the lamp power supply unit using the black rocker switch on the front panel.  The red light-emitting 

diode should illuminate.  Wait for at least ten seconds before pressing the red button to ignite the lamp.  When 

the lamp is running the counter LCD on the power supply will show the lamp running time.   

 

4) Power on the computer and log on.  The default account is „SX user‟ which has no password.  There are two 

other accounts as standard, „APL Service‟ for use by service engineers, and an administrator account. Load Pro-

Data SX using the  desktop icon. 

 

5) Start Pro-Data Viewer program using the Viewer  icon on the Pro-Data Viewer toolbar. Navigate in the 

Pro-Data Viewer file browser (Figure 2.2) to your preferred save directory and right click on it selecting Set 

Working Directory Here. New data files will now automatically be saved in this directory. 

 

 
 

Figure 2.2: the Pro-Data Viewer file browser 

 

Now open the Files Names dialog box by clicking on the  icon on the toolbar (Figure 2.3:). Enter a name for 

the new data files and baseline file (where relevant).  Subsequent files of each type will be numbered starting 

from the values set in the window. 
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Figure 2.3: the Files Names dialog box 
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2.3 Sample Handling Unit (SHU) Preparation 

The sequence for preparing the SX20 sample handling unit (SHU) is as follows: 

 

1. Configure the flow lines for single-mixing (SQ.1 option only) 

2. Set the drive volume 

3. Flush the system with water. 

4. Leak test the system. 

 

The following description applies to a single-mixing stopped flow experiment with a 1:1 mixing ratio.  See Section 

3.21.2 for details of how to perform sequential-mixing experiments.  
 

1) Figure 2.4 and the schematic in Figure 2.5 with the single-mix drive ram connected to the left hand ram 

platform. The single-mixing experiment always utilises this drive ram and the reagents are always loaded in the F 

(left) and C (right) drive syringes. The black plastic dust cover should be fitted to the right hand (Pre-Mix) ram 

platform. Systems not equipped with the sequential-mixing option are only configured for single-mixing 

experiments. No additional preparation is required. 

 

 
 

Figure 2.4: sequential-mixing SHU in single-mixing configuration 
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Figure 2.5: sequential-mixing flow lines in the single-mixing configuration 
 

 

2) Screw the knurled volume adjuster (Figure 2.6) on the Auto-Stop fully clockwise (i.e. front edge moves from 

left to right), then screw it two and a half turns anti-clockwise (counter-clockwise). This equates to a total drive 

volume of approximately 120 µl.  
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Figure 2.6: the location of the drive column adjuster on the stop mechanism 

 

 

3) The stopped-flow unit should have been left from previous use with purified water in the flow circuit and cell. In 

any event it is best to ensure that clean water is in the flow circuit and cell prior to loading sample. To do this: 

 

a) Set the drive valves to the „load‟ position (Figure 2.7) 

b) Empty any contents of the drive syringes into waste reservoir syringes by pushing the drive syringe-

piston upwards into reservoir syringes. 

c) Replace the reservoir syringes with ones containing clean purified water. 

d) Load each drive syringe with about 1 ml of water by pushing down on each  reservoir syringe piston 

while at the same time pulling on the drive syringe piston. Take care not to introduce air bubbles into the 

flow-circuit: one of the most common causes of artifacts in stopped-flow data is the presence of air 

bubbles. We recommend taking care and time to develop your technique for eliminating air bubbles. 

e) With the drive valves still in the „load‟ position, raise the drive ram until it is in contact with both drive 

syringe pistons. 

f) Set the drive valves to the „drive‟ position (Figure 2.7). 

g) Select Drive on the Sample handling unit panel (using the Drive function rather than the Acquire 

function ensures that there will be no data collection and generation of a data file). 

h) Do at least 5 repeat drives to ensure that the flow circuit and cell contents have been completely 

displaced by the clean water.  

 

Drive volume 

adjuster 
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Figure 2.7: drive valve drive (left) and load (right) positions 

 

 

Before executing a drive always check that the drive valves are in the „drive‟ position (not the 

„load‟ position) and the drive ram is in contact with the syringe plungers. Failure to do so may 

result in damage to the flow circuit. 

 

To minimise the introduction of bubbles, and to facilitate their removal, shunt liquids back and forth gently 

through the drive valves whilst keeping the liquid compressed from both ends of the flow (by applying downward 

pressure on the piston on the reservoir syringe and upward pressure on the drive syringe piston). When loading 

drive syringes avoid simply pulling the syringes down, to suck liquid from the reservoirs, as this will encourage 

cavitation and bubble formation. Fill them by both pushing liquid in from the reservoirs above, while pulling the 

drive syringe pistons down, to keep a positive pressure in the valve and syringe cavity. 

 

Drives can also be carried out manually by turning the stop valve by hand 180 clockwise, emptying the stop 

syringe manually and returning the stop valve to its normal position. Fresh purified water can then be introduced 

into the drive syringes and flushed through the flow circuit manually (by raising the drive ram upwards against the 

drive syringe pistons). This procedure can be repeated until the user is confident that the circuit is clean and also 

free from air bubbles. 

 

4) The flow circuit should be checked for leaks from time to time, particularly before introducing precious 

samples. With the drive valves in the „drive‟ position, apply upward pressure to the drive ram and fluid in the drive 

circuit and look for any upward movement of the drive syringes after the stop syringe has reached its limit. Any 

further detectable movement is indicative of a leak and must be addressed before any experiments are carried 

out (see Chapter 3). 

 

Leak testing may also be done by using the instrument controls: set the data acquisition period in the time-base 

panel to 5 or 10 seconds, set the trigger to External from the drop down menu, check the box labelled Pressure 

hold, and click Acquire. During the drive that follows, the upward pressure will be maintained on the drive 

syringes for the whole acquisition period. Once again, any discernible upward movement of the syringes during 

this period indicates that there is a leak in the flow circuit. 
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Note that the Sample Handling Unit (SHU) panel displays the temperature inside the stopped-flow water bath. If 

the temperature is to be controlled via the Pro-Data software, this can be done using the Temperature Control 

Unit panel (Section 3.11). If a programmable bath has been connected and the software configured via the 

Device window (Section 4.12): the Temperature Details dialog box can be opened by clicking the Settings 

button and a desired temperature set.  

 

  



 

 

Document 4140Q001C02.01  Page 33 of 175  

SX20 User Manual 

2.4 Stopped-Flow Absorbance Kinetics 

1. Select Absorbance mode 

2. Select kinetics mode, set timebase and points 

3. Select monochromator wavelength and slit width 

4. Zero detector 

5. Load sample 

6. Acquire data 

 

1) Assuming that the SHU has been prepared as in Section 2.3, on the Signal panel (Figure 2.8) of the Pro-Data 

main window select Absorbance from the drop down list.  Ensure that AutoHV is ticked. 

 

 
 

Figure 2.8: the Signal panel for Absorbance 

 

 

2) Ensure that Kinetics mode is selected on the Sequencer panel (Figure 2.9). 

 

 
 

 
Figure 2.9: the Sequencer panel for absorbance kinetics 

 

 

Select External from the drop down list in the Trigger panel (Figure 2.10) to activate stopped-flow operation. 
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Figure 2.10: the Trigger and Timebase panels for absorbance kinetics 

 

 

On the Timebase panel (Figure 2.10) choose an appropriate acquisition time based on the expected timescale 

of the reaction.  The Points should normally be set to a value between 400 and 1000 data points. 

 

3) On the Monochromator panel (Figure 2.11) enter the selected wavelength.  

 

 
 

Figure 2.11: the Monochromator panel for absorbance kinetics 

 

 

Using the dials on the front of the monochromator set the slit widths.  A width of 0.5 mm will be suitable for most 

absorbance work. 

 

4) Fill the optical cell with a suitable reference material (e.g. water or other solvent). Click the Baseline button in 

the Signal panel (Figure 2.8) to zero the absorbance detector.    

 

5) Samples may now be loaded into the drive syringes.  

 

6) Ensure that the drive valves are in the „drive‟ position and click the Acquire button to perform a drive and 

collect the data.  The first few drives will consist of buffer and then diluted sample.  By the fourth or fifth drive 

clean sample should be mixed with each drive and results should be consistent. 

 

Absorbance measurements will now be in units of absolute absorbance since water was used when measuring 

the reference. It is possible to measure the reference with something other than water in the cell, in which case 

the measurements will now be relative absorbance. This may be convenient when measuring small absorbance 

changes on significant backgrounds. Collecting a reference when only one reagent (often colourless) is pushed 

into the cell is one typical option as is reference collection to the chemical end point of the chemical reaction 

under investigation.   
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2.5 Stopped-Flow Fluorescence Kinetics 

 

1. Install an appropriate cut off filter 

2. Select an appropriate pathlength 

3. Select fluorescence mode 

4. Select kinetics mode, set timebase and points 

5. Select excitation wavelength and bandwidth 

6. Load sample 

7. Set detector voltage 

8. Acquire data 

 

1) Select a long pass cut-off filter appropriate for the fluorophore being used which blocks scattered light of the 

excitation wavelength but passes fluorescent emission. The filter should be installed between the fluorescence 

detector and the end window of the cell. The filter holder (Figure 2.12) is accessed by removing the fluorescence 

detector from the SHU.  

 

 

 

 

 

 

 
 

Figure 2.12: the filter holder 

 

 

2) The choice of excitation pathlength will depend on the absorption and concentration of the sample under 

investigation, taking into account the risk of inner filtering effects.  Inner filtering is the partial blockage of the 

excitation light by absorption. If there is a significant change in the absorption of the sample during the course of 

the experiment (as a result of the reaction that is taking place), the proportion of „blocked‟ excitation light will also 

change and so the recorded change in fluorescence emission will not be wholly due to the rate(s) of the reaction 

being monitored.  The resulting kinetic curves will be non-exponential in form and accurate reaction rates will not 

be derived from the data by usual curve fitting methods.  The 2 mm pathlength is therefore normally used as the 

excitation path. 

 

3) Assuming that the SHU has been prepared as described in Section  2.3, on the Signal panel of the Pro-Data 

main window select Fluorescence from the drop down list (Figure 2.13).    
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Figure 2.13: the Signal panel for fluorescence kinetics 

 

 

4) Ensure that Kinetics mode is selected on the Sequencer panel (Figure 2.14). 

 

 
 

Figure 2.14: the Sequencer panel for fluorescence kinetics 

 

 

Select External from the drop down list on the Trigger panel to activate stopped-flow operation, and on the 

Timebase panel (Figure 2.15) choose an appropriate acquisition time based on the expected timescale of the 

reaction.  The Points should normally be set to a value between 400 and 1000. 

 

 
 

Figure 2.15: the Trigger and Timebase panels for fluorescence kinetics 

 

 

5) On the Monochromator panel (Figure 2.16) enter the selected excitation wavelength.  
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Figure 2.16: the monochromator panel for fluorescence kinetics 

 

 

6) Samples may now be loaded in the drive syringes. Ensure that the drive valves are in the „drive‟ position and 

click the Drive button on the KSHU panel (Figure 2.17) to push sample through the system without collecting 

data.  Click the Drive button five times so that the samples will have reached the observation cell. 

 

 
 

Figure 2.17: the KSHU panel for fluorescence kinetics 

 

 

7) Now click the „…‟ button next to the Fluorescence box on the Detector High Voltages panel (Figure 2.18). 

 

 
 

Figure 2.18: the Detector High Voltages panel 

 

 

This will open the Set HV dialog box (Figure 2.19).   

 

 
 

Figure 2.19: the Set HV dialog box 
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Now click the AutoPM button. This will by default l. Note that some fluorescence quenching reactions may 

require a lower detector supply voltage in order to measure a signal within the detector operating range. In such 

cases a lower supply voltage should be entered manually by the user. 

 

8) Click Acquire to collect data. 
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2.6 Stopped-Flow Fluorescence Polarisation (FP) 

 

1. Fit the FP accessory (Figure 2.20) to the cell block 

2. Install filters in the polariser units 

3. Attach polarisers and detectors 

4. Select Fluorescence Polarisation mode 

5. Select kinetics mode, set timebase and points  

6. Select excitation wavelength and bandwidth  

7. Load sample 

8. Set detector voltage 

9. Acquire data 

 

 
 

Figure 2.20: the fluorescence polarisation accessory 

 

 

1) Remove the detectors from the cell block and any filter from the standard filter holder, then attach the FP 

accessory main body to the block.  It is best not to fully tighten the fixing screws but to leave them slightly loose 

until the detector polariser units are attached. 

 

2) Install a pair of identical cut off filters in the detector polariser units. 
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Figure 2.21:the positions of the polariser units 

 

 

3) Push the detector polariser units into place on the cell block.  As they are usually a tight fit it is helpful at this 

stage if the fixing screws of the main body of the FP accessory are loose as this allows some free play.  When 

viewed from the front of the SHU the parallel (V) polariser should go on the lower right side of the cell block and 

the perpendicular (H) polariser on the upper left side.  Once the polarisers are in place tighten the fixing screws 

and the fixing screw of the main unit.  The detectors should now be attached. The detector on the perpendicular 

polariser should be plugged into channel 2 on the electronics rack with the other detector plugged into channel 1. 

 

 

 
 

Figure 2.22: the Signal panel for fluorescence polarisation  

Input polariser 

Detector polarisers units 
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4) Assuming that the SHU has been prepared as described in Section 2.3, on the Signal panel of the Pro-Data 

main window select Fluorescence Polarisation from the drop down list (Figure 2.22) and select the desired 

units (Polarisation or Anisotropy).  The Total Flu box may also be ticked to record the total fluorescence signal 

as well as the polarisation. 

 

5) Ensure that Kinetics mode is selected in the Sequencer panel (Figure 2.23). 

 

 
 

Figure 2.23: the Sequencer panel for fluorescence polarisation 

 

 

Select External from the drop down list in the Trigger panel to activate stopped-flow operation, and on the 

Timebase panel (Figure 2.24) choose an appropriate acquisition time based on the expected timescale of the 

reaction.  The Points should normally be set to a value between 400 and 1000 data points. 

 

 
 

Figure 2.24: the Trigger and Timebase panels for fluorescence polarisation 

 

 

6) On the Monochromator panel (Figure 2.25) enter the selected excitation wavelength.  A slit width of 2 mm is 

normally recommended for fluorescence polarisation measurements. 

 

 

 
 

Figure 2.25: the Monochromator panel for fluorescence polarisation 

 

 

7) Samples may now be loaded into the flow circuit. Ensure that the drive valves are in the „drive‟ position and 

click the Drive button on the SHU panel to push sample through the system without collecting data. 
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Figure 2.26: the KSHU panel for fluorescence polarisation 

 

 

8) Click the Setup button on the Signal panel (Figure 2.22) to start the FP setup wizard following the instructions 

on the screen at each step.  The procedure starts with zeroing any voltage already applied to the detectors and 

moving the input polariser to the H position (step 1), then setting the voltages of the two detectors (step 2).  

Steps 3 and 4 allow for the zero offset signals to be accounted for (this requires water to be in the cell).  In step 5 

the G factor, which is the small difference in gain between the two detectors, is found at to the level of precision 

set by the user.  In step 5 the input polariser is finally moved back to the V position. 

 

9) The instrument will now be ready to start acquiring data.   
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2.7 Stopped-Flow Absorbance Spectra-Kinetics  

(Multi-Wavelength Absorbance Kinetics via PMT Detection) 

 

1. Select Absorbance mode 

2. Select Spectra-Kinetics mode, set timebase and points 

3. Select wavelength range,  bandwidth and step size 

4. Acquire baseline measurement 

5. Load sample 

6. Prime flow circuit 

7. Set shot counter 

8. Acquire data 

 

1) Preparation of the SX20 for spectra-kinetic absorbance measurements is identical to the preparation for single 

wavelength absorbance work described in Section 2.4. 

 

A key difference from single wavelength work is in the collection of suitable reference data for the absorbance 

calculation as this now has to be collected at each wavelength of interest.  Collection of the baseline with water 

in the cell is recommended as spectra-kinetic data, by its nature, exhibits different kinetics and amplitudes at 

different wavelengths. 

 

2) Select Spectra-Kinetics mode in the Sequencer panel. 

 

 
 

Figure 2.27: the Sequencer panel for absorbance spectra-kinetics 

 

 

Select External T from the drop down list on the Trigger panel and on the Timebase panel (Figure 2.28) choose 

an appropriate acquisition time based on the expected timescale of the reaction.  The Points should normally be 

set to a value between 400 and 1000 data points. 

 

 
 

Figure 2.28: the Trigger and Timebase panel for absorbance spectra-kinetics 

 

 

3) On the Monochromator panel (Figure 2.29), first select the wavelength range, bandwidth and step size. Note 

that the monochromator always moves from a high to a low wavelength when scanning.  
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Figure 2.29: the Monochromator panel for absorbance spectra-kinetics 

 

 

4) Click Baseline on the Signal panel to collect the wavelength dependent reference data. The monochromator 

will move to each required wavelength and apply an appropriate HV to the detector. This will be re-applied when 

running your samples and the accurate absorbance spectra derived.  

 

5) Samples may now be loaded into the drive syringes.  

 

6) Ensure that the drive valves are in the „drive‟ position and click the Drive button on the KSHU panel (Figure 

2.30) four times in succession to perform a series of drives without collecting any data.  This will ensure that the 

flow circuit is primed with fresh reagents. 

 

 
 

Figure 2.30: the KSHU panel for absorbance spectra-kinetics 

 

 

Refill the drive syringes from the reservoir syringes. 

 

7) Click the Setup button on the KSHU panel (Figure 2.30) and select the General tab (Figure 2.31).  Enter 20 in 

the Max Shots box, click the Save button and then OK.  
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Figure 2.31: the General tab 

 

 

On the KSHU panel (Figure 2.30) click the Reset button. 

 

8) Click the Acquire button to start the data acquisition. Note that spectra-kinetic data acquisition consists of an 

automated series of stopped-flow drives and it is recommended that the reagent volume remaining in the drive 

syringes is monitored during the course of the reaction. The acquisition can be paused and resumed from the 

acquisition panel if an interruption to re-fill the syringes is needed. If the shot counter is correctly set the 

acquisition will be paused automatically.  However, keep in mind that the Shots left counter can get out of 

synchronisation with the true reagent volumes in the drive syringes and so it is best to check that syringes 

contain sufficient volume. 

 

For subsequent management and processing of the newly acquired spectra-kinetic reaction data please refer to 

the Pro-Data Viewer User Guide. Also note that this data can be readily converted for input into the Applied 

Photophysics Global Analysis applications Pro-K for PC and Pro-KII by exporting from the viewer software as 

APL-ASCII_SPECTRAKINETIC format. 

 

Note that this procedure may be adapted to measure stopped-flow fluorescence spectra-kinetics for instruments 

equipped with an emission monochromator (option SEM.1). 
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2.8 Photodiode Array Operation 

(Multi-Wavelength Absorbance Kinetics via PDA Detection) 

 

1. Set up the PDA hardware as described in the Hardware Manual 

2. Select Photodiode Array from drop down list 

3. Select appropriate PDA settings 

4. Collect baseline 

5. Load samples and acquire data 

 

The photodiode array accessory allows multiple spectra to be acquired from a single stopped flow drive.  In 

comparison, the standard spectra-kinetic operating mode is time consuming and requires much more sample but 

offers a higher time resolution and sensitivity than is available with the PDA (1.2 ms is the minimum integration 

time).  

 

1) Refer to Section 3.3.4 for guidance on how to set up the PDA hardware on the SX20. Generally the PDA is 

operated with the xenon lamp fitted to the SX20, however, an optional deuterium lamp is available for use with 

the UV region PDA specifically for measurements below 250 nm. Further information relating to operation of the 

deuterium lamp is provided in Section 3.3.5.  

 

2) Select Photodiode Array from the drop-down list on the Signal panel (Figure 2.32). 

 

 
 

Figure 2.32: the Signal panel for PDA operation 

 

 

3) Click the Setup button to open the PDA Configuration dialog box (Figure 2.33) and select the appropriate 

settings.  Normally the xenon (Xe) lamp option should be used: these settings will have been optimised and 

preset for the 10 mm pathlength.  Two other preset options are available, one for use with a deuterium (D2) lamp 

(option UV.2) and the other of which is user configurable. 
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Figure 2.33:the PDA Configuration dialog box 

 

 

If the Preset 3 option is selected, the Configure button becomes active.  Clicking this opens the Photodiode 

Array dialog box (Figure 2.34).  For further information on the settings refer to the Section 4.12.6.  

 

 
 

Figure 2.34: the Photodiode Array dialog box 

 

 

4) Ensure that the optical cell is filled with water and click Baseline in the Signal panel (Figure 2.32) to collect 

the 100% transmission signal. 

 

5) Load reagents and set the timebase, number of points and external trigger as normal then click Acquire to 

perform the drive.   
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2.9 Sequential-Mixing Stopped-Flow 

 

1. Fit the two sequential-mixing drive rams to the SHU 

2. Drain the thermostat bath 

3. Configure the flow circuit for sequential-mixing 

4. Adjust the pre-mix ram drive volume 

5. Adjust the total drive volume 

6. Flush the flow circuit 

7. Check the ram profiles 

8. Load reagents 

 

The sequential-mixing (SQ.1 option) stopped-flow experiment allows investigation of the reactivity of reaction 

intermediate species.  

 

The following procedure describes the use of the syringes and the various valves during sample loading, sample 

flow circuit flushing and sequential stopped-flow mixing. 

 

The sequential-mixing experiment employs a double pneumatic drive. The first (Pre-Mix) drive mixes the 

contents of the two right hand drive syringes (A and B) in an aging loop. After a user defined aging period (from 

0.010s to 1000s) the second (Flush) drive mixes the contents of the aging loop with a third reagent C. 
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1) The sample handling unit should be set-up with the flush drive ram connected to the left hand ram platform 

and the pre-mix drive ram connected to the right hand ram platform (Figure 2.35) 

 

 
 

Figure 2.35: sequential-mixing SHU in sequential-mixing configuration 

 

 

2) If the thermostat bath is full, remove the bleed screw at the top of the cell block to allow the fluid to drain out.  

It may be necessary to lower the circulator so that it is well below the level of the SHU.  Remove the six screws 

on the front of the thermostat bath to allow the cover to be opened. 

   

3) The flow circuit should be set-up according to the following instructions and referring to Figure 2.37 
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Figure 2.36: sequential-mixing flow lines in sequential-mixing configuration 

 

 

Remove the aging loop from the straight through connector that connects to the flush line. Remove the plugs 

from the pre-mixer and the end of the extension tube.  

 

Connect the extension tube to the straight through connector on the end of the flush line and the aging loop to 

the pre-mixer. Pressure test the flow line to make sure that it is not leaking. Replace the front of the water bath 

and the bleed screw.  

 

4) Screw the fine adjuster on the pre-mix drive ram fully upwards (clockwise if the ram is viewed from below) so 

that the ram will have no upward travel.  This is the zero drive volume position. Screw the fine adjuster five turns 

anti-clockwise to increase the drive volume. This equates to a pre-mix drive volume of approximately 220 µl. It is 

essential that the pre-mix drive volume is set to 220 µl ± 10 µl.  
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Use of the Profiles function in the Pro-Data control software allows accurate measurement of the drive volume 

and will be described in step 7. 

 

5) Screw the volume adjuster on the Auto-Stop fully clockwise (i.e. front edge moves from left to right), until the 

pneumatic connection starts to rotate, then screw it eight and a half turns anti-clockwise (counter-clockwise). 

This equates to a total drive volume of approximately 400 µl and will result in a drive 2 volume of 180 µl (±10 µl) 

assuming a pre-mix (drive 1) volume of 220 µl (±10 µl). 

 

6) Fit four reservoir syringes filled with distilled water or another suitable solvent to the A, B, C and F Luer fittings. 

It is recommended that 5 ml or 10 ml plastic disposable syringes are used.  

 

Turn the A, B, C and F drive valves to the „load‟ position. Ensure that the drive rams are pushed fully down. Fill 

the drive syringes by pushing down the plungers of the reservoir syringes. Expel any air bubbles by flushing 

backwards and forwards between the drive syringes and the reservoir syringes several times. 

 

Turn the F drive valve to the „drive‟ position and manually push the water from the drive syringe, through the flow 

circuit and into the stop syringe.  

 

Empty the stop syringe by clicking Empty on the Pro-Data control software. 

 

Repeat the above two steps until the drive syringe is empty. 

 

Flush from the other three drive syringes in the same manner as described above. 

 

Fill all four drive syringes with water and turn all of the drive valves to the „drive‟ position.  

 

Enable the sequential-mixing mode in the Pro-Data control software by opening the SHU Setup window, going to 

the Sequential tab (Figure 2.37) and ticking the Enable box followed by clicking the Apply button.  

 

 
 

Figure 2.37: the Sequential tab 
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The KSHU panel on the SCP (Figure 2.38) will indicate that the sequential-mixing mode is activated and the 

delay time currently set.   

 

 
 

Figure 2.38:the KSHU panel for sequential-mixing 

 

 

Carry out a stopped-flow drive by clicking the Drive button on the SHU Setup window. The drive profiles will be 

displayed automatically after the drive and should be used to check the accuracy of the drive 1 and 2 volumes.  

The drive syringes will need to be refilled after each drive. 

 

7) Carry out several drives and check that the drive 1 volume is 220 µl (±10 µl) and the drive 2 volume is 180 µl 

(±10 µl) from the Drive Profiles data (Figure 2.39). The drive volumes and measured delay time should be 

consistent from run to run. 

 

 
 

Figure 2.39: the Drive profiles window 

 

 

8) Ensure the all four drive valves are set to the „load‟ position. Replace the reservoir syringes with ones 

containing the samples. The F (flush) reservoir syringe should be filled with a neutral buffer solution. Fill the drive 

syringes by pushing down the pistons of the reservoir syringes (this ensures that there is no cavitation inside the 

drive syringes and, therefore, no bubbles). Ensure that there are no air bubbles in the drive syringes. 

 

Set the four drive valves to the „drive‟ position. 

 

9) The experimental procedures for the various modes of data acquisition (absorbance, fluorescence and 

fluorescence polarisation) are described elsewhere in this manual.  
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2.10 Anaerobic Stopped-Flow 

 

1. Fit purge manifold around the drive syringe plungers 

2. Turn on purge gas flow  

3. Power on the circulator  

4. Flush the drive syringes and flow circuit of the SHU with anaerobic buffer  

5. Load gas tight reservoir syringes in a glove box 

6. Transfer syringes and 3 way valves to SHU 

7. Flush the 3-way valves with buffer 

8. Flush drive syringes with sample 

9. Load drive syringes 

10. Set-up experimental parameters for stopped-flow measurements 

 

The anaerobic accessory (AN.1) equips the SX20 with a high performance bench top anaerobic capability. In 

such an environment, operating under anaerobic conditions requires stringent care with respect to eliminating 

oxygen dissolved in the thermostat medium and adsorbed into the wall material of the sample flow circuit. The 

accessory comprises a purging manifold and a set of 3-way valves. 

 

 
 

 
Figure 2.40: the anaerobic accessory purging manifold and 3-way valves 

 

 

1) The purge manifold should be fitted with the drive syringes empty and the drive rams removed.  Push it up so 

that it rests against the underside of the thermostat bath and encloses the drive syringe plungers with the gas 

tube connector pointing to the left as in Figure 2.41.  Tighten the single screw in the middle to hold it in place. 

 

 
Figure 2.41: position of the gas tube connector of the anaerobic accessory 
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2) Attach a nitrogen line to the manifold connector and adjust the gas regulation so that a slow flow of gas is 

supplied. 

 

3) The thermostatic liquid in the circulator should be purged of oxygen by gently bubbling nitrogen through it at 

25°C ± 1°C. 1 gram of sodium dithionite should be added to the thermostat liquid. The circulator must be left 

running for the duration of anaerobic operation. 

 

4) Fill the drive syringes with a solution of 600 ng/ml glucose oxidase and 10 mM glucose in 100 ml of sodium 

acetate at pH5.  Manually work the stop valve and drive ram to push this through the flow circuit.  Wait one hour 

then use deoxygenated buffer to flush the flow system.  Ensure that a small volume of buffer is left in the drive 

syringes. 

 

5) In a glove box load the samples into gas tight Luer lock syringes.  Place a three way valve on the end of each 

syringe ensuring that the syringe port is closed. 

 

6) The syringe and 3-way valve should be transferred to the stopped flow instrument. 

 

7) Connect an empty disposable syringe on to the unused port on the 3-way valve. With the 3-way valve in the 

same position (i.e. closed), turn the drive valve to the „load‟ position and push up on the drive syringe to expel the 

anaerobic buffer from the drive syringe into the empty disposable syringe on the side of the 3-way valve. This 

effectively scrubs the drive valve, Luer fitting and part of the 3-way valve making these components anaerobic. 

 

8) Open the 3-way valve by turning it 90 degrees and introduce a small amount of the anaerobic sample into the 

drive syringe.  Turn the 3-way valve back to the closed position and then push this small volume of anaerobic 

sample out through the 3-way valve to the disposable syringe (containing anaerobic buffer). This fills the valve, 

syringe and Luer fitting with sample. 

 

9) Open the 3-way valve and load the sample into the drive syringes. 

 

10) The software may now be set up for the desired stopped-flow experiment and data acquired. 
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2.11 Steady State Absorbance Scanning 

 

1. Select Absorbance mode 

2. Select spectrum mode and set time per point 

3. Select monochromator scan range and step size 

4. Acquire a baseline 

5. Load sample and acquire spectrum 

 

1) On the Signal panel of the Pro-Data SCP (Figure 2.42) select Absorbance from the drop down list.  If the 

instrument is equipped with two data acquisition channels then by ticking Fluorescence, data can be 

simultaneously acquired from the fluorescence detector. 

  

 
  

Figure 2.42: the Signal panel for steady state absorbance 

 

 

2) Ensure that Spectrum mode is selected on the Sequencer panel (Figure 2.43). 

 

 
 

Figure 2.43: the Sequencer panel for steady state absorbance 

 

 

On the Sampling panel (Figure 2.44) enter the time which the instrument will spend collecting data at each 

wavelength step in the Time-per-point box.  The greater the time per point for data sampling (and hence the 

longer the scan time) the better the signal to noise ratio will be.  
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Figure 2.44: the Sampling panel for steady state absorbance 

 

 

3) On the Monochromator panel (Figure 2.45) enter the selected wavelength range and step size. 

 

 
 

Figure 2.45: the Monochromator panel for steady state absorbance 

 

 

4) With water in the cell click the Baseline button on the Signal panel (Figure 2.42).  

 

5) Load samples into the drive syringes and push through the system to ensure that mixed reagents are in the 

cell.  Click Acquire to collect the spectrum.   

 

 

  



 

 

Document 4140Q001C02.01  Page 57 of 175  

SX20 User Manual 

2.12 Steady State Fluorescence Excitation Scanning  

 

1. Install an appropriate cut off filter 

2. Select fluorescence mode 

3. Select spectrum mode and time per point 

4. Select monochromator wavelength range, bandwidth and step size 

5. Load sample 

6. Set detector voltage 

7. Acquire data 

 

In the total fluorescence configuration it is possible to record steady-state fluorescence excitation spectra using a 

cut-off filter. This can be useful to determine the optimum excitation wavelength for subsequent single 

wavelength excitation kinetics.  

 

1) Select a long pass cut-off filter appropriate for the fluorophore being used which block scattered light of the 

excitation wavelength but pass fluorescent emission.  Applied Photophysics are able to supply a wide range of 

such filters.  

 

2) On the Signal panel of the Pro-Data SCP select Fluorescence from the drop down list (Figure 2.46).   If you 

have a second fluorescence detector with fittings, ticking the Dual Fluorescence box will allow data to be 

simultaneously acquired from the two detectors..   

 

 
 

Figure 2.46: the Signal panel for steady state fluorescence excitation 

 

 

3) Now ensure that Spectrum mode is selected on the Sequencer panel (Figure 2.47).  
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Figure 2.47: the Sequencer panel for steady state fluorescence excitation 

 

 

On the Sampling panel (Figure 2.48) enter the time which the instrument will spend collecting data at each 

wavelength step in the Time-per-point box.  The greater the time per point for data sampling (and hence the 

longer the scan time) the better the signal to noise ratio will be.  

 

 
 

Figure 2.48: the Sampling panel for steady state fluorescence excitation 

 

 

4) On the Monochromator (Mono 1) panel (Figure 2.49) enter the selected excitation wavelength range and 

step size.  Ensure that the excitation wavelength is always shorter than the cut off wavelength of the filter.  The 

monochromator slits should be opened to 1 nm using the dials. 

 

 
 

Figure 2.49: the Monochromator panel for steady state fluorescence excitation 

 

 

5) Load the drive syringes and either click the Drive button or manually push reagents through the system to 

ensure that fluorescent reagents will be in the flow cell. 

 

6) If the excitation maximum is known then type this wavelength into the Wavelength (nm) box on the 

Monochromator panel and click Set.  The monochromator will immediately move to this wavelength.  Now click 

the „…‟ button next to the Fluorescence box on the Detector High Voltages panel (Figure 2.50)  

 

 
 

Figure 2.50: the Detector High Voltages panel 

 

 

This will open the Set HV dialog box (Figure 2.51).   
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Figure 2.51: the Set HV dialog box 

 

 

Now click the AutoPM button.  This will cause a suitable voltage to be applied to the detector to ensure that the 

signal during the scan will not go off scale.  When the excitation maximum is not known, setting the high voltage 

will be a matter of trial and error. Voltages can be entered directly in the appropriate box in the Detector High 

Voltages panel (Figure 2.50).  

 

7) Click Acquire on the Sequencer panel (Figure 2.47) to start acquiring the spectrum.     
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2.13 Steady State Fluorescence Emission Scanning  

 

Emission scanning requires that the SX20 is equipped with the SEM.1 accessory. 

 

1. Connect emission light guide 

2. Select spectrum mode and time per point 

3. Select fluorescence mode and emission mono 

4. Select excitation and emission wavelengths and bandwidths  

5. Load sample 

6. Set detector voltage 

7. Acquire data 

 

 

1) Install the emission light guide fitting in the upper right hand port of the cell block (assuming that the excitation 

light guide is connected to the lower right port for a 2 mm excitation path).  Move the fluorescence detector to the 

opposite port of the emission monochromator, blanking off the rear port on the cell block using the circular plate 

(Figure 2.52). 

 

 
 

Figure 2.52: the monochromator positions for steady state fluorescence emission 

 

 

2) Now ensure that Spectrum mode is selected on the Sequencer panel (Figure 2.53) 

 

 
 

Figure 2.53: the Sequencer panel for steady state fluorescence emission 

 

 

On the Sampling panel (Figure 2.54) enter the time which the instrument will spend collecting data at each 

wavelength step in the Time-per-point box.  The greater the time per point for data sampling (and hence the 

longer the scan time) the better the signal to noise ratio will be. When the Set button is clicked on the 

Monochromator panel an approximate time for the scan will be displayed. 
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Figure 2.54: the Sampling panel for steady state fluorescence emission 

 

 

3) On the Signal panel of the Pro-Data SCP select Fluorescence in the drop down list (Figure 2.55).   Tick the 

Emission mono box and ensure that Emission scanning is selected.  The excitation scanning option allows an 

excitation scan to be carried out using the second monochromator instead of a cut off filter to select the emission 

wavelength to be monitored.   

 

 
 

Figure 2.55: the Signal panel for steady state fluorescence emission 

 

 

4) On the Excitation mono (Mono 1) panel (Figure 2.56) enter the selected excitation wavelength and 

bandwidth and click Set.  On the Emission mono (Mono 2) panel enter a scan range and step size.   

 

 
 

Figure 2.56: the Monochromator panels for steady state fluorescence emission 

 

 

5) Load the drive syringes and either click the Drive button or manually push reagents through the system to 

ensure that fluorescent reagents will are in the flow cell. 
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6) If the peak emission wavelength is known then the emission monochromator should be set to this value so 

that the fluorescence detector high voltage can be set to give a suitable signal at this point.  This is done using 

the AutoPM button as in a total fluorescence experiment.  If the peak emission wavelength is not known then 

setting an appropriate detector voltage will be a matter of trial and error.        

 

7) The scan can now be started by clicking Acquire. 
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3 HARDWARE AND ACCESSORIES 

3.1 Introduction 

This Chapter is a reference guide to the hardware of the SX20 stopped-flow reaction analyser. It describes the 

set-up, operation and routine maintenance of the hardware of the instrument. A trouble-shooting guide is also 

included to help the user fault find commonly encountered problems. 

 

3.2 SX20 Stopped-Flow Reaction Analyser 

This section describes the experimental capabilities of the standard configuration SX20 stopped-flow reaction 

analyser and the components that comprise the system.    

 

3.2.1 Description 

The SX20 stopped-flow system in its standard configuration, without any of the optional accessories described 

later in this section, allows the user to carry out single-mixing stopped-flow measurements. The user can select 

between detection of absorbance kinetics at a single wavelength or fluorescence kinetics using an optical filter to 

isolate the fluorescence signal.   

 

3.2.2 Components 

The standard configuration SX20 stopped-flow system consists of the following major hardware components:  

 

 150 watt xenon lamp power supply and igniter unit 

 150 watt xenon lamp housing (lamp fitted) 

 Monochromator (Mono 1) 

 Optical rail for mounting of the lamp housing and monochromator 

 Fibre optic light guide 

 Sample handling unit fitted with 20µl cell cartridge 

 Absorbance detector 

 Fluorescence detector 

 Electronics Unit fitted with single detection channel 

 Computer fitted with USB module and monitor 

 

These components will be described in detail later in this section. In addition to the major components, the SX20 

system is supplied with the following ancillary components: 

 

 Mains electricity distribution board and mains cables 

 Set of cables for electrical connection of the SX20 major components 

 Pneumatic tubing and connectors for connecting the system to an 8 bar gas supply 

 In-line pressure regulator for controlling drive pressure 

 Storage case including toolkit and consumable spares kit 

 Electronic user manual and back-up software 
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3.3 SX20 Optional Accessories 

This section describes the optional accessories that are available for the SX20 system. These options are 

available for new systems or as upgrades to existing systems as the research interests of the user evolve. 

 

3.3.1 SQ.1 Sequential- (Double-) Mixing Option 

The sequential- (double-) mixing option equips the sample handling unit with four drive syringes and permits the 

mixing of two reagents (A+B) with a first mixing drive and after a user defined delay period, mixes the aged 

solution with a third reagent (C). This option consists of the following components: 

 

 A sequential-mixing sample handling unit  

 2 sequential-mixing drive rams 

 Stop syringe brake mechanism  

 

3.3.2 SEM.1 Emission Scanning Option 

This emission scanning option extends the fluorescence detection capability of the SX20. An emission 

monochromator located between the optical cell and the fluorescence detector allows collection of fluorescence 

kinetic traces at a single wavelength and collection of steady state and time resolved emission spectra. It 

consists of the following components: 

 

 Emission monochromator (Mono 2)  

 Second optical rail and four supports 

 Emission fibre optic light guide 

 

3.3.3 AM.1 Extended Absorbance Option 

The extended absorbance option provides improved stray light performance in the far UV enabling accurate 

absorbance measurements up to 2 AU below 250 nm. It consists of the following components:  

 

 Second monochromator (Mono 2)  

 Extended optical rail  

 Mono 1 to Mono 2 optical coupler  

 

3.3.4 PDA.1 Photodiode Array Option 

The Photodiode Array (PDA) option allows collection of time resolved absorbance spectra from a single stopped-

flow drive. There are two versions available: a UV region PDA operates over the wavelength region 180-750 nm, 

and a visible region PDA operates over the wavelength range 350-1100 nm. The PDA consists of the following 

components: 

 

Photodiode array unit (UV or visible version) 

PDA fibre optic light guide (xenon light source version) 

Electronics Unit PDA module  

 

 

3.3.5 UV.1 Deuterium Light Source Option 

The deuterium light source option allows the collection of PDA data using the UV version PDA accessory down 

to 200 nm. The option consists of the following components:- 

 

 Deuterium lamp power supply unit 

 Deuterium lamp housing (lamp fitted) 

 PDA fibre optic light guide (deuterium light source version) 
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3.3.6 DD.1 Dual Channel Detection Option 

The dual channel detection accessory allows fluorescence and absorbance data to be collected simultaneously 

using the absorbance and fluorescence PMT detectors. It consists of the following components:  

 

 Dual channel PMT module fitted in the Electronics Unit.  

 Detector cable for connecting the detector to the PMT module.  

 

3.3.7 DF.1 Dual Fluorescence Detection Option 

The dual channel fluorescence detection accessory allows fluorescence data to be collected simultaneously 

using two fluorescence PMT detectors. It requires the DD.1 dual channel option and consists of the following 

additional components:  

 

 Additional fluorescence detector 

 Fluorescence detector mounting fittings and filter holder 

 

3.3.8 FP.1 Fluorescence Polarisation Option 

The fluorescence polarisation accessory allows collection of polarisation and anisotropy signals. It consists of the 

following components: 

 

 Additional fluorescence detector 

 T-format excitation and emission polarizer accessory 

 

3.3.9 RC.1 5 L Rapid Kinetics Cell Option  

The 5 L rapid kinetics cell allows collection of stopped-flow data with a dead time of 0.45 ms. The cell is 

mounted in an interchangeable cell cartridge supplied in a protective storage case and is supplied with a 1 ml 

stop syringe. 

 

3.3.10 QFA.1 Quench Flow Adaptor Option 

The quench flow accessory utilises the sequential-mixing capability of the SHU. The adaptor is mounted in the 

standard interchangeable cell cartridge and is fitted with a basic sample collection loop. 

 

3.3.11 AN.1 Anaerobic Accessory  

The anaerobic accessory improves the ease with which anaerobic experiments can be performed without the 

need for a glove-box environment. It consists of the following components:  

 

 Pack of ten 3-way valves for loading anaerobic samples into the SHU 

 Nitrogen purging manifold that connects to the sample handling unit 
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3.4 SX20 Instrument Set-up 

This section describes the basic set-up procedure and configuration of the SX20 stopped-flow reaction analyser. 

More detailed information relating to the set-up and connections of each component of the system is provided 

later in this chapter. 

 

3.4.1 Site Requirements 

The SX20 should be set-up in a clean laboratory environment on a sturdy work surface. The laboratory 

temperature should be maintained within the range 15-35
o
C. 

 

 The minimum space requirement for the SX20 (length x depth x height) is:  

 Standard system: 1.5 x 0.8 x 0.6 metres 

 With AM.1 accessory: 1.8 x 0.8 x 0.6 metres 

 

The SX20 requires a stable mains electricity supply of 85-264 volts.  

 

The sample handling unit is pneumatically driven and requires a compressed gas supply (preferably nitrogen) 

capable of operating at 8 bar (120 psi). The supply should be fitted with a push-on tube adaptor to accept the 

flexible hose (6 mm internal diameter) that connects to the SHU inlets. 

 

For connection to a water circulator unit, the SHU is provided with an inlet and outlet fitting compatible with a 

flexible hose of 8 mm internal diameter.  

 
SX20 Hardware General Set-up 

Figure 3.1 shows the standard arrangement of the major hardware components of the system. 

 

 
 

 

 

 

 
 
 

Figure 3.1: the main components of the SX20  
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The major components of the SX20 spectrophotometer should be assembled according to  

Figure 3.1, with the lamp housing and monochromator positioned on the optical rail to the right of the sample 

handling unit. (Note: the sample-handling unit is shown with the sequential-mixing SQ.1 option fitted). 

 

SX20 systems equipped with the SEM.1 and AM.1 options are supplied with two monochromators and an 

extended optical rail. The set-up of these systems should be assembled according to the instructions provided in 

Sections 3.6.1 and 3.6.2 respectively. 

 

3.4.2 Lamp Power Supply Unit 

The 150 watt xenon lamp power supply unit is generally located to the right of the optical rail. Suitable clearance 

to the rear and left hand side should be allowed for ventilation of this unit. 

 

3.4.3 Xenon Arc Lamp Housing 

The 150 watt xenon lamp housing is mounted on the right hand side of the optical rail. A magnet assembly is 

sometimes attached to the rear of the housing. This provides magnetic stabilisation of the lamp arc.  

 

 

3.4.4 Monochromator 

The monochromator is located on the left hand side of the optical rail to the right of the 150 watt xenon arc lamp 

housing. It is essential that the lamp housing and monochromator are correctly coupled together. The two units 

must be pushed together so that the exit port of the lamp locates firmly with the entrance port of the 

monochromator. Both units should be locked in position on the optical rail using the four plastic screws on each 

unit   

 

3.4.5 USB Communications 

The USB cable provided is used to connect the communications module on the SX20 electronics unit to the 

USB3 port on the workstation 

 

3.4.6 Sample Handling Unit 

Pneumatic Connections - The stopped flow operation of the sample handling unit is driven by a compressed 

gas supply. A nitrogen cylinder is recommended for this purpose and must be regulated to 8 bar (120 psi).  A 

length of flexible tube (6 mm internal diameter) is supplied for connecting the cylinder to the sample handling 

unit.   

 

The cylinder pressure regulator should be fitted with a push-on fitting to accommodate the flexible tube which is 

clamped onto the fitting with the finger-tightened hose clamp supplied with the system. 

 

The main pneumatic inlets (labelled 1 & 2) are located on the rear of the sample handling unit. Port 1 is internally 

connected to the auto-stop and, on sample handling units equipped for sequential-mixing, the right hand drive 

ram. Port 2 is connected to the left hand drive ram. 

 

An h-shaped pneumatic tubing arrangement allows both of these ports to be connected to the flexible tube of the 

compressed gas supply (Figure 3.2). The arrangement also incorporates an in-line pressure regulator that is 

used to adjust the drive pressure of the left hand drive ram. This regulator is set to 4 bar (60 psi), except for 

asymmetric mixing (Section 3.22).  
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Figure 3.2: pneumatic connections to the Sample Handling Unit 

 

 

This connector may additionally be used for supplying nitrogen to the lamp housing when using ozone-producing 

lamps or when using the anaerobic purging manifold. Detailed instructions for operating with ozone-producing 

lamps are provided in Section 3.16. 

 

Stopped-Flow Circuit - The flow circuit of the sample handling unit requires connection of the waste flow tube to 

the outlet of the stop valve. Place the free end of the waste tube into a suitable receptacle. 

 

To prevent damage to the optical cell during shipping, the flow circuit is filled with an antifreeze 

solution. The flow circuit should be flushed thoroughly with purified water prior to use. 

 

Water Circulator Connections - Two tubing connections on the lower right of the sample handling unit water 

bath permit connection of a circulating thermostatic water bath to the stopped-flow sample handling unit. The 

front port is the inlet and the rear port is the outlet. It is important that the inlet and outlet are connected correctly 

otherwise the sample handling unit water bath will not fill correctly. It is recommended that the circulating 

thermostatic water bath is positioned below the sample-handling unit to aid the drainage procedure for the water 

bath.  

 
  

Set to 4 bar 

8 bar 
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3.4.7 Safety cover 

 

The SX20 drive rams are pneumatically driven and could trap hands or clothing, causing injury to 

the user. Keep hands and clothing clear when performing a drive, and never perform a drive 

without the safety cover in place. 

 

 
 

Figure 3.3: the SX20 with the safety cover in place 

 

 

The safety cover is a transparent shield that fits easily over the drive and stop syringes to protect the user. The 

cover is shown mounted on an SX20 in single-mixing configuration in Figure 3.3. 

 

3.4.8 Absorbance Detector 

The absorbance photomultiplier tube detector is connected to one of the two upper ports of the cell housing and 

opposite the port used for the light input. A plastic blanking plug should be placed over each of the unused ports. 

 

3.4.9 Fluorescence Detector  

The fluorescence photomultiplier tube detector is connected to the rear port on the cell housing. The light guide 

is normally connected to the short pathlength port (lower right hand side) of the cell housing.  

 

3.4.10 Electronics Unit  

The electronics unit should be positioned to the left of the sample handling unit.  

 

3.4.11 Workstation and Monitor  

The workstation (PC) is normally positioned to the left of the electronics unit. The monitor is positioned above the 

electronics unit.  
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3.5 Electrical Set-up 

This section describes the basic electrical set-up of the SX20 stopped-flow reaction analyser. It systematically 

lists the connections that must be made between the various components of the system. 

 

The SX20 spectrometer is powered by  the mains electricity supply which can produce a shock 

leading to serious injury or death. Do not connect or disconnect the instrument from the mains 

supply unless the supply is powered off at source. Ensure all communications and electrical 

connections are made before powering on the spectrometer. Exercise care during operation and 

do not operate units with their covers removed. Operate the spectrometer using only the cables 

provided. Never operate a spectrometer with damaged cables.  

 

3.5.1 Mains Electricity Supply 

The lamp power supply unit and electronics unit feature a universal mains power supply and do not need to be 

set for the mains electricity voltage of your particular country. These units are provided with mains cables 

terminated in IEC plugs. These plugs should be connected to the distribution board provided. The distribution 

board should be fitted with a plug suitable for the mains sockets fitted in your laboratory. This means that only 

one socket is required to power the entire system. The workstation PC and monitor are also each supplied with a 

mains cable for connection to the distribution board. 

 

Figure 3.4 and Figure 3.5 show the mains supply connections. 

 

3.5.2 Earth (Ground) Connections 

 

The design of the spectrometer provides protection against electrical shock by earthing 

(grounding) appropriate metal components. This protection will be lost unless the power cable is 

connected to a properly earthed outlet. It is the user‟s responsibility to ensure that a proper earth 

connection can be made.   

 

The electronic circuitry used in the stopped-flow spectrometer is very sensitive and must be 

correctly grounded to avoid electrical interference. The lamp power supply unit, the lamp housing 

and the mains distribution board all have earth posts that must be connected to the earth post on 

the optical rail via the braided earth straps provided with the system. 

 

The system is earthed through the mains supply earth. Figure 3.4 shows the basic configuration of the earth 

connections. Note that the other components of the system are separately earthed. 
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Figure 3.4: SX20 mains supply and earth connections 

 

 

 
 

Figure 3.5: SX20 electrical connections 
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3.5.3 Lamp Power Supply Unit 

 

The cables running between the power supply and the lamp housing carry high voltages during 

lamp ignition that could cause interference with other electronic devices and cables: keep other 

devices and cables at least 30 cm away. 

 

One loose braided cable provides the earth link between the lamp power supply and the optical rail. In addition to 

the mains inlet socket, there are sockets for two output cables from the safe-start igniter of the lamp power 

supply. These outputs are connected to the inlet sockets on the lamp housing unit using the loose black and red 

cables. The black cable is the negative and also carries the 13000 volt ignition pulse to start the lamp, hence the 

heavy insulation. The red cable is the positive.  

 

3.5.4 150 watt Xenon Arc Lamp Housing 

One loose braided cable provides the earth link between the lamp housing and the optical rail. The lamp housing 

is fitted with two input terminals (black negative and red positive) that are connected to the lamp power supply 

unit. 

 

3.5.5 Monochromators 

For systems with one monochromator, the grey monochromator cable fitted with a 9-pin D-connector is 

connected to the Drive 1 port on the control module of the electronics unit. For SX20 systems fitted with the 

SEM.1 or AM.1 option (i.e. two monochromators) Mono 1 must be connected to the Drive 1 port and Mono 2 

must be connected to the Drive 2 port on the control module of the Electronics Unit.  

 

3.5.6 Sample Handling Unit 

The sample handling unit is connected to the KSHU module in the Electronics Unit via a black cable fitted with a 

44-pin D-connector.  

 

3.5.7 Absorbance Detector 

The absorbance detector is connected to channel 1 of the PMT module on the electronics rack via a black cable 

fitted with a 10-pin D-connector. 

 

3.5.8 Fluorescence Detector 

The end window fluorescence detector is connected to channel 2 of the PMT module on the electronics rack via 

a black cable fitted with a 10-pin D-connector. 

 

3.5.9 Electronics Unit 

The electronics unit (Figure 3.6) contains a number of plug-in modules for controlling the various operations of 

the stopped-flow system. It is fitted with one mains supply input. The modules are fitted with a range of sockets 

and must be connected as follows: 

 

 
 

Figure 3.6: the rear of the Electronics Unit 
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12V and 5V Supply Modules - These modules are not connected to other components on the SX20. 

 

Communications Module - This is connected to the USB3 module housed in the workstation PC via a USB 

communication cable. The Temp Inputs port is currently redundant on the SX20. 

 

Control Module 1 - This provides control of the monochromators. For systems with one monochromator, the 

monochromator must be connected to the Drive 1 port. For SX20 systems fitted with the SEM.1 or AM.1 options, 

(i.e. two monochromators), Mono 1 must be connected to the Drive 1 port and Mono 2 must be connected to the 

Drive 2 port. 

 

KSHU Module - This provides control of the stopped-flow sample handling unit. The sample handling unit is 

connected via a black cable fitted with a 44-pin D-connector. The Lamp Cont port is currently redundant on the 

SX20 system. 

 

PMT Module - This provides control of the photomultiplier tubes. There are two versions of the PMT module. 

The single channel PMT module provides a single channel for fluorescence or absorbance measurement. The 

detector is connected via a black cable fitted with a 10-pin D-connector. In the case of the dual channel PMT 

module, the absorbance detector is connected to Channel 1 via a black cable fitted with a 10-pin D-connector. 

The fluorescence detector is connected to Channel 2 via a black cable fitted with a 10-pin D-connector. 

 

PDA Module - For systems equipped with the photodiode array option, this module controls the PDA unit which 

is mounted on the back of the sample handling unit. The PDA unit is connected to the module via a black cable 

fitted with a 26-pin D-connector. 

 

3.5.10 Workstation and Monitor  

Refer to the user manuals supplied with these units for detailed instructions relating to electrical connections.  

The workstation houses a USB3 card that is connected to the communications module of the Electronics Unit via 

a USB communication cable. 
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3.6 SX20 Optional Accessories Basic Set-up  

This section describes the set-up of the optional accessories for the SX20 system. The basic instrument 

configuration does not alter significantly for any of the optional accessories with the exception of options SEM.1 

and AM.1 which feature a second monochromator. Instrument set-up for other optional accessories will be 

described fully in the relevant operating instructions section. 

 

3.6.1 SEM.1 Scanning Emission Monochromator Option 

This option features a two-tiered optical rail and second monochromator. The instrument layout for this option is 

shown in Figure 3.7. 

. 

 

 
 

 

 

 

 
 
 

Figure 3.7: the SX20 with scanning emission monochromator 

 

 

The general assembly of the components is similar to the basic system. However, the following points should be 

noted: 

 

 The lamp is always connected to monochromator 1 and never to monochromator 2. 

 Monochromator 2 is connected to the Drive 2 port of Control Module 1 in the Electronics Unit. 

 The excitation light guide has a rectangular bundle of fibres of dimensions 5 mm x 1 mm at the SHU 

end. The emission light guide has a circular bundle of fibres of 3.5 mm diameter at the SHU end.  
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3.6.2 AM.1 Extended Absorbance Option 

This option features an extended optical rail and second monochromator. The instrument layout for this option is 

shown in Figure 3.8: 

 

 
 

 
 
 
 
 

Figure 3.8: the SX20 in extended absorbance mode 

 

 

The general assembly of the components is similar to the basic system. However, the following points should be 

noted: 

 

 The lamp is always connected to monochromator 1 and never to monochromator 2. 

 Monochromator 2 is connected to the Drive 2 port of Control Module 1 in the Electronics Unit. 

 The monochromators are connected using the mono-to-mono opto-coupler.  
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3.7 Sample Handling Unit  

3.7.1 Introduction 

The Sample Handling Unit (SHU) is the heart of the SX20 stopped-flow reaction analyser where reagents are 

loaded, mixed and monitored for a signal change. Figure 3.9 shows an SHU equipped with the sequential 

(double) mixing (SQ.1) option. Principal components of the system are labelled for reference purposes and are 

described in detail in this section. 

 
 

Figure 3.9: SHU fitted with sequential-mixing option 

 

 

Figure 3.9 shows the SHU fitted with the sequential- (double-) mixing option. This option equips the SHU with 4 

drive syringes and 2 pneumatic drive rams. The standard single-mix system is equipped with 2 drive syringes 

and 1 pneumatic drive ram. The operation of each SHU is identical for single-mixing stopped-flow experiments. 

 

The flow circuit comprises 2 drive syringes, 2 drive valves, 3 flow tubes, optical cell, stop valve and stop syringe. 

With the exception of the last two components, the flow circuit is enclosed by a water bath to provide 

temperature control of the reagents and their reaction.  

 

Reagents are loaded into separate drive syringes from reservoir syringes. The direction of flow into and out of 

the drive syringe is controlled by a drive valve. The direction of flow is manually selected by the user via the drive 

valve control knob. 

 

The SHU features a pneumatic drive system that drives the reagents from the drive syringes through two micro 

volume flow tubes into an optical flow through cell. The optical cell contains an integral T-mixer which under 

pressure causes highly efficient mixing of the two reagents. This reaction mixture is stopped in the observation 

chamber of the optical cell. 
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Each pneumatic drive displaces the current reaction mixture from the observation chamber to the stop syringe 

via a waste flow tube and subsequently to a waste vessel. 

 

The volume of each drive is accurately controlled via the Auto-Stop mechanism. This mechanism is also 

responsible for triggering the data acquisition procedure.  

 

The cell housing employs a removable cartridge design in which the optical cell is mounted. This provides the 

capability for rapidly changing the optical cell according to experimental requirements. 

 

The cell housing features five observation ports that provide user friendly flexibility in measurement of 

absorbance and fluorescence based signals. 

   

3.7.2 Description of a Stopped-Flow Drive 

The following sequence of events occurs for each stopped-flow drive: 

 

1. The stop syringe is emptied of a set volume of solution by the auto-stop mechanism. This volume 

equates to the drive volume that will be mixed later in the sequence by the drive ram. There are three 

steps to this process. Firstly, the stop valve is turned to the Empty position. Secondly, the return cylinder 

is raised to displace a fixed volume of solution from the stop syringe. Finally, the return cylinder returns 

to its initial position and the stop valve is powered to the Drive position. 

2. The drive ram fires, pushing the reagents from the two drive syringes through the flow tubes into the 

optical cell. The optical cell contains a T-mixer that accounts for thorough mixing of the two reagents 

prior to the observation window.  

3. The flow of the mixed solution is stopped at the moment the stop syringe plunger contacts the copper 

trigger on the Auto-Stop mechanism, i.e. once the selected drive volume has been mixed.  

4. A signal is monitored as set up in the software.   
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3.7.3 Stopped-Flow Circuit 

A schematic of the single-mix flow circuit is shown in Figure 3.10.  

 

 

 
 

Figure 3.10: single-mixing flow circuit 

 

 

The flow circuit consists of the following key components: 

 

 drive valves for loading the reagents into the drive syringes 

 drive syringes for storing the reagents prior to mixing 

 2 flow tubes for transferring the reagents from the drive syringes to the optical cell 

 1 optical cell with an integral T-mixer where the reagents are mixed and an observation chamber with 

two different optical pathlengths. 

 1 waste flow tube for transferring the mixed reagents from the optical cell to the Auto-Stop unit. 
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 1 stop valve that controls the flow from the optical cell to the stop syringe and from the stop syringe to 

the waste collection vessel. 

 1stop syringe that is emptied and filled during the stopped-flow process.  

 

The sequential- (double-) mixing flow circuit features two additional drive valves and drive syringes plus extra 

flow tubing. This configuration is described fully in Section 3.21.2. 

 

3.7.4 Drive Syringes 

Two 2.5 ml drive syringes are fitted to the standard single-mixing SHU. The drive syringe is screwed into the 

base plate of the drive valve and is filled with the reagent solution that is mixed during the stopped-flow drive. 

The plastic piston is constructed of PEEK to protect against corrosion. The tip of the piston is PTFE. The SHU 

water bath is fitted with rubber grommets to provide a leak-free seal between the drive syringe and the water 

bath housing.  

 

In addition to the standard Kloehn manufactured 2.5 ml syringe, use of Hamilton syringes of different volumes 

may be used to achieve asymmetric mixing ratios (Section 3.22).  

 

The normal temperature operating range of the drive syringes determines the operating range of the SX20 to 5
o
C 

to 50
o
C. Above 50

o
C, the adhesive used to bond the syringe will deteriorate. Below 5

o
C the syringe piston tip 

does not seal with the glass barrel. A special low temperature syringe is available for work below 10
o
C. 

 

3.7.5 Drive Valves 

Two PEEK drive valves are fitted to the standard single-mixing sample handling unit. There are left-hand and 

right-hand versions of the drive valve. The drive valve is fixed in position using a stainless steel base plate and 

two securing screws. SHUs fitted with the sequential- (double-) mixing option will be fitted with four drive valves.  

 

Figure 3.11 shows a right-hand drive valve with its respective base plate and screws. Note that the two O-rings 

fitted to seal the valve are not shown. 

 

 
Figure 3.11: a right hand drive valve 

 

 

The drive valves control the flow of solution between the drive syringe and either the reservoir syringe or the 

flow-circuit. The Load position is used to control the flow of the drive syringe to and from the reservoir syringes 
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via a female Luer fitting. The Drive position is used to control the flow from the drive syringe towards the optical 

cell via a PEEK micro volume flow tube. Each drive valve is controlled manually by turning the control knob 90
o
 

between the Load and Drive positions. Figure 3.12 shows the orientation of the valves in both positions. 

 

 
Figure 3.12: drive valves in Drive position (left) and Load position (right) 

 

 

3.7.6 Stop Syringe 

A 2.5 ml stop syringe is fitted to the SHU. Its purpose is to act as a small reservoir of waste solution from which a 

volume equal to the drive volume may be displaced prior to the stopped-flow drive. At the time of the drive, the 

stop syringe is refilled and the action of the plunger striking the trigger indicates that the drive is completed and 

activates the acquisition of data. The stop syringe is screwed into the lower threaded port of the stop valve and 

supported in this position by the stop syringe clamp. The plastic piston is constructed of PEEK to protect against 

corrosion. The tip of the piston is PTFE. 

 

In addition to the standard Kloehn manufactured 2.5 ml stop syringe, other stop syringes may be used for 

specific experiments. For rapid kinetic measurements (rate constants in excess of 500 s
-1

) a smaller volume 1 ml 

Hamilton manufactured stop syringe is recommended for improved data fitting.
 

 

3.7.7 Stop Valve 

The stop valve controls the flow of solution from the flow circuit into the stop syringe and from the stop syringe to 

the waste vessel. The stop valve may be turned manually using a control knob or automatically via the software 

controlled Auto-Stop mechanism. The Drive position is used to control the flow from the flow circuit to the stop 

syringe. The Empty position is used to control the flow from the stop syringe to the waste vessel. The Drive and 

Empty positions are shown in Figure 3.13.  
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Figure 3.13: stop valve in Drive position (left) and Empty position (right) 

 

 

The body of the valve is constructed of PEEK with a plastic spindle. The 180
o
 rotation of the spindle provides 

control of the flow direction. The spindle is retained in the valve body by a stainless steel plate. 

A stainless steel adaptor is screwed into the entrance port of the stop valve to accommodate the PEEK flow tube 

connected to the optical cell. A polypropylene tube is connected to the exit port to flow to the waste vessel.  

 

3.7.8 Flow Tubing 

The flow circuit utilises custom-made PEEK tubing terminated with compression fittings to link the drive valves 

with the optical cell and the cell with the stop valve. The rigidity and chemical inertness of PEEK make it ideally 

suited for this purpose. The internal diameter of all the flow tubing before the cell entrance is 1.56 mm. The 

waste tube connected between the cell and stop valve is 3.12 mm.  

 

All the flow tubes are connected to the various valves and connectors in the flow circuit using threaded fittings 

with the exception of those that connect to the optical cell face. These tubes are attached to the cell using a 

pressure plate, which enables both inlet tubes and the outlet tube to be tightened or loosened simultaneously. 

 

The arrangement of the pressure plate and flow lines is displayed in Figure 3.14. For the purpose of clarity, the 

drive valves have been removed. 

 
 

Figure 3.14: pressure pale and flow lines 

 

 

Waste Flow Tube
Reagents Out

Pressure Plate

Valve C Flow Tube
(Reagent In)

Securing Screw

Valve F Flow Tube
(Reagent In)



 

 

Document 4140Q001C02.01  Page 82 of 175  

SX20 User Manual 

3.7.9 PEEK compatibility 

 

PEEK is an inert thermoplastic material that is compatible with a wide range of organic solvents, acids and bases 

making it an ideal choice for the stopped-flow circuit. PEEK also offers high anaerobic performance for oxygen 

sensitive stopped-flow experiments provided that the flow-circuit has been prepared carefully. The compatibility 

of PEEK with various reagents encountered in stopped-flow measurements is outlined in Table 3.1 

 

Reagent Compatibility  Reagent Compatibility 

1,1,1 Trichloroethane A  Acetonitrile A 

1,2 Dichloroethane B  Urea A 

Carbon Tetrachloride A  Ammonium Chloride A 

Chloroform A  Calcium Salts A 

Dichloromethane B  Copper Salts A 

Dichlorobenzene A  Iron(II) Chloride B 

Ethylene Dichloride A  Iron(III) Salts A 

Trichloroethylene A  Manganese Salts A 

Aliphatic Esters A  Magnesium Salts A 

Butyl Acetate A  Nickel Salts A 

Ethyl Acetate A  Potassium Salts A 

Diethylether A  Silver Nitrate A 

Dioxane A  Sodium Salts A 

Petroleum Ether A  Tin(II) Chloride A 

Tetrahydrofuran A  Sulphites A 

Benzene A  Hydrogen Peroxide A 

Toluene A  Bleach A 

Xylene A  Soap Solution A 

Hexane A  Sodium Hydroxide A 

Phenol (dilute) A  Nitric Acid (Conc) B 

Phenol (conc) C  Sulphuric Acid (Conc) B 

Dimethylsulphoxide B  Hydrochloric Acid A 

Diphenylsulphone B    

 

 

A – No attack, no or little adsorption    B – Slight attack 

C – Severe attack 

 
Table 3.1: compatibility of PEEK with various reagents 

 

 

Please note that the information provided in Table 3.1 is provided for guidance only, and that Applied 

Photophysics cannot accept responsibility for damage to the SX system produced by the action of samples. 
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3.7.10 Interchangeable Cell Cartridge System 

The SX20 sample handling unit features a novel cell cartridge system that facilitates cartridge mounted optical 

cells to be interchanged with a minimum of work. Figure 3.15 shows a cell cartridge removed from the cell block. 

 
 

Figure 3.15: a cell cartridge removed from the cell block 

 

 

3.7.11 Procedure for changing the optical cell 

The cell currently fitted in the cell block of the sample handling unit should be removed according to the following 

procedure: 

 

1. Remove the light guide, fluorescence detector and fluorescence cut-off filter holder from the cell block. 

2. Drain the contents of the thermostat bath housing. 

3. Loosen the pressure plate that seals the three flow tubes against the face of the cell cartridge (no more 

than one rotation is sufficient). 

4. Undo the four fixing screws that secure the cell cartridge to the cell block. 

5. Carefully withdraw the cell cartridge to the rear. 

 

The refitting procedure is the reverse of the removal: 

 

1. Ensure that the O-ring seals are present. 

2. Insert the cell cartridge into the cell block so that the bevelled corner of the cartridge is aligned with that 

on top of the cell block. 

3. Secure the cartridge in position with the four captive fixing screws. 

4. Tighten the tubing pressure plate screw to ensure a good seal between the three flow tubes and the cell. 

5. Replace the light guide and detectors. 

6. Flush the flow circuit with purified water until all bubbles have been expelled. 

7. Reattach the thermostat bath cover. 

 

Whenever any component of the flow circuit has been altered, upon reassembly the user is recommended to 

check the flow circuit for leak-free operation.  
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3.7.12 Checking the flow circuit for leaks 

Leaks in the flow circuit will result in collection of unreliable data and loss of sample. The flow circuit may be 

checked for leaks using the following procedure:- 

 

1. Fill the flow circuit with water or solvent. 

2. In the software, set-up a stopped-flow drive for 10 seconds  with the drive pressure held. 

3. During the 10 second drive, closely observe the tips of the drive syringe pistons. 

4. If the pistons do not creep upwards the flow circuit is leak-free. 

 

The flow circuit is full when the stop syringe contacts the auto-stop trigger initiating data acquisition. At this 

moment the drive syringes should not be able to push more solution from the drive syringes and the pistons 

should not creep upwards. 

 

If the flow circuit leaks, the pressure held on the drive syringes over 10s will push the solution from the drive 

syringes out of the flow circuit at the location of the leak. In this case the pistons will appear to creep upwards 

during the 10 second period. 

  

3.8 Optical Cells 

All optical cells available for use on the SX20 are construction from quartz and feature an integral flow circuit and 

T-mixer located in the quartz. The dimensions of the optical windows of the cell provide the user with different 

optical pathlengths and dead times. Figure 3.16 shows the internal design of the 20 µl optical cell: 

 

 

 

 

 
 
 
 
 
 
 
 
 

Figure 3.16: the optical cell 

 

 

3.8.1 Cell Pathlengths and Dead Times 

Table 3.2  lists the pathlengths and approximate stopped-flow dead times of the optical cells available from 

Applied Photophysics.  

 

Cell Volume Pathlengths Uses Dead Time 

20 µl 10 mm +2 mm Standard SF 1 ms 

5 µl 5 mm + 1 mm Rapid SF 500 µs 

 
  Table 3.2: dead times and pathlengths for available optical cells  
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E

A

C

B

D

Air Bleed

Cell Cartridge Screws

Cell Cartridge Ports

All SX20 systems are supplied with the standard 20 µl optical cell. This cell is the most sensitive for emission 

based measurements and has a dead time of approximately 1 ms. The 5 µl cell provides extra pathlength options 

and a shorter dead time (500 µs) however the fluorescence sensitivity is lower than the standard cell owing to the 

smaller fluorescence window in the 5 µl cell.  

 

Note that the 5 µl cell must be operated with the 1 ml stop syringe provided with the cell.  

 

3.8.2 Absorbance Pathlength Selection 

The optical cells feature a long and short pathlength (10 mm and 2 mm for the standard 20 µl cell). The 

pathlength is selected according to the positioning of the light guide and absorbance detector on the cell block. 

 

 

Figure 3.17 shows the rear of the cell block and the configuration of the light guide and detector to select each 

pathlength. 

 

 

 

               
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.17: the rear of the cell block 

 

 

The long pathlength is between ports C and A. The short pathlength is between ports D and B. The optical 

pathlength is selected by moving the absorbance PMT detector (A or B ports) and light guide (C or D ports) to 

the respective ports on the cell block. 

 

The absorbance pathlength also applies to using the optional photodiode array detector. Further information on 

use of the PDA is provided in Section 3.20.  

 

3.8.3 Fluorescence Excitation Pathlength Selection 

The fluorescence detector mounting (port E) is at the rear of the cell block and the emission PMT detector should 

be mounted using the rubber light seal, finger screws and nylon washers provided. When measuring 

fluorescence the excitation light guide should be connected to the D port to give the best illumination and lowest 

inner filter effect.  
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3.9 The Auto-Stop Mechanism 

The Auto-Stop mechanism is mounted on the front left hand side of the Sample Handling Unit. It has two main 

functions:  

 

 To control the volume of each stopped-flow drive. 

 To trigger data acquisition at the moment the flow is stopped. 

 

    
Figure 3.18: the Auto-Stop mechanism 

 

 

The Auto-Stop mechanism, shown in Figure 3.18, comprises a number of important components: 

 

Auto-Stop Actuator - This provides automated stop valve control via the software. It switches between the Drive 

and Empty positions driven by compressed gas (8 bar, 120 psi). The plastic control knob provides an option to 

control the stop valve manually. 

 

Stop Valve - This controls the flow of reagents into the stop syringe (Drive position) and out of the stop syringe 

to the waste vessel (Empty position).  

 

Stop Syringe - The emptying of this syringe controls the drive volume. A number of syringe options are 

available. 

Stop Syringe Clamp - This provides support for the stop syringe. 

 

Brake Assembly - This is required only for sequential- (double-) mixing experiments. 

Control knob 
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Stopped-Flow Trigger - This completes a circuit once contacted by the piston of the stop syringe to start the 

data acquisition. 

 

Return Cylinder - This upward movement of the cylinder empties the stop syringe. It also contains the adjuster 

for setting the drive volume. The Return Cylinder is pneumatically driven by compressed gas. 

 

3.9.1 Setting the Drive Volume 

 

 
Figure 3.19: the return cylinder 

 

 

The volume of a stopped-flow drive is controlled using the adjuster screw on the return cylinder (Figure 3.19). 

This adjuster sets the vertical limit of travel for the return cylinder. The zero drive volume is set by turning the 

screw clockwise to the limit of its travel. The volume is increased by releasing the screw a set number of turns.  

 

Using the standard 2.5 ml stop syringe, one full turn of the adjuster screw equates to a total drive volume of 

approximately 40 µl. The exact drive volume required for a stopped-flow experiment will depend on a number of 

factors including the type of measurement, the acquisition time and physical properties of the reagents. 

Recommended drive volumes are provided in the relevant sections of this chapter.  

 

3.9.2 Software Control of the Auto-Stop Mechanism 

The stop syringe is emptied by clicking the Empty button in the Pro-Data SCP. This action completes the empty 

cycle of the Auto-Stop mechanism. This function is useful for priming the flow-circuit during the experimental set-

up routine to maximise sample economy. 

 

The software provides control of three solenoid valves that open and close to apply high pressure to the actuator 

and return cylinder via three plastic tubes labelled A, B and C. A rotates the stop valve to the Empty position, B 

raises the return cylinder to empty the stop syringe by a set volume and C rotates the stop valve back to the 

Drive position. The timing of these operations is critical and is controlled via the Waste Timings function in the 

Pro-Data SCP. Under normal circumstances the user will not need to alter these timings  
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3.9.3 Manual Control of the Auto-Stop Mechanism                              

The Auto-Stop mechanism may be manually operated to empty the stop syringe. This is particularly useful for 

cleaning the flow circuit before and after measurements. To empty the stop syringe, the following procedure 

should be used: 

 

1. Turn the control knob clockwise 180° to the rear. This is the Empty position. 

2. Grip the lower part of the Stop Syringe plunger and push upward expelling the contents of the syringe to 

the waste vessel. 

3. Return the control knob anti-clockwise 180° to the front. This is the Drive position. 

 

3.9.4 Stop Syringe Brake Mechanism 

The brake mechanism, Figure 3.18, is provided to improve the results obtained when performing sequential- 

(double-) mixing experiments. It is used to provide friction on the stop syringe plunger and hence prevent over-

run after the first drive. This would result in cavitation in the flow line and inconsistent results. The friction is 

increased by tightening the mechanism, decreased by loosening it. It must be loose for single-mixing stopped-

flow so that it does not impair the dead time of the instrument, but tightened up, as necessary, when performing 

sequential-mix experiments.  

 

Note that the sequential-mixing brake assembly is only fitted to SHUs equipped with the sequential- (double-) 

mixing option (SQ.1) 

 

3.10 Pneumatic Drive and Drive Rams 

The SX20 Sample Handling Unit features a pneumatic drive system. The drive ram acts as the interface between 

the pneumatic drive system and the flow circuit. To satisfy the differing needs of the single-mixing stopped-flow 

and sequential- (double-) mixing stopped-flow techniques, three drive rams are supplied on the full sequential-

flow machine. On the single-mixing instrument, only one drive ram is supplied. Figure 3.20 shows the three drive 

rams compatible with the SX20. 

 

 
Figure 3.20: the single-mix drive ram (left) and flush and pre-mix drive rams (right) 

  

 

Sequential-mixing experiments require great care in setting up the volumes for the first and second mixing 

drives. To assist the user in setting up the correct drive volumes, an electronic transducer is fitted in each drive 

ram mounting platform. Movement of the transducer is reported in the software and may be used to calculate the 
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drive volume. The limited travel of the transducer necessitates the use of special sequential-mix drive rams with 

a similar travel limit. In addition, the pre-mix drive ram contains a self-stop mechanism that allows the volume of 

the pre-mix drive to be set via this mechanism. The flush ram is not fitted with this mechanism and the 

corresponding drive volume is set via the auto-stop mechanism.    

 

Further information on the use of the transducer profile information to set up sequential-mixing experiments is the 

relevant sections of this chapter. 

 

3.11 Temperature Control 

The sample handling unit is fitted with a water bath to provide temperature control of stopped-flow experiments. 

A circulator unit may be connected to pump thermostatic fluid into the water bath housing surrounding the drive 

syringes, drive valves and flow tubing. The thermostatic fluid also fills the cell block ensuring temperature control 

of the entire flow circuit.  

 

A thermocouple located in the PEEK housing reports an accurate temperature measurement inside the water 

bath to the software. This temperature is recorded with each stopped-flow drive.  

 

3.11.1 Circulator Unit Connections                               

A circulator unit is connected to the SHU water bath via 8 mm tubing. The SHU is fitted with quick fit Legris-type 

fittings to allow the circulator to be connected and disconnected rapidly without the need to drain the water bath. 

The rear port is the outlet and the front port is the inlet.   

 

For circulator units equipped with an external temperature probe to compensate for temperature loss between 

the circulator and the external water bath, a probe port is provided on the right side of the   

 

3.11.2 Software Controlled Circulator Units                               

Some circulator units may be connected to a USB of the workstation PC via to provide direct temperature control 

through the SX20 control software. APL recommend the use of the A25/SC150 supplied by Thermo Fisher 

Scientific. 

  

For further information on circulator unit compatibility please contact the Technical Support Section at Applied 

Photophysics. 

 

3.11.3 Draining the Water Bath                               

The water bath can be drained according to the following procedure: 

 

1. Power off the circulator unit. 

2. Loosen the bleed screw on top of the cell block using a 2.5 mm hexagonal wrench. 

3. Allow the water bath to drain. 

4. Tighten the bleed screw on top of the cell block. 
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3.12 Absorbance Detector 

3.12.1 Description 

The SX20 is fitted with a side-window 9-stage photomultiplier tube for absorbance detection measurements. The 

standard detector (Figure 3.21) features a Hamamatsu R928 PMT capable of operation in the wavelength range 

185-900 nm.  

 

 

 

 

 

 

 

 

 

 

 

 
 
 

Figure 3.21: the absorbance detector 

 

 

3.12.2 Basic Set-Up and Electrical Connections 

 

The photomultiplier tube (PMT) detector used with the SX20 operates at high voltages and can 

produce a shock leading to serious injury or death. Do not connect or disconnect the detector 

from the spectrometer unless the spectrometer is powered off.  

 

The detector is mounted to one of the two upper ports on the cell block using two mounting screws. The detector 

position must always be opposite that of the light-guide (fitted to one of the lower ports) and this configuration 

determines which optical pathlength of the cell is selected for the measurement. See the section describing the 

cell block and optical cells for further information on available pathlengths.  

 

Absorbance measurements normally employ the 10mm pathlength of the standard 20 µl cell (or 5 mm pathlength 

of the 5 µl cell). These require the detector to be mounted to the upper right port and the light-guide to the lower 

left port of the cell block. Remember to blank off any unused ports.            

For SX20 systems fitted with a single detection channel, there will be one cable connected to the PMT Module of 

the Electronics Unit. When switching between absorbance and fluorescence detection, the cable must be 

connected to the appropriate detector. 

 

For SX20 systems fitted with dual detection channels, there will permanently be two detector cables connected 

to the PMT Module of the Electronics Unit. The absorbance detector is connected to Channel 1 and the 

fluorescence detector is connected to Channel 2. 
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3.12.3 PMT Characteristics 

The response characteristics of the Hamamatsu R928 PMT are displayed in Figure 3.22:  
 

 
 

Figure 3.22: characteristics of the Hamamatsu R928 PMT 

 

3.13 Fluorescence Detector 

3.13.1 Description 

The SX20 is fitted with an end-window 11-stage photomultiplier tube for emission detection measurements. The 

standard detector (Figure 3.23) features a Hamamatsu R6095 PMT capable of operation in the wavelength 

range 300-650nm. In addition to the standard PMT, Applied Photophysics offer alternative PMTs for applications 

requiring different detection characteristics.   

 

 
 

Figure 3.23: the standard fluorescence detector 
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3.13.2 Basic Set-Up and Electrical Connections 

 

The photomultiplier tube (PMT) detector used with the SX20 operates at high voltages and can 

produce a shock leading to serious injury or death. Do not connect or disconnect the detector 

from the spectrometer unless the spectrometer is powered off.  

 

The detector is mounted to the fluorescence port at the rear of the cell block using 3 finger screws. When fitting 

the detector, ensure that the detector light seal and the seals in the cell block are present to prevent detection of 

stray light.  

 

Fluorescence measurements are normally carried out using the 2 mm pathlength of the standard 20 µl cell (or 5 

mm pathlength of the 5 µl cell). These are accessed by fitting the excitation light-guide to the lower right port on 

the cell block. Remember to blank off any unused ports. 

 

For SX20 systems fitted with a single detection channel, there will be one cable connected to the PMT Module of 

the Electronics Unit. When switching between absorbance and fluorescence detection, the cable must be 

connected to the appropriate detector. 

 

For SX20 systems fitted with dual detection channels, there will permanently be two detector cables connected 

to the PMT Module of the Electronics Unit. The absorbance detector is connected to Channel 1 and the 

fluorescence detector is connected to Channel 2. 

 

3.13.3 PMT Characteristics 

The response characteristics of the Hamamatsu R6095 PMT are displayed in Figure 3.24:  

 

 
 Figure 3.24: characteristics of the Hamamatsu R6095 PMT   



 

 

Document 4140Q001C02.01  Page 93 of 175  

SX20 User Manual 

3.14 Dual Channel Fluorescence Set-Up 

For SX20 systems fitted with the dual channel fluorescence detection or fluorescence polarisation options, the 

second fluorescence detector must be connected to Channel 1 of the Electronics Unit PMT Module. This channel 

is normally used for absorbance measurements and the fluorescence detector is best connected by 

disconnecting the detector cable from the absorbance detector and connecting to the second fluorescence 

detector.  

 

For dual channel fluorescence detection, the second fluorescence detector should be mounted on the upper right 

port of the cell block using the twist-lock fittings supplied (Figure 3.25). The male fitting is connected to the cell 

block using 4 countersunk screws ensuring that the light sealing O-ring is fitted. The female fitting is connected to 

the end of the fluorescence detector using 3 screws. 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                           
 
 

 Figure 3.25: the setup for dual channel fluorescence 
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3.15 Monochromator 

3.15.1 Description  

The high precision automated monochromator (Figure 3.26) contains a 250 nm holographic diffraction grating 

that provides a useful operating wavelength range of 190 to beyond 850 nm (limited by PMT detector range). 

The monochromator is accurately pre-aligned and calibrated using a He-Ne laser and mercury emission lines.  

 

The wavelength of monochromatic light is selected by rotation of the grating using a stepper motor housed within 

the monochromator unit.  This motor is controlled via Control Module 1 in the Electronics Unit. This allows the 

monochromator wavelength to be set via the SX20 control software. 

 

 
 

Figure 3.26: the SX20 monochromator 

 

The monochromator entrance and exit slits are manually adjustable using the dials on the front of the 

monochromator. The dials are calibrated in millimetres and are mechanically linked to a pair of slit blades on the 

entrance and exit. A 1 mm monochromator slit opening is equivalent to a wavelength bandwidth of 4.65 nm. The 

slits provide a bandwidth range from below 0.5 nm up to 37 nm. 

 

  

Exit Port 

Exit Slit 

Control 

Entrance 

Slit Control 

Locking Screws 
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3.15.2 Basic Set-Up and Electrical Connections 

The monochromator is located on the optical rail to the left of the lamp housing. It is essential that the lamp 

housing and monochromator are correctly coupled together. The two units must be pushed together so that the 

exit port of the lamp locates firmly with the entrance port of the monochromator. To prevent vibration, both units 

should be locked in position on the optical rail using the four plastic locking screws on each unit.   

 

The monochromator control cable is connected to Port 1 of Control Module 1 in the Electronics Unit. For systems 

with two monochromators, Mono 1 must be connected to the Drive 1 port and Mono 2 must be connected to the 

Drive 2 port.  

 

3.15.3 Selecting a Suitable Monochromator Slit Width (Band Pass) 

The monochromator slit width setting is an important variable in the set-up of a stopped-flow experiment. 

Typically these values lie in the range 0.25 to 2 mm. A suitable value will depend on numerous factors, the most 

important factors being the type of signal being measured and the stability of the reagents to photochemical 

degradation (photo-bleaching). The entrance and exit slit widths are normally set to identical values. 

 

A suitable setting for absorbance experiments is 0.5 mm. 

 

Fluorescence experiments tend to be more sensitive and require higher light throughput using wider slit width 

settings. 1 mm and 2 mm settings are commonly used. 

 

It should be noted that samples which are susceptible to photochemical reaction should be investigated with a 

narrower slit setting to reduce the possibility of photo-bleaching. 

 

3.15.4 Bandpass Calculation 

The wavelength bandpass is calculated by multiplying the slit width readings (in mm) by a factor of 4.65. 

Bandpasses below 2 nm are most accurately set using feeler gauges. The final bandpass adjustment should 

always be set by moving the dial in a clockwise direction. This procedure will give maximum accuracy and 

reproducibility. 

 

3.15.5 Dual Monochromator Operation 

Systems equipped with two monochromators are labelled Mono 1 and Mono 2. Mono 1 is always connected to 

the lamp housing on the lower rail. Mono 2 may either be positioned on the upper rail in the emission 

configuration or on the lower rail to the left of Mono 1 in the UV absorbance configuration according to the 

experimental requirement. 

 

3.15.6 Photodiode Array Operation 

When the SX20 is used with the optional photodiode array accessory (PDA.1), the monochromator is 

automatically set to the zero order position by the software. This allows white light from the lamp source to pass 

directly through the monochromator to the optical cell. The user must adjust the entrance and exit slit widths to 

maximise the signal reaching the photodiode array unit. A detailed description of photodiode array operation is 

provided in Section 3.20.   

 

3.15.7 Absorbance Measurements in the near IR (>650nm) 

It is essential that absorbance measurements collected at wavelengths greater than 650 nm use an appropriate 

filter to eliminate second order stray light from detection. Second order stray light is a phenomenon common to 

all monochromators fitted with diffraction gratings. In addition to monochromatic light of the required wavelength, 

a small proportion of light with half this wavelength is also generated. 
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All SX20 systems are supplied with a 645 nm cut-off filter that should be positioned between the optical cell and 

the absorbance detector when measuring absorbance in the near IR region (>650 nm).  

 

3.15.8 Maintenance 

The monochromator should not require any maintenance from the user. Under no circumstances should the user 

attempt to recalibrate the monochromator. 

 

3.16 150 watt Lamp Housing 

3.16.1 Description 

The arc lamp source uses a 150 watt gap shortened xenon bulb and is ignited and powered by the lamp power 

supply unit. Three different lamps may be fitted to the housing to accommodate experimental requirements.  

 

A manually operated shutter is located on the exit port of the lamp housing to control the passage of light to the 

monochromator (Figure 3.27). The shutter is open when the shutter is pushed to the rear. The shutter is closed 

when pulled to the front.  

 

 
 

Figure 3.27: the lamp housing front view 

 

 
3.16.2 Basic Set-Up and Electrical Connections 

The 150 watt lamp housing is mounted on the right hand side of the optical rail. A magnet assembly is 

sometimes attached to the rear of the housing to provide greater stability of the xenon arc lamp.  

 

The electronic circuitry used in the stopped-flow spectrometer is very sensitive and must be 

correctly grounded to avoid electrical interference. The lamp power supply unit, the lamp housing 

and the mains distribution board all have earth posts that must be connected to the earth post on 

the optical rail via the braided earth straps provided with the system. 

Lamp 

Shutter 
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The lamp housing is fitted with two input terminals (black negative and red positive) that are connected to the 

lamp power supply unit. The earth post should be connected to the earth post on the optical rail using the 

braided cable supplied.  

 
Figure 3.28: lamp housing rear view 

 

 

3.16.3 Lamp Stability Magnet 

The SX20 lamp housing is sometimes fitted with an adjustable magnet assembly that stabilises the xenon arc. 

The magnet is attached to the rear of the lamp housing in the orientation that provides the greatest stability.   

 

3.16.4 Lamp Types 

 

The SX20 spectrometer may be equipped with a light source (150 watt xenon or mercury-xenon 

arc lamp) that produces intense ultraviolet radiation that can irritate the eyes and may impair 

eyesight. Never look directly at the light source. Do not open the lamp housing while the lamp is 

operating or immediately after it is powered off. Do not allow the skin to be exposed to UV 

radiation. 

 

The interaction between ultraviolet light and oxygen leads to the formation of ozone, a very 

reactive gas that is damaging to health and may cause deterioration of the optical components of 

the instrument. If an ozone producing lamp is used, it essential that the SX20 is thoroughly 

purged with clean, oxygen-free nitrogen before the lamp is powered on. 

 

There are three types of 150 watt arc lamp approved for use in the SX20 lamp housing. The choice of lamp will 

depend on individual experimental requirements. Systems are normally supplied fitted with a 150 watt ozone-free 

xenon lamp unless requested otherwise. This lamp has excellent long term stability and a spectral range of 250-

1000 nm. 

 

Negative 

terminal 
Positive 

terminal 
Earth Point 

Lamp Stability Magnet 
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For studies in the far UV region, a 150 watt ozone-producing xenon lamp is recommended, with a spectral range 

of 200-1000 nm. Operating with an ozone producing lamp requires the lamp housing to be purged with an inert 

gas such as nitrogen. The purging procedure is described later in this section. 

For fluorescence-based measurements, a 150 watt mercury-xenon lamp is available that offers significantly 

higher output at particular wavelengths. The lamp emission profile relative to the standard 150 watt source is 

shown in Figure 3.29, which is accompanied by Table 3.4 which lists the most significant mercury emission lines. 

Fluorescence excitation at these wavelengths provides an improved signal to noise level in fluorescence data 

compared to a standard 150 watt xenon lamp.   

 

Additional lamps can be supplied mounted on an extra lamp housing unit back-plate and storage case. This 

allows for more rapid lamp changeovers and eliminates the need for lamp alignment following the swap. 

 

Table 3.3 lists the three lamps approved for use with the SX20 system  

 

Lamp Manufacturer Uses 

150W Xe (O3 free) 
Osram 

XBO 150W/CR OFR 
general SF 

150W Xe (O3 producing) 
Osram 

XBO 150W/4 
Far UV region SF 

150W Hg-Xe 
Hamamatsu 

L2482 

Sensitive fluorescence  

SF 

   
Table 3.3: the lamps available for use with the SX20 

 

 

The output profiles for the xenon lamp (red) and mercury xenon lamp (blue) are displayed in Figure 3.29 

 
 

Figure 3.29: xenon (red) and mercury-xenon (blue) output profiles  
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The principle emission lines of the mercury-xenon lamp are listed in Table 3.4. 
 

Wavelength, nm Relative intensity, % Wavelength, nm Relative intensity, % 
222 6.0 302 52.0 
230 9.8 313 100 
240 14.2 334 37.1 
250 19.2 365 89.5 
265 45.6 405 60.8 
277 23.9 436 72.8 
283 28.8 546 47.9 
290 30.7 577 25.4 
297 63.1   

 
 Table 3.4: emission lines for the mercury-xenon lamp 

 

 

3.16.5 Purging the Lamp Housing (Ozone-Producing Lamp Only)  

 

The interaction between ultraviolet light and oxygen leads to the formation of ozone, a very 

reactive gas that is damaging to health and may cause deterioration of the optical components of 

the instrument. If an ozone producing lamp is used, it essential that the SX20 is thoroughly 

purged with clean, oxygen-free nitrogen before the lamp is powered on. 

 

This procedure applies only to lamp housings fitted with an ozone-producing xenon lamp. Ozone is produced by 

the reaction of oxygen in the atmosphere with UV light. Inhalation of ozone is harmful to health and will rapidly 

degrade seals and optical surfaces in the lamp housing and monochromator. Purging the lamp housing with an 

inert gas such as nitrogen will ensure there is no build-up of ozone in the lamp housing. A fitting is provided on 

the right hand side of the lamp housing to connect a purging line from the main stopped-flow drive supply.  

 

Connection of the Lamp Housing Purging Accessory  

If nitrogen is being used as the main drive gas supply then the elbow on the h-shaped tubing arrangement used 

to connect the gas supply to the back of the sample handling unit can be replaced with an additional flow 

regulator assembly. The tubing on the outlet of the flow regulator should be connected to the purge inlet on the 

right hand side of the lamp housing as shown in Figure 3.30 and Figure 3.31. 
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Figure 3.30: the position of the purge inlet on the lamp housing 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure 3.31: pneumatic connections on the rear of the SHU 

 

 

Purging Procedure  

Before igniting the lamp, the flow regulator should be opened to allow a minimal steady flow of nitrogen through 

the lamp housing. This flow should be continued for at least 15 minutes prior to igniting the lamp. This will ensure 

that all the air in the lamp housing is replaced with nitrogen. The nitrogen flow must be maintained when the 

lamp is running. 
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3.16.6 Lamp Alignment Procedure 

The lamp alignment should be checked frequently to ensure optimum performance of the SX20 system. Any 

misalignment will result in excess noise, due to both a lower light level and, more importantly, increased 

vibrational noise. The alignment procedure involves adjusting the horizontal and vertical position of the lamp in 

the lamp housing to optimize the signal monitored in the live display window of the software. 

 

An electrical short between the lamp adjustment point and the lamp housing could give an 

electric shock to the user cause damage to the instrument. The alignment procedure should only 

be performed using the insulated 4 mm hexagonal wrench supplied with the SX20. 

 

To align the lamp, follow the procedure below.  

 

1. Remove the magnet assembly from the rear of the lamp housing. Note the orientation of the magnet if 

fitted. 

2. Loosen the lamp alignment mechanism locking screw on the rear of the lamp housing. Generally no 

more than one quarter turn should be necessary. 

3. Remove the two plastic plugs covering the alignment screws.  

4. The sample handling unit should be configured in the absorbance mode. Set the monochromator to a 

suitable wavelength for aligning the lamp. Applied Photophysics recommend a value of 350 nm with 

monochromator slits set to 0.5 mm. 

5. Click the Reference button in the baseline panel of the control software to set the absorbance baseline. 

6. Adjust the horizontal alignment setting by turning the hexagonal wrench until the signal reaches an 

optimum level (i.e. minimum absorbance). 

7. Adjust the vertical alignment setting by turning the hexagonal wrench until the signal reaches an 

optimum level (i.e. minimum absorbance). 

8. Repeat the horizontal and vertical alignment steps until the optimum signal is reached. 

9. Retighten the lamp alignment mechanism locking screw and refit the magnet assembly to the rear of the 

lamp housing.   

10. Replace the two plastic plugs covering the alignment screws. 

 

3.16.7 Lamp Lifetime  

The 150 watt arc lamps are generally rated for 1000 operational hours. The life time of a lamp often exceeds 

1000 hours depending on the type of work it is used for.  Symptoms of an aging lamp include difficulty to ignite, 

poor lamp stability and reduced output (particularly in the UV region). When the lamp starts to exhibit these 

symptoms it should be replaced. 

 

The lamps used in the SX20 operate at high pressure and can explode or break without warning, 

causing damage to the interior of the lap housing. This is more likely to happen with lamps with 

longer usage, and lamps with more than 1000 hours usage should be replaced.  

 

3.16.8 Lamp Stability Test 

The stability of a lamp is a performance measure that will determine the quality of the data that can collected on 

the SX20. Lamp stability can be measured according to the following procedure: 

 

1. The sample handling unit should be configured in the absorbance mode with a 2 mm optical pathlength. 

2. Set the monochromator to 350 nm with entrance and exit slits set to 0.5 mm. 

3. Click the Reference button to apply a high voltage to the detector. 

4. Acquire data over a 10 second period. 
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The maximum peak-to-peak noise on the signal during the acquisition period should not exceed 0.001 AU for a 

new system. As systems and lamps age, the stability level decreases. It is recommended that the lamp 

alignment should be checked if the lamp stability has deteriorated significantly. If the stability exceeds 0.003 AU 

the lamp should be considered for replacement. 

 

3.17 Lamp Power Supply Unit 

3.17.1 Description 

The lamp power supply unit (PSU) (Figure 3.32) is a purpose-designed unit for igniting and running the 150 watt 

xenon arc lamp. The unit contains a safe-start igniter that is harmless to surrounding electronic equipment. The 

igniter delivers a high voltage pulse to strike the arc lamp and once ignited supplies a stable running voltage to 

the lamp.  

 

 
 

Figure 3.32: the lamp power supply unit 

 

 

3.17.2 Basic Set-Up and Electrical Connections 

 

The SX20 spectrometer is powered by  the mains electricity supply which can produce a shock 

leading to serious injury or death. Do not connect or disconnect the instrument from the mains 

supply unless the supply is powered off at source. Ensure all communications and electrical connections are 

made before powering on the spectrometer.  

 

The 150 watt xenon lamp power supply unit is generally located to the right of the optical rail. Suitable clearance 

to the rear and left hand side should be allowed for the ventilation fan to operate efficiently. 

 

The PSU has one mains inlet socket and two sockets (red and black) for connecting the cables to the lamp 

housing (Figure 3.33). The red cable is the positive. The black cable is the negative and also carries the 13000V 

ignition pulse to start the lamp, hence the heavy insulation. The earth post should be connected to the earth post 

on the optical rail using the braided cable supplied. 

 

The cables running between the power supply and the lamp housing carry high voltages during 

lamp ignition that could cause interference with other electronic devices and cables: keep other 

devices and cables at least 30 cm away.  
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The Lamp Cont socket on the rear of the PSU not currently used. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure 3.33: rear of the lamp power supply unit 

 

 

3.17.3 Operation 

The mains electricity supply to the power supply unit is controlled by the black rocker switch on the front panel of 

the PSU. The unit is powered on by moving the switch to the on (I) position. The red LED indicates that power is 

present. 

 

To ignite the lamp, press the red Start button on the front panel of the PSU. If ignition is successful the digital 

timer display will be activated. Xenon arc lamps typically require 30 minutes to warm up and stabilise. 

 

The digital timer displays the number of hours that the lamp has been running. Adjacent to the timer is a 

recessed button to reset the timer when the lamp is replaced. 

 

The lamp is powered off by moving the rocker switch to the off (O) position. 

 

3.17.4 Use of Xenon and Mercury-Xenon Lamps 

The lamp PSU is designed to supply a running current appropriate for a 150 watt xenon lamp and a 150 watt 

mercury-xenon Lamp. A switch on the rear panel labelled 8.5A and 7.5A provides a simple way to control the 

running current for these lamps. When using a xenon lamp, ensure the switch is set to the 8.5A position. When 

using a mercury-xenon lamp set the switch to the 7.5A position. An incorrect setting will result in increased noise 

visible on data traces. 

 

3.17.5 Maintenance 

The lamp PSU contains no user serviceable components and should not require any maintenance. In case of a 

damaged fuse, the 3.15A mains fuse holder is located above the mains inlet socket. 

 

3.17.6 Electrical Characteristics 

The characteristics of the lamp power supply and igniter unit are as follows: 

 

Supply voltage   85-264 V 

Supply frequency  47-63 Hz 

Power rating   250 VA 

Fuse   3.15 A 
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3.18 Electronics Unit 

3.18.1 Description 

The Electronics Unit (Figure 3.34) provides automated control of the sample handling unit and monochromator 

wavelength setting plus signal acquisition from the photomultiplier tube detectors and data processing. 

 

The SX20 spectrometer is powered by  the mains electricity supply which can produce a shock 

leading to serious injury or death. Do not connect or disconnect the instrument from the mains 

supply unless the supply is powered off at source. Ensure all communications and electrical 

connections are made before powering on the spectrometer. Exercise care during operation and 

do not operate units with their covers removed. Operate the spectrometer using only the cables 

provided. Never operate a spectrometer with damaged cables.  

 

The modular design of the SX20 electronics means only required features need be installed and any faults that 

develop are localised and can be easily repaired by substitution of the appropriate module. All modules have a 

built in self-test capability which communicates any operational problem to the user.  

 
Figure 3.34: the Electronics Unit 

 

 

The rear view of the SX20 Electronics Unit is shown in Figure 3.35. 

 

 

 
 

Figure 3.35: rear view of the SX20 Electronics Unit 
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The full functionality and connections of the Electronics Unit modules are described in order from left to right. 

Two vacant slots are also available in the electronics rack for future instrument expansion. 

 

Mains Inlet – The Electronics Unit mains electricity supply inlet is connected to the mains distribution board. The 

universal mains. 

 

12V Power Supply Module – This provides 12V power to all electronics modules of the SX20 except the 

Communications Module. A red LED indicates that the module is operational. Two sockets are provided for 

monitoring the output level of the module.   

  

5V Power Supply Module - This provides 5V power to all electronics modules of the SX20. A red LED indicates 

that the module is operational. Two sockets are provided for monitoring the output level of the module.   

 

Communications Module – This is the interface of the electronics and the USB link to the computer, it also 

provides several extra inputs for analogue temperature probes and a general-purpose digital I/O. The module is 

connected to the USB module housed in the workstation PC via a USB communication cable. The Temp Inputs 

port is not currently used on the SX20.The function of the red Tx and Rx LEDs are identical to those on the front 

panel of the Electronics Unit. These LEDs flash to indicate that information is being transmitted and received. 

The green Status LED reports a fault on the module electronics. This is constantly illuminated if the module 

passes the self test routine and flashes if the test is failed. 

 

Control Module 1 – This provides stepper motor control used to drive the monochromators. For systems with 

one monochromator, the monochromator must be connected to the Drive 1 port. For SX20 systems fitted with 

the SEM.1 or AM.1 options, (i.e. two monochromators), Mono 1 must be connected to the Drive 1 port and Mono 

2 must be connected to the Drive 2 port. The green Status LED below each port indicates the operational status 

of the respective Drive. The LED is constantly illuminated if the Drive passes the self test routine and flashes if 

the test is failed. 

 

KSHU Module – This provides control of the sample handling unit pneumatics. It also manages inputs from the 

drive ram transducers and temperature probe. The sample handling unit is connected via a black cable fitted with 

a 44-pin D-connector. The Lamp Cont port is currently redundant on the SX20 system. The green Status LED 

indicates the operational status of the module electronics. This is constantly illuminated if the module passes the 

self test routine and flashes if the test is failed. The red TRG LED indicates triggering of the Auto-Stop of the 

sample handling unit. 

 

PMT Module – This controls the photomultiplier tube detector high voltage and signal measurement. There are 

single and double channel versions that allow for connection and measurement on one and two channels 

respectively. For systems with one data acquisition channel, the detector cable is connected to the Channel 1 

port. For systems fitted with two data acquisition channels, the absorbance detector is connected to Channel 1 of 

the module. The fluorescence detector is connected to Channel 2. The green Status LED below each port 

indicates the operational status of the Channel. The LED is constantly illuminated if the Channel passes the self 

test routine and flashes if the test is failed. 

 

PDA Module (only fitted on systems equipped with the optional photodiode array detector) – This controls all 

communication with the externally mounted PDA accessory. The PDA unit is connected to the module via a 

black cable fitted with a 26-pin D-connector. The three yellow LEDs labelled 1024, 512 and 256 indicate the type 

of diode array that is connected to the module. The diode labelled 256 should be illuminated when a PDA is 

attached as the currently supplied units are 256 element diode arrays. The green Status LED reports a fault on 

the module electronics. This is constantly illuminated if the module passes the self test routine and flashes if the 

test is failed. 
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3.18.2 Operation 

Refer to Figure 3.36 for aspects relevant to operation of the Electronics Unit. 

 

 
 

Figure 3.36: the Electronics Unit front panel 

 

 

The mains electricity supply to the Electronics Unit is controlled by the black rocker switch on the front panel of 

the unit. The unit is powered on by moving the switch to the on (I) position. The green LED labelled Status 

indicates that power is present. This LED should be constantly illuminated.  

 

When the Electronics Unit is first powered on, the instrument will automatically check its zero positions (the 

monochromator motor will be audible) and perform an electronics self-test procedure. If the self test procedure 

fails, the green Status LED will flash indicating an electronics error. In the event of a self-test failure, restart the 

Electronics Unit to remedy the fault. If the fault persists, please contact the Technical Support Team at Applied 

Photophysics.  

 

The two red LEDs labelled Tx and Rx indicate that the Electronics Unit is transmitting and receiving information 

respectively. 

 

The Electronics Unit is powered off by moving the rocker switch to the off (O) position. 

 

3.18.3 Maintenance 

The Electronics Unit contains no user serviceable components and should not require any maintenance. In case 

of a damaged fuse, the 1A mains fuse holder is located above the mains inlet socket. 

 
3.18.4 Electrical Characteristics 

The electrical characteristics of the system are as follows:- 

 

Supply voltage   85-264 V 

Supply frequency  47-63 Hz 

Power rating   80 VA 

Fuse   1 A 
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3.19 Workstation (PC) 

3.19.1 Description 

The SX20 is normally supplied with an HP Compaq PC, pre-configured for use with the instrument, fitted with a 

USB interface card that is linked to the Electronics Unit of the SX20 and provides computer control of the 

stopped-flow data acquisition via the SX Control Software.  

 

3.19.2 Basic Set-Up and Operation 

The set-up and operation of the computer is fully described in the manual supplied by the computer 

manufacturer. Please refer to that manual for detailed instructions for setting up the computer, but note the 

position of the USB3 module to which the SX20 Electronics unit should be connected shown in .  

 

 
 

Figure 3.37: rear of the Workstation showing the position of the USB3 module 

 

3.20 Photo Diode Array Detector (Option PDA.1) 

3.20.1 Description 

The SX20 may be equipped with an optional photodiode array detector for collection of time-resolved 

absorbance spectra from a single stopped-flow drive (Figure 3.38).  

 

There are two versions of the 256 element photodiode array accessory: The visible region PDA has an 

operational spectral range of 300-1100 nm with a wavelength resolution of 3.3 nm. The UV region PDA has an 

operational spectral range of 190-735 nm with a wavelength resolution of 2.2 nm. Each PDA is capable of an 

integration speed of 1.4 ms per scan. 

 

USB3 module 
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Figure 3.38: the Photo-Diode Array detector 

 

 

3.20.2 Basic Set-Up and Electrical Connections 

 

The SX20 spectrometer is powered by  the mains electricity supply which can produce a shock 

leading to serious injury or death. Do not connect or disconnect the instrument from the mains 

supply unless the supply is powered off at source. Ensure all communications and electrical 

connections are made before powering on the spectrometer. Exercise care during operation and 

do not operate units with their covers removed. Operate the spectrometer using only the cables 

provided. Never operate a spectrometer with damaged cables.  

 

The photodiode array unit is normally positioned on the rear of the sample handling unit. The PDA is connected 

to the cell housing via a fibre-optic light guide. The light guide is attached to the cell housing and the PDA via two 

finger screws. The light guide has a rectangular bundle of fibres of dimensions 7 mm x 1 mm at the SHU end and 

a circular bundle of fibres of 3.5 mm diameter at the PDA end. The PDA unit is connected to the PDA module in 

the Electronics Unit via a black cable fitted with 26-pin D-connectors. The yellow diode labelled 256 will be 

illuminated when a PDA is attached.    

 

3.21 SX20 Experimental Operation  

This section provides detailed information relating to experimental operation of the SX20 stopped-flow reaction 

analyser hardware. 

 

The SX20 drive rams are pneumatically driven and could trap hands or clothing, causing injury to 

the user. Keep hands and clothing clear when performing a drive, and never perform a drive 

without the safety cover in place. 

 

3.21.1 Single-Mixing Stopped-Flow Operation  

The following procedure describes the use of the syringes and the various valves during sample loading, sample 

flow circuit flushing and stopped-flow mixing. This is the basic experimental template for stopped-flow operation. 

Variations of this template will be described in later sections of this chapter. 
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STEP 1 Sample Handling Unit Preparation (Sequential-mixing Systems Only) 

 

 
Figure 3.39: sequential-mixing SHU in single-mixing configuration 

 

For systems equipped with the sequential-mixing option (SQ.1), the sample handling unit should be set-up as 

shown in Figure 3.39 with the single-mix drive ram connected to the left hand ram platform. The single-mixing 

experiment always utilises this drive ram and the reagents are always loaded in the F (left) and C (right) drive 

syringes. The black plastic dust cover should be fitted to the right hand (Pre-Mix) ram platform. 
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STEP 2 Flow Circuit Configuration (Sequential-mixing Systems Only) 

 

 

 
Figure 3.40: sequential-mixing flow circuit in single-mixing configuration 

 

For systems equipped with the sequential-mixing option (SQ.1), the flow circuit should be set-up as shown in 

Figure 3.40 with the flow tubing connecting directly between drive valve F and the optical cell. Systems not 

equipped with the sequential-mixing option are only configured for single-mixing experiments. No additional 

preparation is required. 

 

STEP 3 Adjusting the Drive Volume 

Screw the knurled volume adjuster on the Auto-Stop fully clockwise (i.e. front edge moves from left to right), then 

screw it three and a half turns anti-clockwise (counter-clockwise). This equates to a total flow volume of 

approximately 140 µl.  
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STEP 4 Flushing the Flow Circuit 

Fit two reservoir syringes filled with distilled water to the C and F Luer fittings. It is recommended that 5 or 10ml 

plastic disposable syringes be used. 

 

Turn the C and F drive valves to the Load (side) position. Ensure that the drive ram is pushed fully down. Fill the 

C and F drive syringes by pushing down the plungers of the reservoir syringes. Expel any air bubbles by flushing 

backwards and forwards between the drive syringes and the reservoir syringes several times. 

 

Turn the F drive valve to the Drive (forward) position and manually push the water from the drive syringe, through 

the flow circuit and into the stop syringe. 

 

Empty the stop syringe by clicking Empty on the Pro-Data SCP. 

 

Repeat the above two steps until the drive syringe is empty. 

 

Turn the F drive valve to the Load (side) position and the C drive valve to the Drive (forward) position and 

manually push the water from the drive syringe, through the flow circuit and into the stop syringe.  

 

Empty the stop syringe by clicking Empty on the Pro-Data SCP. 

 

Repeat the above two steps until the drive syringe is empty. 

 

If there are bubbles in the stop syringe that cannot be expelled by manual pushing, the syringe must be removed 

and the bubbles removed. To collect quality data it is essential that air bubbles are not present in the flow circuit. 

 

STEP 5 Loading the Reagents 

Ensure that all the control valves are set to the Load (side) position. Replace the C and F reservoir syringes with 

ones containing the samples. Where applicable, the solution of greatest density should be loaded in the F drive 

syringe. If both samples are of the same density then the most precious sample, should be loaded in the C 

syringe as it has the smaller priming volume.  

 

Fill the drive syringes by pushing down the pistons of the reservoir syringes (this ensures that there is no 

cavitation inside the drive syringes and, therefore, no bubbles). 

 

Prime the sample handling unit by manually pushing 200 µl from each drive syringe. 

 

Completely fill both of the drive syringes and ensure that there is no gap between the drive ram and the drive 

syringe plungers. 

 

Set both drive valves to the Drive (forward) position. 

 

STEP 6 Data Acquisition  

The experimental procedures for the various modes of data acquisition are described in detail in Chapter 1 of this 

User Manual. 

 

Twenty-five drives can be made in quick succession before the drive syringes will need to be refilled. 
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3.21.2 Sequential-mixing Stopped-Flow Operation 

The sequential-mixing stopped-flow experiment allows investigation of the reactivity of reaction intermediate 

species.  

 

The following procedure describes the use of the syringes and the various valves during sample loading, sample 

flow circuit flushing and sequential stopped-flow mixing. 

 

The sequential-mixing experiment employs a double pneumatic drive. The first (Pre-Mix) drive mixes the 

contents of the two right hand drive syringes (A and B) in an aging loop. After a user defined aging period (from 

0.010s to 1000s) the second (Flush) drive mixes the contents of the aging loop with a third reagent C. 

 

STEP 1 Sample Handling Unit Preparation 

The sample handling unit should be set-up as shown in the diagram below with the flush drive ram connected to 

the left hand ram platform and the pre-mix drive ram connected to the right hand ram platform.  

 
Figure 3.41: sequential-mixing SHU in sequential-mixing configuration  
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STEP 2 Flow Circuit Configuration 

The flow circuit should be set-up according to the following instructions and referring to Figure 3.42. 

 

 

 
Figure 3.42: sequential-mixing flow lines in the sequential-mixing configuration 

 

 

Drain the thermostat solution from the water bath by removing the bleed screw from the top of the cell block.  

 

Remove the front cover of the water bath.  

 

Remove the aging loop from the straight through connector that connects to the flush line. Remove the plugs 

from the pre-mixer and the end of the extension tube.  

 

Connect the extension tube to the straight through connector on the end of the flush line and the aging loop to 

the pre-mixer. Pressure test the flow line to make sure that it is not leaking. Replace the front of the water bath 

and the bleed screw.  
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STEP 3 Adjusting the Pre-Mix Drive Volume 

Screw the fine adjuster on the pre-mix drive ram fully upwards so that the ram will have no upward travel (this is 

the zero drive volume position). Screw the fine adjuster five turns to increase the drive volume. This equates to a 

pre-mix drive volume of approximately 220 µl. It is essential that the pre-mix drive volume should be 220 µl ± 10 

µl.  

 

Use of the Profiles function in the Pro-Data control software allows accurate measurement of the drive volume 

and will be described in STEP 6. 

 

STEP 4 Adjusting the Total Drive Volume 

Screw the volume adjuster on the Auto-Stop fully clockwise (i.e. front edge moves from left to right, until the 

pneumatic connection starts to rotate), then screw it eight and a half turns anti-clockwise (counter-clockwise). 

This equates to a total drive volume of approximately 400 µl and will result in a drive 2 volume of 180 µl (±10 µl) 

assuming a pre-mix (drive 1) volume of 220 µl (±10 µl). 

 

Use of the Profiles function in the Pro-Data control software (Section 4.9) allows accurate measurement of the 

drive volume and will be described in STEP 6. 

 

STEP 5 Flushing the Flow Circuit 

Fit four reservoir syringes filled with distilled water or another suitable solvent to the A, B, C and F Luer fittings. It 

is recommended that 5 ml or 10 ml plastic disposable syringes are used.  

 

Turn the A, B, C and F drive valves to the Load position. Ensure that the drive rams are pushed fully down. Fill 

the drive syringes by pushing down the plungers of the reservoir syringes. Expel any air bubbles by flushing 

backwards and forwards between the drive syringes and the reservoir syringes several times. 

 

Turn the F drive valve to the Drive position and manually push the water from the drive syringe, through the flow 

circuit and into the stop syringe.  

 

Empty the stop syringe by clicking on Empty in the Pro-Data control software. 

 

Repeat the above two steps until the drive syringe is empty. 

 

Flush from the other three drive syringes in the same manner as described above. 

 

Fill all four drive syringes with water and turn all of the drive valves to the Drive position.  

 

Enable the sequential-mixing mode in the Pro-Data control software. With a delay time of 1s, carry out a 

stopped-flow drive by clicking the Drive button on the Sequential tab on the SHU Setup dialog box (Figure 

3.43). The drive profiles will be displayed automatically after the drive and should be used to check the accuracy 

of the drive 1 and 2 volumes. 
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Figure 3.43: the Sequential tab 

 

 

STEP 6 Checking the Drive Volume Using the Profiles Function 

Carry out several drives and check that the drive 1 volume is 220 µl (±10 µl) and the drive 2 volume is 180 µl 

(±10 µl) from the Drive Profiles window (Figure 3.44). The drive volumes and measured delay time should be 

consistent from run to run. 

 

 
 

Figure 3.44: the Drive Profiles window 

 

 

STEP 7 Loading the Reagents 

Ensure the all four drive valves are set to the Load position. Replace the reservoir syringes with ones containing 

the samples. The F (flush) reservoir syringe should be filled with a neutral buffer solution. Fill the drive syringes 

by pushing down the pistons of the reservoir syringes (this ensures that there is no cavitation inside the drive 

syringes and, therefore, no bubbles). Ensure that there are no air bubbles in the drive syringes. 
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Set the four drive valves to the Drive position. 

 

STEP 8 Data Acquisition 

The experimental procedures for the various modes of data acquisition are described in detail in the chapter 1 of 

this user manual. 

 

The first trace acquired with new reagents will prime the flow lines and should be discarded. The drive syringes 

must be refilled after each acquisition. 

 

3.22 Asymmetric (Variable Ratio) Mixing 

The SX20 is fitted with 2.5 ml Kloehn manufactured drive syringes as standard. This provides a 1:1 stopped-flow 

mixing ratio. Other mixing ratios may be achieved by fitting drive syringes of different volumes to the sample 

handling unit. 

 

For single-mixing stopped-flow measurements the ratios shown in Table 3.5 may be achieved using one 

standard 2.5 ml Kloehn syringe and one of the Hamilton manufactured Salt Line syringes. 

 

Mixing Ratio Syringe Configuration 

1:1 1.0 mL + 1.0 mL 

2.5:1 2.5 mL + 1.0 mL 

5:1 2.5 ml + 500 µl 

10:1 2.5 mL + 250 µL 

25:1 2.5 ml + 100 µl 

 
Table 3.5: syringe conformations for asymmetric mixing 

 

 

3.22.1 Setting the Drive Pressure for Asymmetric Mixing Experiments 

 

Syringes smaller than the standard 2.5 ml can produce excessive pressures in the flow circuit. 

Top prevent damage to the flow circuit, the pneumatic drive pressure must be reduced to 2 bar 

(30 psi) via the pressure regulator fitted to the rear of the sample handling unit.    

 

The drive pressure is set at 4 bar for standard 1:1 mixing experiments. For 1:5, 1:10 and 1:25 mixing ratios the 

drive pressure must be reduced to 2 bar (30 psi) using the regulator connected to the gas inlet on the rear of the 

sample handling unit (Figure 3.45). 
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Figure 3.45: position of the drive pressure regulator on the rear of the SHU 

 

 

3.22.2 Setting the Drive Volume for Asymmetric Mixing Experiments 

The total drive volume should be increased as the ratio increases in order to obtain good reproducible results. 

Table 3.6 lists some recommended drive volumes that may be used as a guide during experimental set-up.  

 

 

Mixing Ratio Drive Volume 

1:1 140 µl 

2.5:1 160 µl 

5:1 200 µl 

10:1 250 µl 

25:1 300 µl 

 
Table 3.6: drive volumes for asymmetric mixing 

 

 

Preparing the SHU for Asymmetric Mixing 

 

1. Check that the drive pressure has been set to 2bar. 

2. Drain the water bath housing and remove the front plate. 

3. Unscrew the F drive syringe from the drive valve retaining plate by gripping the metal tip. Withdraw the 

syringe down through the rubber water bath seal.  

Left Hand Drive Ram 

Pressure Regulator 
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4. Repeat the reverse of the removal procedure to fit the Hamilton syringe. It will be necessary to fit a 

rubber sleeve to the glass barrel of smaller diameter syringes to prevent water bath leaks. Tighten the 

syringe into the drive valve retaining plate carefully to provide a leak-free fit. 

5. Test the flow circuit for leaks using the procedure described previously and tighten the drive syringe 

further if necessary. 

6. Replace the front plate of the water bath housing. 

7. Adjust the drive volume on the Auto-Stop according to the values listed in the table above. 

 

3.23 Anaerobic Operation (using option AN.1) 

The AN.1 anaerobic accessory equips the SX20 with a high performance bench top anaerobic capability. In such 

an environment, operating under anaerobic conditions requires stringent care with respect to eliminating oxygen 

dissolved in the thermostat medium and adsorbed into the wall material of the sample flow circuit. The accessory 

comprises a purging manifold and a set of 3-way valves. 

 

The most significant source of oxygen ingress is between the plunger and barrel of the drive syringe. Although 

the syringes are gas tight, the tips of the plungers are made of Teflon which does not act as a barrier to oxygen. 

In order to stop oxygen from passing between the barrel and plunger, the end of the syringe barrel needs to be 

maintained in an inert environment. This is achieved using the anaerobic purging manifold shown attached to the 

sample handling unit in Figure 3.46. 

 

 
 

Figure 3.46: the anaerobic purge manifold attached to the SHU 

 

 

To fit the accessory, push it over the drive syringe plungers and screw the accessory to the underside of the 

sample handling unit water bath so that the ends of the drive syringe plungers are enclosed. Connect an inert 

gas supply (nitrogen or argon) to the male fitting on the side of the manifold and gently purge so that the ends of 

the drive syringes are in an inert environment. Figure 3.46 shows a cut away view of the assembled accessory. 
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3.23.1 Flow Circuit Preparation 

Another significant source of oxygen contamination is through the flow circuit. The SX20 sample handling unit is 

fitted with PEEK tubing and PEEK drive valves as standard. This minimises the danger of oxygen contamination 

from the tubing and the valves. 

 

The thermostatic liquid in the circulator should be purged of oxygen by gently bubbling nitrogen through it at 

25°C ± 1°C. 1 gram of sodium dithionite should be added to the thermostat liquid. The circulator must be left 

running for the duration of anaerobic operation. A solution of 600 ng/ml glucose oxidase and 10 mM glucose in 

100 ml of sodium acetate, pH5, should be flushed through the internal flow lines of the sample-handling unit. 

After 1 hour deoxygenated buffer should be used to flush out the glucose oxidase solution. The sample handling 

unit is now ready for anaerobic use. 

 

3.23.2 Sample Introduction Care 

Another source of oxygen contamination is at the point where the samples are introduced into the drive syringes. 

For basic anaerobic work the use of gas tight Luer tip reservoir syringes is recommended. Prepare the anaerobic 

samples as usual, draw them into gas tight syringes, bring them quickly to the sample handling unit, as you are 

about to fit them to the Luer connections expel a small amount of the sample to prevent an air bubble from being 

trapped between the reservoir syringe and the fitting.  

 

3.23.3 Advanced anaerobic work 

Advanced anaerobic work requires the use of three-way valves to introduce the samples into the system.  These 

are supplied as part of the AN.1 accessory and may be used according to the following procedure: 

 

1. Flush the drive syringes and flow circuit of the SHU with anaerobic buffer. After flushing, a little anaerobic 

buffer should be left in the drive syringes. 

2. Prepare all reagents in a glove box and load these into gas-tight (Luer lock) syringes with a 3-way stop 

valve on the end of the syringe, ensure this valve is closed. 

3. The syringe and 3-way valve should be transferred to the stopped flow instrument. 

4. Connect an empty disposable syringe on to the unused port on the 3-way valve. With the 3-way valve in 

the same position (i.e. closed), turn the drive valve to the Load position and push up on the drive syringe 

to expel the anaerobic buffer from the drive syringe into the empty disposable syringe on the side of the 

3-way valve. This effectively scrubs the drive valve, Luer fitting and part of the 3-way valve making these 

components anaerobic. 

5. Open the 3-way valve by turning it 90 degrees and introduce a small amount of the anaerobic sample 

into the drive syringe. 

6. Turn the 3-way valve back to the closed position and then push this small volume of anaerobic sample 

out through the 3-way valve to the disposable syringe (containing anaerobic buffer). This fills the valve, 

syringe and Luer fitting with sample. 

7. Open the 3-way valve and load the sample into the drive syringes. The system is now ready for the 

stopped-flow experiment. 
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3.24 Optical Filters 

The SX20 is designed to operate with a variety of optical filters according to experimental requirements. 

 

3.24.1 Absorbance Measurements in the near IR (>650nm) 

It is essential that absorbance measurements collected at wavelengths greater than 650 nm use an appropriate 

filter to eliminate second order stray light from detection. Second order stray light is a phenomenon common to 

all monochromators fitted with diffraction gratings. In addition to monochromatic light of the required wavelength, 

a small proportion of light with half this wavelength is also generated. 

 

All SX20 systems are supplied with a 645 nm cut-off filter that should be positioned between the optical cell and 

the absorbance detector when measuring absorbance in the near IR region.  

 

3.24.2 Fluorescence Measurements 

Optical filters are used in fluorescence measurements to eliminate the scattered excitation light from detection by 

the fluorescence PMT. The fluorescence signal is measured at a 90
o
 angle to the excitation light and the filter is 

mounted between the optical cell and detector.  

 

The filter (25 mm diameter) is mounted in the circular filter holder and retained in position using the split ring. The 

filter holder shown in Figure 3.47 is designed for use with cut-off and band-pass filters. 

 

 
 

Figure 3.47: filter holder 

 

 

3.24.3 Cut-Off Filters 

Cut-off filters eliminate light of shorter wavelength than its cut-off value. Applied Photophysics stock the range of 

Schott manufactured filters suitable for use with the SX20 shown in Table 3.7; the cut-off wavelengths are in 

nanometers.   

 

295 375 475 570 

305 395 495 590 

320 400 515 610 

335 420 530 630 

360 455 550 645 

 
Table 3.7: range of available cut-off filters; wavelengths are in nanometres 

 

 

The transmittance profiles for these filters are displayed in Figure 3.48. 
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Figure 3.48: transmittance profiles for cut-off filters 

 

 
3.24.4 Band-Pass Filters 

Band-pass filters transmit a band of light of a certain wavelength. Band-pass filters are most suited to 

applications where more than one fluorophore is present in the reaction mixture. Applied Photophysics offer 435, 

465 and 505 nm filters for use with the SX20. The transmittance profiles for these filters are displayed in Figure 

3.49. 

 
Figure 3.49: transmittance profiles for band-pass filters 
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4 PRO-DATA SX 

4.1 The Spectrometer Control Panel  

The purpose of Pro-Data SX is to control the spectrometer and its accessories and to acquire data. It has been 

written to be versatile enough to cope with a wide variety of experiments while being simple to use. It operates 

under Windows 7 and some earlier versions of Windows. The object-oriented modular architecture is easily 

expandable, allowing the introduction of new features, anticipating future developments. 

The software is launched by clicking on the desktop icon . The Spectrometer Control Panel (SCP) of 

Pro-Data SX (Figure 4.1) will appear on the screen. 

 

 
 

Figure 4.1: the Spectrometer Control Panel 

 

The SCP enables you to provide instructions to the spectrometer so that it carries out an experiment or a series 

of experiments according to your requirements. The interface is supplemented by drop-down menus for the 

management of files or the launching of associated programs. Shortcuts to the most commonly used items from 

the drop-down menus are provided by the toolbar icons. 
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4.2 The Signal Panel 

4.2.1 General 

 

 
 

Figure 4.2: the Signal panel 

 

 

The Signal panel (Figure 4.2) is used to select the mode of data collection. Provided the relevant accessory is 

fitted, five options can be selected from the drop-down menu: Absorbance, Fluorescence, Fluorescence 

Polarisation, Photodiode Array and Voltage. The panel changes appearance to reflect the mode of data 

collection. Each is described in detail below.  Common to all five is an oscilloscope-style live signal display. The 

units will be those of the chosen measurement mode; an instantaneous value of the measurement is also 

displayed in the box to the right of the drop down menu. 
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4.2.2 The Signal panel for Absorbance  

 

 
 

Figure 4.3: the Absorbance panel 

 

 

In the baseline section of the absorbance panel (Figure 4.3) there are two buttons, Reference and Recall, which 

function slightly differently when in Kinetics mode compared with Spectrum or Spectra-Kinetics modes.  In 

Kinetics mode when the Reference button is clicked an appropriate detector voltage will be applied to give a 

reading of zero absorbance units.  The Auto HV option should be selected when using the Kinetics mode.  

  

When in Spectrum or Spectra-Kinetics modes the Reference button is labelled Baseline and is used to 

measure an absorbance baseline over a wavelength range. Clicking on Baseline will initiate a series of 

absorbance measurements using the monochromator parameters defined elsewhere in the Pro-Data for SX main 

window.  Pro-Data Viewer will be launched automatically and the display will show the absorbance baseline 

trace.  The measurement can be stopped at any time by clicking Stop, which is the label that appears on the 

Baseline button during a measurement. At the end of the measurement, the baseline will be stored as a file 

named Baselinexxxx.dsa, unless a different seed name has been specified. If the file already exists, a Save As 

panel will open in the current working directory and you can save the data with a different name or in a different 

location.  The AutoHV option when de-selected allows the baseline to be acquired at a fixed detector voltage.  

When it is selected the detector high voltage will be adjusted at each wavelength point to give the optimum signal 

level for the baseline.   

 

The Recall button will reload the last photomultiplier reference value or baseline spectrum depending on the 

program operating mode. 

In the Options section of the absorbance panel the Option buttons allow the selection of either Absorbance or 

Transmission.  In general absorbance should be used but the transmission mode can be useful for special 

cases such as measuring the transmission profile of a filter.  The fluorescence tick box below allows the 

simultaneous acquisition of data from the fluorescence detector alongside that from the absorbance detector. 

This option will be greyed out on instruments which are not equipped with dual channel detection. 
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4.2.3 The Signal panel for Fluorescence 

 

 
 

Figure 4.4: the Signal panel for Fluorescence 

 

 

The Options sub-panel on the Signal panel for Fluorescence (Figure 4.4) provides control of the fluorescence 

signal collection mode.  The Emission mono tick box enables the use of the optional emission monochromator 

(SEM.1).  The Dual Fluorescence option which allows simultaneous collection of data from two fluorescence 

detectors is only available on dual channel instruments (with option DF.1). 

 

4.2.4 The Signal panel for Fluorescence Polarisation 

 

 
 

Figure 4.5: the Signal panel for Fluorescence Polarisation 
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The Signal panel for Fluorescence Polarisation (Figure 4.5) allows control of the fluorescence polarisation and 

anisotropy accessory.  This panel will only be available if the fluorescence polarisation accessory is connected to 

the instrument.  The Options buttons allow the selection of the measurement units and also whether the total 

fluorescence signal is to be stored alongside the other data. 

 
4.2.5 The Signal panel for the Photodiode Array 

 

 
 

Figure 4.6: the Signal panel for the Photodiode Array 

 

 

The Signal panel for the Photodiode Array panel (Figure 4.6) will only be available if the PDA device is 

connected to the SX instrument. The live display does not operate in PDA mode.  The live signal must be viewed 

by opening the PDA device window. 

 

The Detection method section on the photodiode array panel is used to select the signal to be measured.  The 

Baseline section provides a baseline collection button and a baseline recall button.  The Setup button opens the 

PDA Configuration dialog box (Figure 4.7). 

 

 
 

Figure 4.7: the PDA Configuration dialog box 
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The Settings panel allows the selection of pre-set values for the parameters displayed in the Advanced panel or 

manual configuration of them. Selecting the Manual settings option opens the PDA device window which is 

described in Section 4.12.6.   

 

4.2.6 The Signal panel for Voltage 

 

 
 

Figure 4.8: the Signal panel with Voltage selected 

 

 

The Signal panel for Voltage (Figure 4.8) allows the signal voltages from either or both of the two detectors to 

be monitored in real time.  The channels may be selected using the appropriate tick boxes. 

 

4.3 The Detector High Voltages Panel 

 

 
 

Figure 4.9: the Detector High Voltages panel 

 

 

The Detector High Voltages panel (Figure 4.9) controls the high voltages supplied to the PMT detectors (either 

two fluorescence detectors or one absorbance and one fluorescence detector). Voltages can be entered directly 

into the text boxes and will be applied to the detector when the enter key is pressed.  The Zero HV button 

immediately sets the high voltages on both detectors to zero.  This then allows detectors to be removed from the 

SHU with the software still running without risking damage to the photomultiplier tubes.  After the voltages have 

been zeroed in this way the label on the button changes to Restore HV and if pressed again will re-apply the 

previous voltages to the detectors. 
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Detector high voltages can also be controlled via the buttons labelled with three dots which open up the Set HV 

dialog box (Figure 4.10). 

 

 
 

Figure 4.10: the Set HV dialog box 

 

 

The edit box allows voltages to be directly entered and adjusted using the arrow keys. The value in the box is 

linked to the slider below allowing rapid adjustment.  The voltage set in this way will be applied to the detector 

when the OK button or Enter key is clicked.  Alternatively if the Instant effect box is ticked then any voltage 

changes are applied to the detector immediately. Expanding the window by clicking on the More/Less button 

reveals the AutoPM sub panel.  If the default box is un-ticked the target detector signal can be adjusted.  When 

the AutoPM button is clicked the high voltage to the detector is automatically adjusted so that the detector output 

signal is equal to the target value. Note that the Reference button is used to zero the absorbance detector 

before making absorbance measurements (Section 2.4). 

 

The setting of a suitable high voltage on the fluorescence detector requires some knowledge of the fluorescent 

behaviour of the sample. If it is a sample type you know, then go to the excitation wavelength that generates the 

maximum fluorescence intensity; if it is not, then run an exploratory scan with the fluorescent sample in the cell to 

find out where the maximum fluorescence is. At the maximum-intensity wavelength, click on AutoPM, which will 

adjust the detector high voltage so that the photomultiplier anode current resulting from the maximum 

fluorescence intensity is at the optimum level for the electronics. The detector is now set correctly and a 

fluorescence excitation spectrum can be measured without risk of the signal going off scale. 

 

4.4 The Monochromator Panel 

4.4.1 General 

 

 
 

Figure 4.11: the Monochromator panel 
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The Monochromator panel (Figure 4.11) provides access to the parameters that control the operation of the SX 

monochromator. Here you may set the scan range and step-size for your experiment; you can also move the 

monochromator to a specific wavelength. 

 

To drive the monochromator to a specific wavelength, use the Wavelength (nm) edit box and click the Set 

button below the box; to set the bandwidth, use the Bandwidth (nm) edit box and click the same Set button. 

Setting wavelength and bandwidth can be done simultaneously with a single click. 

 

To set the wavelength range for a scan, use the Low and High edit boxes to set the lower and upper wavelength 

limits; use the Step edit box to set the step-size; all units are nanometres. Click on the Set button to the right of 

these boxes to confirm these parameters. Note the monochromator always scans from high to low wavelength. 

 

To save the current monochromator parameters as the default ones, click on the Adv… button, which displays 

the Monochromator Scan Setup - Advanced dialog box (Figure 4.12) and click on Save As Default. Click OK 

to take you back to the Pro-Data SCP. 

 

 
 

Figure 4.12: the Monochromator Scan Setup – Advanced dialog box 

 

 

4.4.2 Advanced mono setup: discrete wavelengths 

The Monochromator Scan Setup - Advanced dialog box (Figure 4.12) can be used to set the software up to 

perform single wavelength scans. Such measurements are useful when following a change in property as a 

function of some independent variable other than wavelength - temperature, for example. 

 

Select Single wavelength and specify the wavelength in the associated edit box.  Click OK. The dialog box will 

close and when you click on the Start button in the Spectrum panel of the interface, the monochromator will 

drive to the selected wavelength and measure the CD or other chosen property of the sample at that wavelength.  
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It is also possible to create a list of discrete wavelengths. Clear the wavelength list by clicking on Clear list and 

then select Append to list. Now select Single wavelength, specify the wavelength in the edit box and click on 

Generate list. Each time you type in a wavelength and click on Generate list, the specified single wavelength 

will be appended to the list. When you are satisfied that the list of wavelengths is correct, click OK. When you 

click on Start in the Spectrum panel of the interface, the monochromator will drive to the selected wavelengths 

in the order they appear in the list and measure the CD or other chosen property of the sample at those discrete 

wavelengths. 

 

4.4.3 Advanced mono setup: skip-scans 

A simple wavelength range can be set in the Monochromator panel and there is no need to use the advanced 

panel to set such a range (Section 4.4). However, if you wish to carry out a more sophisticated scan, select 

Wavelength range in the Monochromator Scan Setup - Advanced dialog box. Then clear the wavelength list 

by clicking on Clear list and then select Append to list. Specify the Start, Stop and Step values for the first 

wavelength range and click on Generate list. A number of entries that correspond to your specification will 

appear in the list. Then enter the Start, Stop and Step values for the second range and click on Generate list 

once more. The new values will be appended to the existing values in the list. Repeat this cycle until you have 

completed the skip-scan list. The total number of entries in the list is recorded at the foot of the list. 

 

Skip-scans are in general used on samples that you know well and that you might wish to measure again in the 

future. Use the Save As… button to save the list as a .conf (configuration) file that can be retrieved using the 

Load button at a future date. This obviates the need to generate a new list every time you run the sample. 

 

With the list generated, click on OK to return to the SCP. When you click on Acquire in the Sequencer panel, 

the monochromator will drive to the wavelengths specified in the list in the order in which they appear in the list 

and the instrument will measure the chosen property (CD, voltage, fluorescence, etc.) 

 

4.4.4 The Emission monochromator 

If a second (emission) monochromator is fitted to the instrument and it is selected in the Fluorescence panel 

(Section 4.2.4) then the monochromator panel changes to allow control of both devices.  The radio buttons in the 

panel allow selection of Emission scanning or Excitation scanning.  In Emission scanning mode Mono 1 is 

set at a fixed wavelength using the left hand panel and Mono 2 is scanned.  In Excitation scanning mode the 

roles of the two monochromators are reversed. 

 

 
 

Figure 4.13: the Excitation Mono and Emission Mono panels 
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4.5 The Trigger and Timebase panels 

 

 
 

Figure 4.14: the Trigger and Timebase panel 

 

 

The Trigger and Timebase panel (Figure 4.14) are visible when operating in Kinetics or Spectrakinetics modes.  

The Trigger drop down menu allows the selection of Internal trigger, External trigger and Remote trigger.  

Internal trigger allows data to be collected without being preceded by a stopped flow drive and is generally used 

for testing purposes.  External trigger is used for normal operation and Remote trigger allows an external signal 

to start the acquisition.  When using external trigger the Pressure hold option becomes available.  This 

maintains the pressure applied to the drive syringes until the data acquisition is complete.  If this is not selected, 

the pressure is released approximately 30 ms after the data acquisition is triggered.  This pressure release may 

result in poor quality data under certain circumstances.  With measurements of 2 seconds or less which have an 

artifact at around 30 ms, enabling the Pressure hold option may improve data quality.  However for 

measurements in excess of 5 seconds keeping the pressure applied will exert unnecessary stress on the flow 

circuit possibly leading to premature failure.  Additionally the pressure hold function will not provide detectable 

improvement in data quality over such timescales.   

 

The acquisition Time and number of data Points are set using the drop down menus in the Timebase section.  

When using a photodiode array the Points setting will be the number of spectra acquired over the time interval 

(1000 max).  The Samples box displays the number of samples which will be averaged in order to obtain each 

data point.  Selecting the Logarithmic option results in the logarithmic distribution of data points over the 

selected acquisition time.  This feature may be useful when the kinetic change being monitored has a fast initial 

phase, but a slower second phase.  As an alternative a Split Timebase may be used in which data points are 

distributed between two linear intervals. 

 

4.6 The Sampling panel 

 

 
 

Figure 4.15: the Sampling panel 

 

 

The Sampling panel (Figure 4.15) replaces the Trigger and Timebase panel when operating in Spectrum 

mode, and is used to control the sampling time for each point in a scan. Use the Time-per-point (s) edit box to 

specify the time in seconds to be spent collecting data at each point; an approximate scan-time is calculated 

from the product of the time-per-point and the number of points in the scan (specified in the Monochromator 

panel (Section 4.4) 
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If the Enable Adaptive Sampling check box is ticked, the time-per-point is varied inversely as a function of the 

light reaching the detector. Where the signal is weaker, more time is spent collecting data than where it is 

stronger. The algorithm has been developed such that it will usually take less time to measure a spectrum than 

at constant time-per-point.  

 

Clicking on the Adv… button calls up the Sampling – Advanced dialog box (Figure 4.16). 

 

 
 

Figure 4.16: the Sampling – Advanced dialog box 

 

 

The Sample period (s) can be set at any value between 10.0 s and 1000.0 s in the edit box, followed by 

clicking on the Apply button. 

 

The Default number of samples can be set anywhere between the minimum and maximum limits (see 

Sampling limits below). The product of the sample period and the number of samples yields the current time-

per-point. The default number of samples is superseded by changing the Time-per-point in the Sampling panel, 

as described above.  

 

Selecting Disable oversampling will do precisely what it says and is used for diagnostic purposes only. If it is 

selected, a warning is given Figure 4.17); for all non-diagnostic use, oversampling must be used. 

 

 
 

Figure 4.17: the Disable oversampling warning message 
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Sampling limits can be changed but the default values are best suited to routine operation. The minimum time-

per-point will be 25 s multiplied by 10 samples, i.e. 250 s; the maximum time-per-point will be 25 s multiplied 

by 4000000 samples, i.e. 100 seconds. These limits apply to all experiments, whether set up using constant 

time-per-point or using adaptive sampling; they are particularly useful in placing limits on the extremes of 

adaptive sampling. 

 

4.7 The Sequencer Panel 

 

 
 

Figure 4.18: the Sequencer panel 

 

 

The Sequencer panel (Figure 4.18) allows you to specify the type of measurement you will make and to control 

the starting, stopping, pausing and resuming of data acquisitions. Tick the Repeats check box to run repeats of 

the same experiment, and enter the number of repeats in the adjacent edit box. The between individual 

measurements in Timed intervals, which is the time between the beginnings of successive repeats; if it is set to 

be shorter than the time for each run, then each run will begin after the previous one. All data from repeat runs 

will be written to a single Datastore.  

 

The radio buttons allow you to select the type of measurement you will carry out. It will usually be Kinetics for 

the SX20. 

 

Click Acquire to begin an acquisition according to the instructions in the SCP; clicking Stop (which appears after 

Acquire has been clicked) will abort the acquisition; clicking Pause will stop the acquisition without aborting and 

Resume (which appears after Pause has been clicked) will restart the acquisition from the point at which it was 

paused. 

 

4.8 The Progress and Status panel 

 

 
 

Figure 4.19: the Progress and Status panel 

 

 

The Progress and Status panel (Figure 4.19) provides information concerning the current status of the 

spectrometer and of data acquisition. The box on the left of the panel will give the status (e.g. Ready, Stirring, 

Acquiring); the two bars to the right of the panel give a visual representation of the progress. 
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4.9 The Kinetic Sample Handling Unit Panel 

 

 
 

Figure 4.20: the KSHU panel 

 

 

The Kinetic Sample Handling Unit (KSHU) panel is shown in Figure 4.21. The temperature inside the 

thermostat bath measured by the thermocouple probe is displayed in the upper box.  Below this is the shot 

counter display.  When the drive syringes are filled with sample, if the maximum number of shots available is 

calculated (based on the drive volume set and syringe capacity) this value can be entered in the Max shots edit 

box on the General tab of the KSHU Setup dialog box (Section 4.9.8).  Each time the drive rams fire the Shots 

left value will decrease by one, acting as a convenient reminder as to when the drive syringes need replenishing.  

The Reset button sets the Shots left counter to the value in the Max shots edit box.  If the shot counter proves 

to be inconvenient then the Max Shots value may be set to a very large number to effectively disable it.   

 

Clicking the Drive button carries out a stopped-flow drive (i.e. empties the stop syringe etc.) but without acquiring 

any data.  This function may be used to prime the system after filling the drive syringes with new solutions.   

 

The Empty button empties the stop syringe but does not perform a stopped flow drive. 

 

The Profiles button will display the drive velocity and volume for the last drive performed.  The drive volume and 

velocity is calculated based on the volume of the drive syringes (set elsewhere in the software) and the 

movement of the drive ram during the drive.  The movement is measured using a transducer which makes 

contact with a screw head in the base of a restricted travel drive ram.  The standard single mixing ram does not 

have this screw fitted so will not give drive ram profile information.   

 

 



 

 

Document 4140Q001C02.01  Page 135 of 175  

SX20 User Manual 

 
 

Figure 4.21: the Drive Profiles window 

 

 

The Setup button opens an SHU setup dialog box which provides various useful functions accessed via eight 

specific tabs.  

 

4.9.1 The Cell tab 

The Cell tab (Figure 4.22) allows the cell pathlength and type information to be entered.  This is stored as a tag 

on the acquired data files. 

 

 
 

 Figure 4.22: the Cell tab 
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4.9.2 The Sequential tab 

The Sequential tab (Figure 4.23) allows activation of sequential mixing (assuming that the SHU is equipped for 

sequential mixing).  The Delay time sets the aging time for the mixture of solutions from syringes A and B.  The 

Drive button will perform an empty and drive cycle without acquiring any data. 

 

 
 

Figure 4.23: the Sequential tab 

 

 

4.9.3 The Solutions tab 

The Solutions tab (Figure 4.24) provides a labelling function that allows the name and concentration of the drive 

syringe contents to be entered and stored as part of the data file. 

 

 
 

Figure 4.24: the Solutions tab 
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4.9.4 The Syringe Volumes tab 

The Syringe Volumes tab (Figure 4.25) allows details of the volumes of the drive syringes to be entered and 

stored with the data file. The Profiles function uses this information to calculate the drive volumes. 

 

 
 

Figure 4.25: the Syringes tab 

 

 
4.9.5 The Shot Counter tab 

The number of shots can be set on the Shot Counter tab (Figure 4.26Figure 1.1). The number will decrease by 

one with each drive. 

 

 
 

Figure 4.26: the Shot Counter tab 
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4.9.6 The Waste Cycle tab 

The Waste Cycle tab (Figure 4.27) reveals the timing settings used for the autostop.  There are three rows 

which correspond to the three Auto-Stop operations, stop valve turning to empty, return ram pushing up (then 

automatically falling back when the pressure is released), and stop valve turning to the drive position.  The On 

Time and Duration edit boxes allow the time when each of these operations occur and the length of time the gas 

pressure is applied to be set.  The default values should not be changed by the user unless advised by Applied 

Photophysics. 

 
 

Figure 4.27: the Waste Cycle tab 

 

 

4.9.7 The Transducers tab 

Values of the ram transducers are set from the Transducers tab: the values are preset and should not need to 

be changed by the user. 

 

4.9.8 The General tab 

The General tab (Figure 4.28) provides various useful functions.  The status of the instrument is displayed in 

addition to Drive and Empty buttons which function as those described previously.  The Save button on the 

Config section allows the pressure held status, syringe volumes and contents, and the max shots settings to be 

saved.  These settings can then be retrieved at a later date using the Reload button.  

 

 
 

Figure 4.28: the General tab  
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4.10 Toolbar icons 

 

 
 

Figure 4.29: the SCP Toolbar 

 

The SCP toolbar is shown in Figure 4.29. Positioning the cursor over an icon will call up a brief description; a 

fuller description is also provided in the status bar at the foot of the SCP. The action of clicking each icon is 

described below: 

described below: 

 

Opens a new document.  

 

Opens a previously collected data file. This will open a window showing the contents of the currently 

active directory or the examples folder if you have just launched Pro-Data. Opening a data file from this 

window will configure the interface with the experimental parameters contained in that file. 

 

Saves the active document. If there is new data that needs saving, this icon will open a Save As window 

showing the currently active directory. If there is no new data, an information window saying so will 

appear.  

 

Opens the File Names dialog box, in which you can specify seed names for spectra and backgrounds. In 

a series of experiments, the file names will share the chosen seed name and be differentiated by an 

automatically incrementing numeric component, e.g. Protein0001, Protein0002… 

 

Opens the Remarks and Comments window, in which you can record information about your 

experiments. The remarks are stored in the Datastore and can be viewed in Pro-Data viewer. 

  

Opens the Preferences dialog box, in which personal preferences can be set. A full description is given 

in Section 4.13 . 

 

Launches Pro-Data Viewer (Chapter 5).  

 

Calls up About Chirascan window, which gives the Chirascan software version. 

 

Click this icon and then on item of interest to call up the context sensitive help for that item. 
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4.11 Drop-Down Menus 

Much of what is available in the drop-down menus is more readily accessible from the icons in the toolbar. A full 

list of the functionality is given below; inevitably, there is some repetition of the information in Section 4.10. 

 

4.11.1 The File menu 

 

 
 

Figure 4.30: the File menu 

 

 

The File menu (Figure 4.30) presents the usual options and shortcuts for opening and closing files. It is unlikely 

that you will need to use these, because their functionality is more conveniently accessible elsewhere in Pro-

Data and in Pro-Data viewer. The examples folder can be accessed from this menu, in which there are several 

examples of spectra supplied by APL that can be used as templates to set up Pro-Data or as tools to familiarise 

oneself with the use of Pro-Data viewer. 

 

 

4.11.2 The View menu 

 

 
 

Figure 4.31: the View menu 

 

 

The View menu (Figure 4.31) offers five options. 

 

 Pro-Data Viewer launches Pro-Data Viewer (Chapter 5) 

 Devices…  opens the Device Window. This contains a number of icons corresponding to hardware 

devices that may need to have certain parameters adjusted. See Section 4.12 for more details.  

 Remarks… opens the Remarks and Comments window, in which you can record information about 

your experiments. The remarks are stored in the Datastore and can be viewed in either Pro-Data viewer 

 Toolbar a toggle to show or hide the toolbar. 

 Always on top a toggle to ensure that Pro-Data SX is always visible.  
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4.11.3 The Configuration menu 

 

 
 

Figure 4.32: the Configuration menu 

 

 

The Configuration menu (Figure 4.32) offers three options. 

 Idle Update Speed opens the rate at which the live signal display (Section )  

 Access Control opens a panel showing the names of members of security groups with access to the 

Pro-Data software 

 Preferences opens the Preferences dialog box in which personal preferences can be set. A full 

description is given in Section 4.13. 

 

4.11.4 The Help menu 

 

 
 

Figure 4.33: the Help menu 

 

 

The Help menu (Figure 4.33) presents two items: 

 Help Topics launches the help manual. You can browse the contents and search for specific words and 

phrases. 

 About SX…  opens a window giving the version number of the SX software. 

 

  



 

 

Document 4140Q001C02.01  Page 142 of 175  

SX20 User Manual 

4.12 The Device Window 

4.12.1 General 

 

 
 

Figure 4.34: the Device window 

 

 

Select Devices… from the View drop-down menu to reveal the Device Window (Figure 4.34).  Some of the 

icons require a service password or are inactive, and their action is not described here. The action of the 

remaining icons is described below. 

 

System Reset will reset any user-adjustable parameters accessible through the Devices panel to their factory 

defaults. It is unlikely that you would need to do this. 

 

Calibrate Zero Offsets will adjust the electronic offset to take into account any small drift that may have 

occurred over time. It is unlikely that you will need to this on a regular basis. The offsets should not be changed 

until the instrument electronics are at their normal working temperature (it is good practice to leave the 

electronics powered on at all times) nor should they be changed part-way through a series of experiments, since 

recalibrating the offsets may shift the CD background slightly. 

 

Service Password… opens a dialog box that permits you to change the password that gives access to the 

advanced sections of the Device window. If you change it, do not forget it because APL engineers will not be 

able to rediscover it for you. 
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4.12.2 Mono1 

 

 The Mono1 icon displays the Main Monochromator window (Figure 4.35). 

 

 
 

Figure 4.35: the Main Monochromator window 

 

 

In the Wavelength panel, the slider bar or the edit box can be used to specify a wavelength; clicking the Set 

button will drive the monochromator to the chosen wavelength. The Status panel reports what the 

monochromator is doing – when it is executing your instruction, the status reported would be Updating and No 

respectively in the Current action and Reached target boxes and on completion the text would read Ready and 

Yes, as shown above. When you are happy that the parameters are correctly set, click OK; to close the panel 

without implementing the changes, click Cancel.  

 

4.12.3 Mono2 

 

 The Mono2 icon displays the Second/Emission Monochromator window, the operation of which is 

the same as the main monochromator (Figure 4.35) 

 

 

4.12.4 The Absorbance Detector 

 

 The Absorbance icon displays the Absorbance Photometric Channel window (Figure 4.36:). 
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Figure 4.36: the Absorbance Photometric Channel window 

 

 

The controls available in this window operate in an identical fashion to those accessed from the detector high 

voltage panel as described in Section 4.3, to allow adjustment of the photomultiplier high voltage.  The 

Advanced button requires a password to gain access to parameters which should not be changed except under 

the instruction of a qualified engineer.   

 
4.12.5 The Fluorescence Detector 

 

 The Fluorescence icon displays the Fluorescence Photometric Channel window (Figure 4.37). 

 

 

 

 
 

Figure 4.37: the Fluorescence Photometric Channel window 
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The controls available in this widow operate in an identical fashion to those accessed from the detector high 

voltage panel as described in Section 4.3 to allow adjustment of the photomultiplier high voltage.  The Advanced 

button requires a password to gain access to parameters which should not be changed except under the 

instruction of a qualified engineer. 

 

 
4.12.6 The PDA 

 

 If the PDA accessory is fitted, the PDA icon displays the photodiode array window (Figure 4.38). 

 

 

 
 

Figure 4.38: the Photodiode Array window 

 

 

The Status and Information and PDA Calibration panels display information relating to the type of PDA and its 

calibration set up.  The A0, A1 and A2 PDA calibration parameters are specific to each individual PDA unit.  

These values must not be altered unless installing a new PDA unit.   

 

The four sliders in the Setup panel allow adjustment of PDA operating parameters in Manual mode (when Preset 

3-User defined is selected), although preset values are available for the two standard SX light sources. The 

Integration period is the time between successive samplings of the same photodiode in the array whereas the 

Scan period is the time taken to perform one reading from all the diodes in the array.  The integration period 

should always therefore be longer than the Scan period.  The minimum integration period is 1 ms but this will be 

too short for many applications.  The Offset slider controls the voltage offset of the output and the Gain slider 

controls the signal gain.  These are pre-acquisition settings which affect the output signal from the PDA.   
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The upper right hand half of the window is taken up by the graphical display panel.  The output from the PDA is 

plotted here in real time when the Start button in the Test panel is clicked with the Auto Repeat option selected.  

This may be used to set the monochromator slits to give a suitable light intensity for the PDA.  The 

monochromator exit slit should normally be set to 1mm and the entrance slit width reduced until the spectrum on 

the real time display is maximised without being saturated.  The instrument electronics will saturate at an output 

of 2.5 volts from the PDA but depending on the Offset and Gain values the PDA may saturate before this level is 

reached.  See Section 2.8 for more information on setting up the PDA.  

 

The Dark count Measurement panel contains buttons which allow the PDA dark count to be measured and 

displayed.  

 

4.12.7 The Circulator 

 

 The Circulator icon displays the Temperature Control Unit window (Figure 4.39). 

 

 

 
 

Figure 4.39: the Temperature Control Unit window 

 

 

The display in the Device selection panel shows the currently connected temperature control unit. The first drop 

down menu presents a list of circulator water baths which can or formerly could be controlled via the Pro-Data 

software; the unit currently recommended is the A25/SC150 supplied by Thermo Fisher Scientific. Choose the 

appropriate unit and the communications port from the second drop down menu and click Connect. You can 

choose to set the selected device as the default. The third dropdown menu allows you to choose between an 

internal or external temperature probe (which is available as an optional accessory on some circulators).  
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4.13 The Preferences dialog box 

Clicking on the Preferences icon or selecting Preferences… from the Configuration drop-down menu  will 

display the Preferences dialog box.  

 

4.13.1 The Viewer tab 

 

 
 

Figure 4.40: the Viewer tab 

 

 

The dialog box opens at the Viewer tab (Figure 4.40) where the appearance of Pro-Data Viewer when launched 

can be controlled (with or without the blank display), and whether or not the display automatically rescales when 

a data point is measured that is outside the limits of the currently-displayed y-axis. 

 
4.13.2 The Absorbance tab 

 

 
 

Figure 4.41: the Absorbance tab 

 

 

On the Absorbance tab (Figure 4.41), preferences for absorbance measurements can be set. In the Default 

Mode panel, select to measure spectra either at constant detector high-voltage (AutoPM not selected) or at a 

voltage that is automatically optimized at each point in the spectrum (AutoPM selected). Constant voltage will 
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normally give the more accurate absorbance measurement because there is no risk of hysteresis associated with 

sharp changes in the detector high-voltage, but you must be careful to ensure that the detector is not saturated 

during the measurement. Selecting AutoPM will remove that possibility and because there are unlikely to be big 

changes in HV from one point to the next, using AutoPM will not degrade the absorbance measurement in any 

significant way.  It is recommended that this option is selected. 

 

4.13.3 The Fluorescence tab 

 

 
 

Figure 4.42: the Fluorescence tab 

 

 

There are no active panels on the Fluorescence tab (Figure 4.42). 

 

4.13.4 The Data Acquisition tab 

The conditions on the Data Acquisition tab (Figure 4.43), have been established as optimal by Applied 

Photophysics‟ engineers, and they should not be changed except under guidance from ALP Technical Support.  

 

 
 

Figure 4.43: the Data Acquisition tab 
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4.13.5 The File Names tab 

 

 
 

Figure 4.44: the File Names tab 

 

 

On File Names tab (Figure 4.44), seed names for spectra and backgrounds can be set. In a series of 

experiments, the file names will share the chosen seed name and be differentiated by an automatically 

incrementing numeric component, e.g. Protein0001, Protein0002… This panel can be accessed directly using 

the File names icon on the toolbar (Section 4.10). 

 

4.13.6 The Startup Preferences tab 

 

 
 

Figure 4.45: the Startup Preferences tab 

 

On the Startup Preferences tab the SCP can be set to open in Spectrum, Kinetics or Spectra-Kinetics 

modes. For the SX20, the default Kinetics is usual. You can also choose to start the software in emulator mode, 

i.e. in the absence of any hardware, but that is unlikely to be of interest during normal use.  
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5 PRO-DATA VIEWER 

This chapter describes the Pro-Data Viewer program, which is designed to display and manipulate data and to 

store them securely. 

 

5.1 Introduction 

Pro-Data Viewer can be used either online, with a client-server link between the spectrometer control panel 

(SCP) and Pro-Data Viewer, or off-line as a standalone program.  

 

Pro-Data Viewer opens with two windows, the launchpad, which shows a list of the files in the current folder, and 

the graphics display, where data will be plotted (Figure 5.1). 

 

The status of Pro-Data Viewer is shown on the status bar at the foot of the launchpad window, where the words 

Ready (Online) or Ready (Offline) will be found. 

 

 
 

Figure 5.1: Pro-Data Viewer, showing the launchpad, left, and graphical display, right 

 

 

5.1.1 Launching Pro-Data Viewer   

Pro-Data Viewer can be launched as a stand-alone program using the desktop icon  and will open at the 

current working directory. Pro-Data Viewer will be offline when launched in this way, i.e. there will be no link with 

the spectrometer control panel. 

 

Pro-Data Viewer can also be launched from the Pro-Data SX spectrometer control panel by clicking on the Pro-

Data Viewer launch icon in the SCP toolbar, , when a client-server link between the SCP and Pro-Data 

Viewer will be established automatically. When launched in this way, Pro-Data Viewer will be online, and 

becomes a live display for data as they are collected, although it can still be used for display and manipulation 

purposes.  

 

If Pro-Data Viewer is started independently of the SCP using the desktop icon and you subsequently wish to 

establish a link between the programs, this can be done in the Preferences window (Section 4.13).  
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5.1.2 File structure: the Datastore 

Experimental data are written to a results file called a Datastore, which is a proprietary format designed for 

handling multi-dimension data. Its content will depend upon the type of experiment that is carried out. A 

knowledge of the structure of Datastores will be helpful in understanding some of the functionality of Pro-Data 

Viewer.  

 

A Datastore consists of dimensions and properties. The dimensions are the controlled (independent) 

experimental variables, such as wavelength or time; the properties are the measured (dependent) variables such 

as CD or absorbance; temperature may be either a dimension or a property, depending on the type of 

experiment. When data are plotted using Pro-Data Viewer, dimensions are always plotted on the x-axis, and the 

properties on the y-axis.  

 

A Datastore can therefore have one or more dimensions, depending on the number of controlled variables. For 

example, a simple experiment in which absorbance is measured as a function of time would generate a one-

dimension Datastore containing time as the dimension, and absorbance, fluorescence (if measured) and the 

number of samples taken (count), as properties. 

 

If the PDA was used for data collection, or if the instrument was used in spectra-kinetics mode, a two-dimension 

Datastore would result, with time and wavelength as dimensions, and containing absorbance, count etc. as 

properties. All data from a particular experiment are written to a single Datastore. Subsequently, the Datastore 

can be mined for subsets of the data. 

 

Note that the Datastore file format is designed for Pro-Data multi-dimension data acquisition and is not suitable 

for direct access outside the Pro-Data environment. A range of file export options is provided within Pro-Data, 

generating formats that are suitable for third-party applications. 

 

5.1.3 Viewing experimental conditions 

Experimental parameters (wavelength range, step size, time-per-point, bandwidth) plus sample information 

provided by the user via the Setup… dialog box in the spectrometer control panel (sample description, 

concentration, cell type and pathlength) are stored with the results file and can be viewed on the Datastores 

Details View, the area to the bottom of the launchpad (Figure 5.2). The details shown will be those of the file 

highlighted in the launchpad file list. 

 

 
 

Figure 5.2: the Datastores Details View 
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5.2 Displaying and selecting data 

5.2.1 The graphical display 

One or more files can be displayed in the graphical display 

 

To display a single file double-click on the filename or choose Open from the File menu (Section 5.7.1). 

To add a file to the graphical display, drag it onto the display or right-click and choose  Add DataStore 

to Graph. 

To add more than one file at a time, select multiple files from the list in the usual way (using the mouse 

pointer with Ctrl or Shift keys) and drag them onto the graphical display (Figure 5.3). 

To display a file in a new window, double-click on the filename or choose Open from the File menu 

(Section 5.7.1). 

To remove a trace from the display select the trace (Section 5.2.2), right-click and choose Remove 

Selected Trace or use the Trace manipulation dialog box (Section 5.3.1). 

 

 
 

Figure 5.3: three files selected in the launchpad and dragged onto the display 

 

 

5.2.2 Selecting a trace in the display 

A trace can be selected in a number of ways. Once selected, it changes colour to black, is highlighted with 

„selection marks‟ and cross-hairs appear on it. The value of the x- and y-coordinates at the position of the cross 

hairs are shown above the graph (Figure 5.4). Single trace selection methods are listed below. 

 

 Place the mouse cursor close to the trace of interest. Left-click to select it. Click a second time to 

deselect it. 

 Right-click anywhere in the display window to reveal a pop-up menu. Choose Select Specific Traces to 

open a dialog box containing a list of the spectra displayed. Click on a filename to select it and OK to 

close the dialog box. 

 On the Trace menu click Selection Dialog to open the Trace Manipulation dialog box (Section 5.3.1). 

Click on a filename to select it and OK to close the dialog box. 

 From the toolbar, click on the icon  to open the Selection dialog box. Click on a filename to select it 

and OK to close the dialog box. 
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Figure 5.4: five traces displayed with one trace selected 

 

 

The method of selection will depend on personal preference and on the number of traces displayed. For 

example, if you wish to select one trace from several overlapping traces, using the dialog is easier than using the 

mouse pointer. Once a trace is selected, the Up / Down arrow keys can be used to move the selection 

sequentially through the displayed traces. 

 

5.2.3 Selecting more than one trace 

Selecting more than one trace is often required, for example to average several traces. Variations in the methods 

described in the Section 5.2.2 to select a single trace are used to select more than one. 

 

 When using the mouse pointer to select spectra, hold down the Shift key and click on the spectra of 

interest. Clicking on the same trace twice with the Shift key depressed will first select it and then 

deselect it. 

 When selecting from the drop-down list, hold down the Shift key and click on the filenames of interest. 

Clicking on the same filename twice with the Shift key depressed will first select it and then deselect it. 

 When selecting from the Trace manipulation dialog box (Section 5.3.1), use the Ctrl and Shift keys in 

combination with the mouse to select filenames in the usual way. Selected files are highlighted. In 

general, using the dialog box is the preferred method when dealing with more than one trace. 

 

5.2.4 Zooming and re-scaling the display using the mouse 

To zoom in to a particular part of the display, click and hold the left mouse button while moving the pointer to 

create a box around the area of interest. On releasing the left mouse button, the newly created box will expand to 

fill the display window (Figure 5.5). To return to full display, double-click in the display area. 
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Figure 5.5: full display (left) and zoom using the left mouse button (right) 

 

Use the mouse wheel to expand or contract both axes simultaneously. Hold down the Ctrl key and use the 

mouse wheel to expand or contract only the horizontal axis. Hold down the Shift key and use the mouse wheel 

to expand or contract only the vertical axis (Figure 5.5). 

 

 
 

Figure 5.6: zoom using wheel alone (left), Ctrl + wheel (centre), 
Shift + wheel (right) 

 

 

The zoom functions can be used in any combination. To return to the default full-screen display, doublet-click at 

any time in the display area. 

 

5.2.5 Displaying different properties 

Pro-Data Viewer always plots the dimension on the x-axis, and the selected property on the y-axis. Right-clicking 

the y-axis legend will display a menu of the properties recorded during a measurement (Figure 5.7). To change 

the property displayed, select one from the list by double-clicking it. 

 

 
 

Figure 5.7: example menu of properties that can be plotted as y-axis 
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When run in absorbance mode, three properties are recorded with every measurement made on the SX20. 

These are: 

 

 Transmission 

 Absorbance 

 Count (the number of 25 s samples taken at each step in the scan) 

 In addition, Fluorescence can be plotted if it was selected and a fluorescence detector was fitted. 

 

5.3 Manipulating and Fitting Data 

5.3.1 Trace Manipulation  

The Trace Manipulation dialog box (Figure 5.8) can be opened by clicking Selection dialog on the Trace  menu 

(Section 5.8.3) or by clicking  on the graphical display toolbar (Section 5.6.2).  

 

The dialog box is an environment in which data (traces) can be background corrected, averaged or otherwise 

manipulated. All operations carried out within this environment are reversible, which means that if errors are 

made they can be quickly and easily corrected. The original data are never over-written or otherwise destroyed 

and all operations carried out on data are recorded in the History file on the View menu (Section 5.7.2). The 

results of the manipulations are displayed in real-time and can be saved at the end of the session in one of a 

number of formats using Save current plot on the File menu (Section 5.7.1). 

 

 
 

Figure 5.8: the Trace Manipulation dialog box  

 

 

The structure of the dialog box is straightforward. There are two windows, one of which lists any traces that are 

visible in the graphics window, the other listing those that have been removed from the display during the 

session and are no longer shown in the display. The buttons on the right execute actions on traces that have 

been highlighted in the Visible Traces window. Traces can be swapped between the Removed Traces and 

Visible Traces window using the arrow buttons between the two panes. Single arrow will move a selection, 

double arrow will move all listed traces. 
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In the example below, there are five traces, named Run1 to Run 5. We will average the first three traces, and 

smooth the averaged curve. With the data loaded into the display as previously described, and the graphical 

display active, open the dialog box to display the data files list (Figure 5.9). 

 

 
 

Figure 5.9: raw data with dialog box called up 

 

 

Select the files for averaging and click Average. A file named Average: 0 will be added to the Visible Traces list 

and plotted in the display.  

 

Select the Average: 0 file and click Smooth. The Smoothing dialog box will appear (Figure 5.10).  

 

    
 

Figure 5.10: An appropriate smooth (left) and an inappropriate one (right) 

 

Enter the number of degrees of smoothing required in the Window Size box. This value will depend on the step 

resolution used during the measurement and the sharpness of the features in the trace. The number should be 

as large as is possible without causing distortion of the trace. Examination of the residual plot will show if any 
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distortion has occurred. If the noise is randomly distributed about zero, the smoothing process has not caused 

any distortion and, importantly, you have the evidence to prove it.  

 

An example of an appropriate smooth, in which 4 degrees of smoothing were used, and an inappropriate one, in 

which 90 degrees of smoothing were used on the same data set, are shown in Figure 5.10. The structure in the 

residuals that arises when 90 degrees of smoothing were used is apparent. 

 

When you are satisfied with the smoothing process, click OK. Select Smooth (s)…………….. and Smooth 

(r)…………….. and click Remove Others. The Trace manipulation dialog box will appear as in Figure 5.11. 

 

 
 

Figure 5.11: Trace manipulation dialog box after curve manipulation 

 

 

Click OK to close the dialog box. The result of the above manipulation is shown in Figure 5.12, with the 

smoothed curve and the smoothing residuals plotted. 

 

 
 

Figure 5.12: smoothed curves (red) and smoothing residuals (cyan) 
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Note that even after closing the Trace Manipulation dialog box, any removed traces are remembered. Should 

you wish to carry out further manipulation, simply re-open the dialog box and all the traces will be listed, whether 

visible or removed, enabling you to carry on where you left off. 

 

5.3.2 Curve Fitting 

Select the curve you want to fit and open the Curve Fitting dialog box (Figure 5.13) using by choosing Fitting 

on the Math menu (Section 5.8.4),  on the graphical display toolbar (Section 5.6.2), or the Fit button on the 

Trace Manipulation dialog box (Section 5.3.1).  

 

A selected function is fitted to the data using a Marquardt-Levenberg algorithm. Select the required function from 

the dropdown list on the Fitting panel and enter the range over which the data are to be fitted on the Fit Range 

panel, then click Set to update. If you are unsure about initial starting parameters for the fit, click the Estimate 

button to automatically generate a set of initial parameters, which may not be very accurate. The curve 

associated with these parameters is plotted in the preview window to the right. 

 

 
 

Figure 5.13: kinetic data fitted with a single exponential model 

 

 

To initiate the fitting of the parameters to the data, click Fit. The algorithm will iterate until convergence or the 

maximum number of cycles is reached. If the fitting is successful, the parameters will be updated and the 

calculated curve plotted in the preview window. The associated residual trace (the difference between the 

observed and calculated data) will be displayed in the Residuals part of the preview window. The errors 

associated with the calculated parameters are displayed next to the calculated parameters. You will be able to 

judge the quality of the fit by inspecting the residual trace and the parameter errors. If the errors are large 

compared with the parameters, then it is likely that you have specified a fitting function which is more 

complicated than is justified by the data, i.e. the result is under-determined. The number of variable parameters 
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can be reduced by locking any parameter using the check boxes adjacent to the parameters, but such locking 

must be justified and should be applied with care. 

 

If the fitting process does not converge within the selected maximum number of iterations, a warning is given. 

You may wish to increase the number of iterations, up to a maximum of 1000. Be aware that 1000 iterations of 

the fitting algorithm may take some time. In some instances, the fitting does not converge because of the 

absence of a unique solution. This too is symptomatic of an under-determined model. 

 

When you are satisfied that the fit is a good one and the calculated parameters are sensible, you can print out a 

report by clicking on the printer icon. The report displays the data, the calculated fit data with residuals and the 

associated fitting parameters. 

 

To plot the fitted curve in the Pro-Data Viewer display, click OK.  If you do not wish the residuals to be included 

on the plot, clear the Include Residuals in Final Plot check box. 

 

5.3.3 Saving data 

The manipulated data are not saved automatically. To save the result, go to Save Current Plot… on the File 

menu (Section 5.7.1) to call up the Save As… dialog box or Save selected traces on the File menu. The 

original raw data are never over-written. The results of any manipulation are stored in a new Datastore and a 

complete history of the manipulated traces is contained in the History of that Datastore which is opened on the 

View menu (Section 5.7.2). 

 

5.4 Exporting data 

Right-click on a filename in Pro-Data viewer launchpad to display the File manipulation pop-up menu shown in 

Figure 5.14.  

 

 
 

Figure 5.14: File manipulation pop-up menu 

 

 

Select Export data… to bring up the dropdown list in Figure 5.15 and choose an appropriate format for export to 

another program 
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Figure 5.15: options for exporting data 

 

 

CSV format is suitable for third-party programs such as Microsoft Excel; other options relate to formats derived 

from other APL products. 

 

5.5 Handling multi-dimension Datastores 

5.5.1 Loading multi-dimension Datastores 

In the example that follows, the PDA was used to monitor the acid catalysed redox reaction (Figure 5.16). The 

PDA measures absorbance as a function of wavelength for a set period of time, so absorbance is the only 

property in this case, and wavelength and time are the two dimensions. 

 

 
 

Figure 5.16: PDA data plotted with wavelength as the x-axis  
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5.5.2 Changing the display axes 

Right-click on the x-axis legend to display the dimension menu (Figure 5.17) 

 

 
  

Figure 5.17: the dimension menu 

 

 

In this case wavelength (in the X column) and Time (in the Z column) are highlighted, indicating that in the 

display above, wavelength is the x-axis and the absorbance traces at different times are projected down the z-

axis onto the display. To change x-axis dimension double click on the row with the required  x and z dimensions, 

in this case time and wavelength respectively. The graphical display will appear as required (Figure 5.18) 

 

 
 

Figure 5.18: PDA data with time as the x-axis 

 

 
5.5.3 Mining multi-dimension Datastores 

Multi-dimension Datastores can be mined for subsets of the original data and the subsets saved as new files. 

The process is recursive, so higher-dimension Datastores can be reduced to their simplest one-dimension forms 

if required.  Below is an example of how to mine a two-dimension Datastore, using the PDA data from Figure 

5.16.  

 

Right-click on a two-dimension Datastore in the launchpad file list and select Decompose Data from the menu. 

A Decompose data dialog box will appear (Figure 5.19). 
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Figure 5.19: Decompose Data dialog box 

 

 

In the example, the dialog box shows that the Datastore has two dimensions, time and wavelength, and the 

ranges those dimensions span. To reduce the time range to 0.005 to 0.8 seconds, and retain wavelength as the 

only dimension, input these values into the temperature range boxes, and clear the temperature Primary check 

box (Figure 5.20). 

 

 
 

Figure 5.20: Decompose data dialog box  

 

 

A new one-dimension Datastore will be created containing spectra for every time from 0.005 to 0.8 seconds. 

Click Save as, name the Datastore and refresh the launchpad directory tree. The Datastore will be in a new 

folder created in the original folder. 

 

The number of Primary boxes ticked will determine the lowest-dimension Datastore created. In the above 

example, a series of spectra with wavelength as the primary dimension will be created. If time had been selected 

as the only primary dimension, a series of time curves over the range of wavelengths would have been created. 

 

5.6 Pro-Data Viewer toolbar icons 

5.6.1 Launchpad toolbar icons 

The launchpad toolbar is shown in Figure 5.21. Positioning the cursor over the icon will call up a brief description; 

a fuller description is also provided in the status bar at the foot of the launchpad. 

 

 
 

Figure 5.21: the launchpad toolbar 
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Defines the currently selected directory (folder) as the working directory i.e. the directory in which any 

new data files will be stored. The current working directory is always shown in the box immediately 

above the toolbar icons. The directory name will sometimes need to be contracted to fit in the box but the 

first and last part of the name are always shown. 

 

Returns you to the current working directory 

 

Moves the working directory up one level, to enable you to access files in directories higher up the tree. 

 

Creates a new folder in the currently selected directory. 

 

Opens a browser window from which you can navigate quickly and easily to other folders. 

 

Refreshes the directory tree display. This should be done after saving a file following averaging or 

smoothing, for example, as the live directory is not automatically updated.  

 

Click this icon and then on item of interest to call up the context sensitive help for that item. 

 
 

5.6.2 Graphical display toolbar icons 

The graphical display toolbar is shown in Figure 5.22. 

 

 
 

Figure 5.22: the Standard toolbar 

 

  

Saves all the traces in the display into a new file. Click on this icon to call up the Save As… dialog box 

from where you can specify a filename and choose a location for the new file. 

 

Prints the active document. 

 

Causes an edit box to appear enabling you to record information in addition to that recorded 

automatically or entered through the Setup… dialogue box in the SCP. 

 

Calls up a history of the operations performed on the trace. 

 

Print the active document. 

 

Sets a selected trace as a background. Clicking again will reset the trace to its original status. 

 

Adds a previously defined background to a selected trace or traces. It is useful if a background has been 

subtracted inadvertently from a trace. This icon is inactive if no background has been defined. 

 

Subtracts a previously defined background from a selected trace. This icon is inactive if no background 

has been defined. 
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Opens the Curve fitting dialog box enabling one of a number of models to be fitted to a selected trace 

(Section ). 

 

Averages the selected traces: the average will be added to the plot. 

 

Averages all the traces in the display, plots the average, and removes the original data. 

 

Opens the Simple math dialog box that enables you to add, subtract, multiply or divide a trace to, from 

or by a constant. 

 

Opens the Smoothing dialog box enabling a reversible Savitsky-Golay smoothing operation to be 

performed on a selected trace. The smoothed trace and (optionally) its residual are plotted (Section 5.3). 

 

Opens the Convert CD units dialog box enabling you to convert from the current CD units to others 

(This icon is greyed out for SX data). 

 

Opens the Trace Manipulation dialog box (Section 5.3.1) 

 

Opens the Visible Trace Range dialog box to reduce the number of traces from the same Datastore that 

are displayed.  

 

Removes all overlaid traces from the display. An overlaid trace is one whose property and dimension 

(e.g. CD and wavelength) are the same as those of traces already in the display but whose wavelength 

range or step-size or bandwidth differs from the originals. 

 

Changes the x-axis to logarithmic scale. Clicking again on the icon will change the axis back to a linear 

scale. A logarithmic scale is mainly used when time is plotted as the x-axis. 

 

Resets the trace colours to the first available in the palette. This can be useful after trace manipulation if 

the automatically assigned colours are not suitable, e.g. too pale. 

 

5.7 Launchpad drop-down menus 

5.7.1 The File menu 

 

  
 

Figure 5.23: the File menu 

 

 

The File menu (Figure 5.23) presents the usual Windows options for opening and closing files.  
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5.7.2 The View menu 

 

 
 

Figure 5.24: the View menu 

 

 

On the View menu (Figure 5.24)  

 

 Close all viewer windows is a quick means of closing all Pro-Data Viewer graphical displays. It is 

useful if Single Window in the Preferences drop-down menu has not been selected. 

 Always on top is a toggle to force Pro-Data Viewer to be the top window.  

 

5.7.3 The Directory menu 

 

 
 

Figure 5.25: the Directory menu 

 

 

The Directory menu (Figure 5.25) can be used to set the current working directory or to return to it.  

 

 Move Root Directory Up One Level will take you back through the directory tree one node at a time 

 Set working directory will define the currently selected directory (folder) as the working directory 

 Back to working directory will take you directly back to the current working directory 

 New folder will create a new folder in the currently selected directory. 

 Browse for folders allows you to browse easily to a folder that can then be set as the working folder 
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5.7.4 The Preferences menu 

 

 
 

Figure 5.26: the Preferences menu 

 

 

The Preferences menu (Figure 5.26) is used to set the conditions for the graphics display and on-line status.  

 

 Single Window when selected means that whenever a new graphical display is opened during data 

acquisition, all previous ones are closed. If it is not selected, then whenever a new measurement is 

made, the previous displays are not closed, but will remain open on separate tabs; If you are running an 

experiment that involves a lot of repeat measurements, it is recommended that Single Window be 

selected; if not, you could end up with a large number of displays to close. Single Window has no effect 

when opening files from the launchpad. 

 Show Online Plots on the Same View will plot the acquired data on the active window. 

 The online status is set by clicking Go on-line, which  will display the Connect dialog box (Figure 5.27) 

on which you will be asked to supply the SX20 IP Address. It is used when Pro-Data Viewer has been 

started as a stand-alone program and you want subsequently to establish a link with the spectrometer 

control program (SCP). If the two programs are running on the same computer, select Local in the 

Connect window. The IP address under these circumstances is always the default 127.0.0.1.  

 

 
 

Figure 5.27: the Connect dialog box 

 

 

The client-server architecture permits remote monitoring of experiments in progress. If a copy of Pro-Data Viewer 

is installed on a remote computer, establishing a client-server link established using the Remote setting will 

enable you to follow an experiment on the second computer.  

 

The IP address of the SX20 computer will not be the same as the default local IP address – your network 

administrator will be able to inform you. If the address is correct and the instrument is running, the Pro-Data 
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Viewer display panel will open. Pro-Data Viewer will „listen‟ to SX20 and report its status, behaving as a real-time 

display. If the address in incorrect, the error message shown in Figure 5.28 will appear. 

 

 
 

Figure 5.28: the Connection error message 

 

 

5.7.5 The Help menu 

 

 
 

Figure 5.29: the Help menu 

 

 

The Help menu (Figure 5.29) gives access to the Pro-Data Viewer launchpad help system 

 

5.8 Graphical Display drop down menus 

5.8.1 The File menu 

 

 
 

Figure 5.30: the File menu 
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The File menu (Figure 5.23) allows the Current plot to be saved, or the selected traces. The plot can be copied to 

the clipboard or printed directly.  

 

5.8.2 The View menu 

 

 
 

Figure 5.31: the View menu  

 

 

On the View menu (Figure 5.24): 

 

 Aux Dimension Ctrl is a toggle to show or hide the third dimension slider bar. It is of use when dealing 

with multi-dimension Datastores 

 Legend is a toggle to hide or show the trace names that appear by default at the side of a plot. The 

function can be more easily executed using the keyboard shortcut L or by right-clicking anywhere in the 

plot border and clicking on the Hide legend or Show legend pop-up that appears. 

 Remarks… calls up an edit box in which you can add comments to supplement information that is 

recorded automatically or entered through the Setup… dialogue box in the SCP. 

 

5.8.3 The Trace menu 

 

 
 

Figure 5.32: the Trace menu 

 

 

On the Trace menu (Figure 5.32): 

 

 Show Trace Name is a toggle to show / hide the name of a highlighted trace when the mouse pointer is 

placed near to it. 
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 Selection Dialog calls up the Trace Manipulation dialog box (Section 5.3.1). 

 Select All selects every trace in the display. 

 Deselect All deselects every trace in the display. 

 Remove Selected removes from the display any currently selected trace. Removed traces can be 

recovered using the Trace Manipulation dialog box (Section 5.3.1). 

 Remove Unselected Traces removes from the display any trace that is not selected. Removed traces 

can be recovered using the Trace Manipulation dialog box (Section 5.3.1). 

 Toggle Selected as Baseline sets / unsets a selected trace as a baseline. 

 Add Baseline and Subtract Baseline become active once a baseline has been set and respectively 

add a baseline to a selected trace or subtract a baseline from it. 

 Remove Overlaid Traces removes all overlaid traces. An overlaid trace is one whose property and 

dimension (e.g. CD and wavelength) are compatible with those of traces already in the display but 

whose wavelength range or step-size or bandwidth is incompatible with those traces already in the 

display. Overlaid traces cannot be manipulated and are always coloured black to differentiate them from 

active traces. 

 Recompute Trace Colours will assign new colours to the traces in the display. This is useful if after 

manipulation the colours of the traces are not satisfactory. 

 Reset will undo all operations carried out on the original data and restore the original display. 

 

5.8.4 The Math menu 

 

 
 

Figure 5.33: the Math menu 

 

 

All mathematical functions can be called up using keyboard shortcuts or toolbar icons. 

 

 Fitting… calls up the Curve fitting dialog box .  

 Average calculates and plots the average of the selected traces. 

 Average All Traces calculates and plots the average of all the traces in the display. The original traces 

are removed. Removed traces can be recovered using the Trace Manipulation dialog box (Section 

5.3.1). 

 Simple Math… opens a dialog box that enables you to add or subtract a constant to a trace or multiply 

or divide a trace by a constant. It can be useful for offsetting one trace from another for display purposes 

or for normalizing spectra for easier comparison. 

 Smooth…  opens a window for applying a smoothing algorithm to raw data. It allows you to optimize the 

smoothing before accepting it. 

 

For more information on the Fitting and Smooth functions, see Section Figure 5.3. 
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5.8.5 The Scale menu 

 

 
 

Figure 5.34: the Scale menu 

 

 

On the Scale menu (Figure 5.34): 

 

 Set Plot limits… calls up a dialog box that enables you to set the limits for the x- and y-axes. 

 Reset Zoom resets the scale to the original display size. Double left-clicking anywhere in display window 

will achieve the same thing. 

 X Logarithmic will change the x-axis to a logarithmic scale. This feature can be useful for kinetic data. 

 

5.8.6 The Window menu 

 

 
 

Figure 5.35: the Window menu 

 

 

On the Window menu (Figure 5.35): 

 

 New Window…  up a list from which can be selected the desired property. The new window will be 

displayed at the same time as the original window in a tile format. 

 Close will close the currently active window 

 Cascade will display in a cascade format all property windows (e.g. CD, absorbance, HT) that have 

been opened and are not currently minimized. 

 Tile will display in a tiled format all property windows (e.g. CD, absorbance, HT) that have been opened 

and are not currently minimized. 

 Arrange icons will tidy up any minimized property displays that have been strewn around the display 

window. 

 Close All Documents will close all the currently active windows. 

 1, 2 etc. refer to the open windows: the displayed window is identified by the  icon 

 Windows… opens a dialog box that enables you to activate or close displays selected from a list. 
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5.8.7 The Help menu 

The Help menu (Figure 5.36) gives access to the ProData help system. 

 

 
 

Figure 5.36: the Help menu   
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6 FLUORESCENCE POLARISATION THEORY 

6.1 FP.1 Specifications 

Wavelength range of excitation:   

> 220 nm (limited by light source) 

 

Wavelength range of detection 

300 nm to >600 nm+ for DPUV polarisers (see Figure 6.1 for transmission curves). 

 

End window PMT detection range 

300 nm to 600 nm 

 

Measurement Accuracy 

±0.005 Polarisation Units 

 

Sensitivity 

2 M Fluorescein (without offset correction) 

50 nM Fluorescein (with offset correction) 

 

   
 

Figure 6.1: fluorescence polarization transmission curves 
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6.2 Enhancing the Performance of FP.1 

This section describes upgrades which may improve the performance of your FP.1 accessory. Items 1 and 2 

below are currently available, while items 3 and 4 are listed as potential future upgrades in order to gauge 

demand through customer feedback. We therefore welcome your comments and suggestions with respect to 

these items and any other performance enhancements you would like to see developed for your FP.1 accessory.  

 

Hg-Xe lamps:  

For greatly enhanced excitation intensity at specific UV wavelengths. Please contact Applied Photophysics Ltd. 

for further details. 

 

Schott glass cut-off filters:  

Choosing filters, which are well tailored to the experiment is critical for maximising the performance of your FP.1 

accessory. Applied Photophysics Ltd. can supply a selected range of cut-off filters on request.  

 

Alternative Collection Pieces:  

The DPUV polarisers supplied with your FP.1 accessory provide a good general coverage of the visible and near 

UV spectrum (see Figure 6.1). They are also well matched to the end-window PMTs currently shipped with the 

FP.1 accessory. Alternative collection pieces may be developed to suit different experimental requirements. For 

example: extended UV coverage, enhanced visible transmission, or better performance using interference filters. 

Such developments may have implications for the detectors used (see item 4 below). 

 

Extended range/sensitivity PMTs:  

The FP.1 Accessory can be used with side window PMTs, which have a detection range of 200 nm to 850 nm 

(note that these have a lower sensitivity than the end window PMTs). Customers may purchase an additional 

side window PMT to complement their existing one.  

 

6.3 G-Factor Determination 

The G-factor determination enables FP measurements to be corrected for gain differences in the two detection 

channels. Although the Target PMTs function alone will approximately equalise the gains in Ch1 and Ch2, a G-

factor determination is still required to ensure that accurate measurements are recorded.  

 

The detection gain is defined as the gain for the state selected by the collection polariser in either channel. For 

channel 1 this is G1. For channel 2 this is G2. The G-factor (G) is then defined as the ratio of these two values. 

 

G-factor is determined by placing the input polariser in the „H‟ (setup) position. Under these conditions, both of 

the collection polarisers have a perpendicular orientation with respect to the excitation polarisation direction. 

Therefore both collection polarisers select the state IPERP. 

 

We may represent the detection signals in channel 1 and channel 2 by the symbols S1 and S2. 

 

So with the input polariser in the position „H‟ (setup), the signals in channel 1 and channel 2 will be as follows: 

 

S1 = G1 x IPERP  S2 = G2 x IPERP 

 

The ratio of these two signals then clearly provides a determination for G: 
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Note that the units for S1, S2, G1 and G2 are not of consequence since we are only dealing with ratios of these 

values. 

 

 

 

 
 

Figure 6.2: Polarisation Geometry (SETUP Configuration) 

 

 

 
 

Figure 6.3: Polarisation Geometry (MEASURE Configuration) 
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6.4 Measurement Correction Using G-Factor 

To understand the use of G-factor for measurement correction, we may first consider the computation of Pol or 

Anis when no correction is used. For the purposes of the discussion, a measurement for Pol is considered, 

although the argument applies equally for Anis measurements. FP measurements are performed with the input 

polariser in the position „V‟ (measure). The detected signals then represent the parallel and perpendicular states 

as follows: 

 

PARA11 Ix  GS   PERP22 Ix  GS   
 

The computation for P using these signals would be: 
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21

SS
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Pol






 
 

Which therefore yields: 

 

PERP2PARA1

PERP2PARA1

Ix  GIx  G

Ix  GIx  G
Pol






 
 

So clearly any difference between G1 and G2 will be manifest as an error in Pol. The procedure used to correct for 

this to multiply the channel 2 signal by G at the point of acquisition. i.e. 

 

2

1

PERP2PERP22
G

G
x  Ix  GG x  )Ix  (GS 

 
 

Giving:         S2 = G1 x IPERP            

 

Also:        S1 = G1 x IPARA     as above 

 

The computation for Pol is then:  

 

PERP1PARA1

PERP1PARA1

Ix  GIx  G

Ix  GIx  G
Pol






 
 

Clearly G1 cancels out, giving: 

 

PERPPARA

PERPPARA

II

II
Pol






 
 

Which is the correct measurement for polarisation. It is a simple matter to show that this method also produces 

corrected Anis data. 

 


